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TECHNICAL SUPPORT

OzWin is supported online, in the OZCIS Forum on CompuServe.  Send messages
addressed to "OzWin Tech Support" at UserID 70007,3574.  The following message
sections are available for OzWin support; please post your message in the section that
most closely matches your question.

7 Scripts/Macros (online scripts, macros, Recorder, etc.)
10 Win Program Files (downloading the program, tools, etc.)
11 Win Setup/Config (installation/setup/genl. configuration)
12 Win Modems/Connect (modems, commports, connection issues)
13 Win Mail/Services (CISMail and non-forum services)
14 Win Forums Mgmt (forum/group config/setup/use)
(Other sections in the forum are used for DOS versions of the program)

Tech support is performed primarily by members of "TeamOz", a group of dedicated
users and beta testers of the program. The Team members check the forum
frequently, and normally can respond to questions within a couple of hours. Please
remember that the TeamOz members are volunteers, giving of their time and energy
out of their love of the program and their desire to help others; they are not Ozarks
West Software employees, nor are they paid in any way - they are given free access to
the OZCIS Forum, but that is all, and in particular they must pay for CISMail just like
any other user. For this reason, it is important that you post your support questions in
the Forum rather than via CISMail. TeamOz members will not respond to tech
support questions sent to them via CISMail, although they will usually post a response
to the question in the appropriate section of OZCIS Forum.

In addition to TeamOz, we at Ozarks West Software and Alchemy Intl. stay on top of
the forum, and answer questions that the TeamOz members cannot field. We can
answer questions posted via CISMail, but ask that you post questions in the forum if
at all possible; questions and their answers in the forum benefit not only you but other
OzWin users, and a review of the forum messages may give you an answer to your
question without even having to post a message. Note that while we do continuously
monitor the forum, questions posted via CISMail may take a day or two to be
answered.

Contact points for Ozarks West Software:

CIS: 70007,3574
Internet: 70007.3574@compuserve.com or steves@rainbow.rmii.com
FAX:1-719-548-8557

Please, use FAX for orders or business enquiries *only*. Tech support questions
received via FAX will be answered only if a CIS UID is included, and such answers
will be sent via CISMail.)
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SOFTWARE LICENSE AND WARRANTY

OzCIS For Windows 1.0 copyright (c) 1994 Ozarks West Software, Inc. and Alchemy International, Ltd. All
rights under US and international copyright law and treaty provisions are reserved. "OzCIS", "OzCIS For
Windows" and "OzWin" are trademarks of Ozarks West Software, Inc. Portions copyrighted by Borland
International and used by permission.

Government Use: This software is classified as "Restricted Computer Software" under Clause 52.227-19(c)(2) of
the FARS for civilian agencies, and as "Commercial Computer Software" under Clause 252.227-7013(c)(1) of
the DFARS for DoD agencies.

Restricted Rights Legend: Use, duplication or disclosure by the Government is subject to restrictions as set forth
in paragraph (c)(1)(ii) of the Rights in Technical Data and Computer Software at DFARS 252.227-7013.

Use of OzCIS For Windows is subject to the following terms. If you do not agree to these terms, you must cease
using the software immediately, and destroy all copies of the software in your possession or return them to
Ozarks West Software, Inc.

1) This license covers the complete OzCIS For Windows programs, documentation and accessory files (the
"software") included on the distribution disks or in the downloadable archives available on CompuServe. This
license also includes any updates or patches that we may from time to time release.

2) For the downloadable archived fileset: You are hereby authorized to install the software and use it for a period
not to exceed 30 days from the date of installation, for the purpose of evaluating the software to determine its
suitability for your use. By the end of this 30 day evaluation period, you must either register your copy with
Ozarks West Software, or cease using the software and destroy all copies in your possession.

3) For disks received from Ozarks West Software, Inc.: You are authorized to install and use the software only on
the number of machines for which your copy is licensed, with the following stipulations: For the Standard
(private use) version of the software, you may install a copy on as many machines as you use, so long as there is
no possibility that more than one copy can be in use at one time - for example, you may install copies on your
machines at work and at home, so long as both copies cannot be used at the same time. For the Commercial
(multi-user) version, you may install copies on as many machines as your license specifies, irrespective of the
actual number of users.

4) In either case, you are authorized to make copies for archival purposes. You cannot distribute the software in
any manner by any medium for commercial or business purposes, either alone or as part of some other product or
service, without the express consent of Ozarks West Software, Inc. You may provide copies of the Standard
(private use) version of the software to others so long as no charge of any kind is made for such copies and such
copies comply with section (5) below; such copies are considered to be evaluation copies, subject to the usage
terms spelled out in section (2) above, and each person who receives a copy must be made fully aware of the
terms of this License for Use. You may not provide copies of the Commercial version to others, beyond the limits
of your license for number of users, under any circumstances.

5) In all cases, you may not upload the software to any Bulletin Board System (BBS), the Internet, or any private
or commercial Information Service (e.g. America Online, GEnie, etc.) without the express consent of Ozarks
West Software, Inc. Ozarks West Software, Inc. will usually grant such consent only in cases where the BBS or
file distribution system is a private restricted-access "in-house" or "in-company" system, and will not consent to
any downloadable access that is open to the public whether or not a charge or "membership fee" is required for
that access. The intent of this clause is to restrict electronic distribution strictly to downloading the files from the
CompuServe Information Service, and any distribution inconsistent with that intent and without prior consent of
Ozarks West Software, Inc. will be considered to be in violation of this clause.

6) Ozarks West Software, Inc. warrants the physical magnetic media on which it distributes the software to be
free from defects in materials and workmanship for a period of 30 days from date of shipment; during that
period, defective media will be replaced at no charge to the customer. No other warranty or guarantee, either
express or implied, is made by Ozarks West Software, Inc. concerning the software, including any guarantee of
usability or suitability for a particular purpose. In no case will Ozarks West Software, Inc. be held liable for any
loss or damage, including loss of use of equipment, data or time, resulting from the installation or use of the
software, even if notified in advance of the potential for such loss or damage.

7) Ozarks West Software, Inc. will provide reasonable technical support via the venues listed below; no voice
telephone support is available. Ozarks West Software, Inc. makes no guarantees concerning the timeliness or
accuracy of technical support.
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8) Any disputes arrising from the terms of this License shall be governed by the laws of the State of Colorado.
Any legal actions concerning the terms of this license, whether brought by Ozarks West Software, Inc. or by
other parties, shall take place in the State of Colorado.



page 8 OzWin Copyright(c)1994 Alchemy International, Ltd. All rights reserved

MANUAL OVERVIEW

This manual should be thought of as being comprised of three major areas:
Installation, Program Reference, and Appendixes. Knowing which area of the manual
to scan for information will speed up your use and enjoyment of OzCIS for Windows
(tm), hereafter referred to as OzWin (tm).

The Installation area of the manual covers Getting OzWin onto the computer and
communicating with CompuServe. This area consists of one section called
Installation. Refer to this section for detailed step-by-step instructions on installing
and setting up OzWin.

The Program Reference area of the manual covers the actual documentation of the
various parts, functions, and features of OzWin. This area is generally useful for
looking up specific answers to specific questions. It should be scanned for particular
answers rather than read completely through. The Program Reference area consists of
four sections: Program Organization, Basic Services Unit, Forum Services Unit, and
Power Services Unit. Program Organization covers Detailing the common concepts
behind OzWin and its features. Basic Services Unit documents Using CIS Mail and
common services. Forum Services Unit documents Using Forum services. Power
Services Unit documents Using advanced services and features of OzWin.

NOTE: Information documented in the Program Reference area is considered
cumulative. Therefore, information that applies in more than one section of the
Program Reference area is only documented in the first section in which it applies. (ie.
Features available to both CIS Mail users and Forum users are documented in the
Basic Services Unit and any differences are further documented in the Forum Services
Unit.)

The Appendixes area of the manual contains very specific information that pertains to
only certain users or at certain times or information that is more useful to the user in a
Quick reference chart or table format. Many times this information will be useful to
have in front of the user while OzWin is running. Three appendixes are of particular
use while OzWin is running. Flags charts by feature the Meaning of the various flag
characters used throughout OzWin. Hot Keys provides a table of all Keyboard
shortcuts to getting work done. Activity Indicators describes the Significance of the
various picture symbols used by OzWin to indicate waiting or pending activities.

Documentation Viewpoint

This documentation assumes you have a basic grounding in Microsoft Windows,
including familiarity with common Windows terminology and operations.

CompuServe autonavigators, such as this program, are by their very nature tools for
power users - they are designed for the CompuServe member who is:-

already familiar with the basic operations of CISMail, Forums and other common
areas of the Service, is familiar with the commonly-accepted terminology used on the
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Service by its members and administrators, and has some practical experience with
using the standard command-driven interface provided by the Service.

This documentation is written from that same viewpoint.

If you are brand new to CompuServe, you will most likely find this program (and the
other available autonavigator programs) rather daunting, especially if you are not yet a
member of CompuServe. Even those people with extensive and varied experience
with other commercial Online Services usually find that comming to grips with the
hows and whys of CompuServe takes some time and practice.

If you are not already an experienced CompuServe user, we strongly recommend that
you spend some time familiarizing yourself with the Service via an interactive-access
program such as CompuServe Information Manager for Windows (WinCIM(tm)).
Just as you would not expect to race a Formula 1 car before learning how to drive, so
you should "learn to drive CompuServe" before attempting to use an autonavigator.
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INSTALLATION

To install OzWin from the downloaded fileset, follow these steps:

1. Copy the OZW1D1.EXE and OZW1D2.EXE files to 2 blank 1.44Mb floppy disks
for backup storage!

2. You will need about 7Mb of free disk space to complete the installation - this
includes the approx. 4Mb of space needed by the installed program, about 2.5Mb
of room for the installation files, and about 500K of room for the installation
program itself. Once the installation process is completed, you can delete the
installation files to recover that 2.5Mb. The installation program itself recovers the
500K it uses when it terminates.

3. If you do not have an empty directory that can be used temporarily for the
installation process, create one. NOTE The setup program can become confused if
you attempt to run it from a directory nested several levels deep. The temporary
directory in which you decompress the OZW1D1.EXE and OZW1D2.EXE files
should always be a 1st-level directory, i.e. only one level below the root directory
for that drive, and should *not* be on a drive or directory redirected via the
SUBST or APPEND commands. In other words, something like C:\TEMP is
acceptable, but something like C:\THIS\THAT\THEOTHER\TEMP is not.

4. Open a DOS session. Copy the OZW1D1.EXE and OZW1D2.EXE files into the
empty temporary directory. From the DOS prompt, run each one in turn; this
extracts the self-extracting archives out into their component files. If disk space is
at a premium (and you have saved backup copies of the distribution archives) you
can delete the OZW1D1.EXE and OZW1D2.EXE archive files only, after they
have both been decompressed completely. Now, close the DOS session. (If you
prefer, you can do this set from within File Manager rather than using a DOS
session.)

5. From Windows Program Manager, select File|Run. In the resultant dialog, enter
the full path for the temporary directory you used in Step 2, plus SETUP.EXE. For
example, if the temporary directory you used in Step 2 was C:\TEMP, you would
enter C:\TEMP\SETUP.EXE in the Run dialog. Now, click on "OK".

6. SETUP will execute and install OzWin. Be sure to follow the instructions
provided during the installation process. If you abort the installation process, you
will be able to repeat Step 5 later.

7. Once the installation has successfully completed, you can go back and delete all
the files in the temporary directory.

To install OzWin from the distribution disks, follow these steps:

1. Make backup copies of the distribution disks!

2. You will need approx. 4.5Mb of free disk space to complete the installation - this
includes the 4Mb of disk space the program itself needs once installed, and about
500K of space used temporarily by the installation program.

3. Insert Disk 1 into your 3.5-inch floppy disk drive. From Windows Program
Manager, select File|Run. In the resultant dialog, enter A:SETUP (if your 3.5-inch
drive is B:, enter B:SETUP instead.) Click on "OK". The installation program will
start and install OzWin. If you abort the installation, you can repeat this step later.
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IF YOU DO NOT HAVE WinCIM/CSNav, OR DID NOT HAVE SETUP
CONFIGURE OzWin TO SHARE THE CIS.INI FILE WITH WinCIM:

From the new OzCIS For Windows group, run OzWin by double-clicking on it's icon.
Once the main OzWin window is displayed, click on the "Maintain" button in the
"Connections" cluster. This will display a dialog that lets you define your connection
configurations (User ID/Password, phone number, comm port and modem settings,
etc.) In this dialog, edit the connection data as needed to provide *your* User ID and
Password, the phone number for the CIS or other network node you call, the type of
network for the node you call, and your modem configuration. When finished, click
on the "OK" button to save your changes. OzWin is now ready to call CompuServe.
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PROGRAM ORGANIZATION

OzWin consists of modeless Windows that govern prime features and modal Dialogs
that govern secondary or subsidiary features.

OzWin has one very important Window called OzControl. OzControl is the common
point for accessing any and all features of OzWin. It is the first Window to appear
when OzWin is initiated. All online activities are initiated from OzControl. OzWin
program configuration is managed from OzControl, including management of Forum
definitions. In addition, all CompuServe services not related to CIS Mail or Forums
are managed from OzControl. In order to provide the user with the quickest access to
OzControl and its window management functions, a floating menu called the
OzControl Popup Menu is available from any subsequent Window in OzWin.

A unique Window called the Address Book manages CIS Mail and Forum addresses
in OzWin address books. An important point to remember is that it is up to the user to
select a valid address from the Address Book when using it to address and Outbox
message (ie. Do not select a non existent address or a long outside mail address when
addressing a Forum Outbox message. The Address Book is made easily accessible
from all message related Windows.

Another Window made available from all other Windows in OzWin is the Edit File
Window. Edit File is a full featured file editor that enables the user to access outside
ASCII files for whatever purpose that the user may have.

CIS Mail and Forum services are split into two categories, Inbox and Outbox. Inbox
defines those features that affect or pertain to messages or data received from
CompuServe (ie. Incoming mail and file downloads). Outbox defines those features
that affect or pertain to messages or data to be sent to CompuServe (ie. Outgoing mail
and file uploads).

Inbox message related features are managed from two different Windows, the
Message Viewer and the Message Browser. Most features are the same between the
Viewer and the Browser Windows. Generally, it comes down to user preference when
deciding from which Window to initiate a feature. The Browser provides mass data
representation of messages while the Viewer displays messages on a singular basis.
Only the Viewer allows for reading of Inbox message text.

Inbox quick scan related features are managed from the Quick Scans Window.
Waiting Inbox messages may be marked for retrieval or otherwise handled before
actually retrieving them online. This is a useful feature since retrieving messages
blindly can result in unnecessary CompuServe charges.

Inbox file download related features are managed from the Catalog Viewer and
Listing Browser. Like the Message Viewer and the Message Browser Windows, it
comes down to user preference and online charge considerations when determining
which Window to use.

Outbox messages are generated using two Windows that are essentially the same,
Compose and Reply. Compose is used for composing new messages while Reply is
used for replying to an Inbox message.
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Once generated, Outbox messages are managed from two different Windows, the
Outbox Viewer and the Outbox Browser. Again, both Windows provide the same
basic features except for actual editing of the Outbox messages which only the
Viewer is able to provide.

Every Window has several elements in common. Therefore all Windows in OzWin are
documented in a consistent breakdown style that closely follows this pattern:

Window Title
Window description and general feature discussion.

Window Menu Overview
Brief introduction to the main menu items.

Menu Item(s)
Necessary elaboration of a menu item feature or additional documentation of a menu
item that is itself a sub menu.

Window Tool Bar
Introduction to the toolbit groups on the tool bar.
Discussion of the toolbit group(s) and its toolbits.

The next area(s) of the Window
Discussion of the purpose and function of the area whether it be a display area or a
control or whatever.

Window Related Dialogs
List of Dialogs employed by the Window for the implementation of its features.

First Related Dialog
Discussion of the Dialog, its controls where necessary, and its relationship to the
feature being performed.

Secondary Dialog
Discussion of the Dialog, its controls where necessary, and its relationship to the
feature being performed.
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THE BASIC SERVICES UNIT

OzControl Window
The OzControl Window is the Main Window and the first window seen when OzWin
is activated. All other Windows and Dialogs are maintained from this window. Select
menu items from the Menu Bar or click toolbits to activate all windows. The
Connections section maintains the information required by CompuServe and OzWin
to log on. The CIS Mail section maintains CIS Mail messages and the display of the
Activity Indicators. The General and Preferences command buttons maintain
configuration settings for OzWin. The Current Group and Defined Forums are Forum
Services Features.

OzControl Menu Overview
The OzControl Main Menu controls most of the features in OzWin. The File menu
item maintains file handling and OzControl sizing features. The CIS Mail menu item
maintains the CIS Mail messages. The Services menu item maintains CompuServe
services not directly related to messages. The Online menu item controls the online
connections to CompuServe. The Setup menu item maintains the configuration
aspects of OzWin. The Window menu item controls the active windows. The Help
menu item accesses all of the Help features and displays information about OzWin.
The Messages and Libraries menu items are Forum Services features.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The View Graphics menu item views .GIF files. The
View File menu item provides read- only viewing of text files. The Shrink menu item
toggles the OzControl Main Window in and out of its Shrunk state. The Exit menu
item terminates OzWin naturally.

CIS Mail
The CIS Mail sub menu maintains CIS Mail features. The Read Inbox Messages
menu item views CIS Mail InBox messages. The Messages in Folders menu item
views CIS Mail messages in other folders (i.e. Saved and Purged messages). The
View Retrieved Headers menu item maintains a list of waiting CIS Mail messages that
have not been retrieved. The Compose New Message menu item composes new CIS
Mail OutBox messages. The Upload File To Mail menu item assigns file(s) to be
uploaded to CIS Mail addresses. The Edit Outbox Messages menu item maintains CIS
Mail OutBox message(s).

CIS Mail|Messages In Folders
The Messages in Folders sub menu views three different types of messages. The
Purged Messages menu item views Inbox messages that have been purged. The Saved
Messages menu item views Inbox message(s) from .SAV files. The Other menu item
views all other files of saved Inbox message(s). The Saved Outbox Messages menu
item views saved Outbox messages. All folder messages use the Inbox format,
browsers and viewers. Folder messages are maintained the same as all other Inbox
messages, except the Hold and Purge flags cannot be set.
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Services
The Services sub menu assigns online events to retrieve information from
CompuServe's Services features. Each menu item, except Member Directory Search,
IBM and Graphics File Finder, display a check mark beside the description to
signifying when an event is pending. The Weather and Weather Maps menu items
assign weather information to be retrieved. Stock Quotes and Trend Charts menu
items assign information about stocks to be retrieved. The Member Directory Search
menu item assigns a search to retrieve CompuServe's user address information. The
IBM and Graphics File Finders menu items, search across Forums for specific files.
The What's New This Week menu item assigns topics from the What's New List to
retrieve the current information. The Update What's New List assigns an event to
retrieve a new What's New List. The Update Phone Numbers List menu item assigns
an event to retrieve a text file containing a phone list of public access CIS Networks
in the U.S.. The returned text file can be viewed in a text editor. The Update Forums
List menu item is a Forum Services Feature.

Services|IBM & Graphics File Finder
The IBM and Graphics File Finder menu items assign events to search for files. The
File Finder Database is accessed while online. The File Finder Database maintains
information on files from many different Forums. This database is not a part of the
Forum therefore updates to it sometimes lag behind. The IBM File Finder searches
Forums that target IBM PC users. The Graphics File Finder searches Forums that
target files specific to graphics.

Online
The Online sub menu activates all Sessions with CompuServe. Each menu item
performs a different series of online events. All menu items except the Execute Script
menu item perform any pending Services events. The Process All Mail menu item
sends all Outbox Mail and retrieves all waiting mail. The Custom Mail Processing sub
menu has four menu items which activate mail related Sessions. The Services Only
menu item performs all pending Services events. The Execute Script menu item
accesses a specific script file and performs the events defined within it. The Manual
Terminal menu item performs online events as they are entered by the user. Both of
the New (1st) Pass menu items, both of the Send(2nd)Pass menu items, both of the
Job Cards and Manual Terminal|LogOn to Current Forum menu items, are Forum
Services Features.

Online|Custom Mail Processing
The Custom Mail Processing sub menu activates online sessions performing four
different ways. All will perform any pending Services features. The Send Outbox Mail
Only sends all messages in the Outbox and any file(s) set as forward to Mail. The Get
Waiting Mail Only menu item retrieves all waiting messages only. The Quick Scan
Mail menu item retrieves a new Quick Scan list. The Retrieve Mail From Marked
Headers menu item retrieves all messages marked for retrieval.

Online|Manual Terminal
The Manual Terminal sub menu maintains menu items which allows manual control
during an online session or activation of an external editor. The Manual Terminal
w/Logon menu item takes the user thru the log on process, then toggles to manual
mode. The Manual Terminal no Logon menu item pops up the Terminal window in
full manual mode.

Setup
The Setup sub menu maintains the input of information for OzWin. The Address
Book menu item pops up the Address Book. The Maintain CIS Mail menu item
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maintains the configuration settings for the CIS Mail handling. This menu item
performs the same as the maintain command button in the CIS Mail area in the
OzControl Window. The Maintain Connections menu item maintains the information
required by CompuServe for the current Connection. This menu item performs the
same as the Connections area Maintain command button. The Connection Options
maintains the additional options required by OzWin for the current Connection. This
menu item performs the same as the Connections area Options command button. The
Maintain Groups and the Maintain Forums menu items are Forum Services Features.

Window
The Window sub menu maintains the active windows. The Cascade Windows menu
item cascades all non minimized windows. The Minimize Windows menu item
minimizes all active windows except OzControl. The Close All Windows menu item
naturally terminates all active windows except the OzControl Main Window. The
Active Window list displays all active Windows.

Window|Active Window List
The Active Windows List does not have a menu item. The Active Window List can be
viewed only if windows other than OzControl are active. Select a window from the list
to make it the current window.

Help
The Help sub menu maintains OzWin Help System. The Help with Help, Contents,
Index, and Glossary all activate a different area of the OzWin Help System. The
About menu item displays Information on OzWin, amount of free memory and
resources, and cumulative online time.

OzControl Tool Bar
The CIS Mail Toolbit Group maintains only CIS Mail messages. The Services Toolbit
Group maintains the Address Book and services feature. The OzControl Toolbit
Group toggles OzControl Shrunk state, OzWin Help System and normal termination
of OzWin. The Forum Toolbit Group and the Online Forum Toolbit Group are Forum
Services Features.

The CIS Mail toolbit group contains the CIS Mail Read Inbox, CIS Mail Compose
New and Process All Mail toolbits. CIS Mail Read Inbox toolbit loads the Inbox
messages to be viewed (CIS Mail|Read Inbox Messages). The Compose New toolbit
creates a new message (CIS Mail|ComposeNewMessage). The Process All Mail
Toolbit activates the Online Module and connects with CompuServe to send all
pending Outbox messages and retrieve all waiting Inbox messages (Online|Process All
Mail).

The Services toolbit group contains the Address, Weather and Stock Quotes toolbits.
The Address toolbit pops up the Address Book. (Setup|Address Books) The Weather
toolbit assigns an event to retrieve current weather forecasts, for specific cities
(Services|Weather). The Stock Quotes toolbit assigns an event to retrieve current
Stock quotes for specific stocks (Services|Stock Quotes).

The OzControl toolbit group contains the Shrink, Help and Exit toolbits. The Shrink
toolbit toggles the size of the OzCOntrol Main Window (File|Shrink) The Help toolbit
activates the OzWin Help System. (Help menu item). The Exit toolbit terminates
OzWin normally (File|Exit).
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OzControl Connections Area
The OzControl Connections Area maintains a list of Connections. Change the current
Connection by dropping down the list and selecting a new connection. The
Connections are the information required to log on to CompuServe. The Maintain
command button maintains the settings required by CompuServe for the current
Connection. The Option command button maintains the OzWin required settings for
the current connection.

OzControl CIS Mail Area
This section displays the Activity Indicators and maintains CIS Mail options. The
Inbox Activity Indicators are displayed on the left side of the field, the Outbox
indicators are on the right. Double click the indicator display area to view the CIS
Mail messages. To change the current configuration settings for the CIS Mail select
the maintain command button.

OzControl Configuration Area
The OzControl Configuration Area maintains the configuration settings for OzWin.
The OzControl Configuration Area consists of two command buttons, the General and
Preferences buttons. The General command button maintains the General
configuration settings for OzWin (i.e. file paths, pre and post online commands, fonts,
color set, message handling etc...). The Preferences button is a Power Services
Feature.

OzControl Related Dialogs
CIS Mail Options
Connections Options
Courtesy Copy Addresses
General Configuration
Graphics File Finder
IBM File Finder
Member Directory Search
Upload To Mail
Setup Session Settings
Stock Quotes
Trend Charts
View Graphics
View File
Weather Forecast
Weather Maps

CIS Mail Options
The CIS Mail Options Dialog maintains the option settings for CIS Mail. All changes
to this dialog are activated as soon as the dialog is closed. The Files Path field
requires a full path for the location of files. The Save Outbox File and the Default
Save File fields maintain default file names for the save Outbox and Inbox files
respectively. These fields are not mandatory. The Return Address field maintains your
Postal mailing address. The Postage Due Handling area maintains the retrieval of
messages with Postage Due. The Save Outbox Messages option determines if a copy
of all Outbox messages get saved to the Save Outbox File. Select the Log Mail
Confirmation option to create an entry in the accounting log each time a message is
successfully posted. The Message Count Limit maintains the maximum number of
messages the Inbox file allows. The Thread Purge Ages is the age in days all



page 18 OzWin Copyright(c)1994 Alchemy International, Ltd. All rights reserved

messages within each thread must be before the thread can be automatically purged.
The Msg Purge Age is the age in days all solo messages must be before they can be
automatically purged. The Msg Purge Age does not effect Mail Threads. Enter a 0 in
either of the two previous fields to disable the automatic purging feature.

The Postage Due Handling area controls the handling of messages with postage due,
while they are being read online. If any have postage due, then the Postage Due
options are checked. The Read Postage Due Mail option retrieves all messages with
postage due. The Scan Postage Due Mail option retrieves headers to the Quick Scans
for all with postage due. The Delete Postage Due Mail deletes online all CIS messages
with postage due.

Connections Options Dialog
The Connections Options Dialog maintains the OzWin required option settings for the
current Connection. The Online Module runs in Unattended Mode option determines
if the current connection is run without being watched by someone. The Process CIS
Mail each online auto pass option determines if all CIS Mail is processed during each
automatic online session.

Courtesy Copy Addresses Dialog
The Courtesy Copy Addresses Dialog maintains a list of additional addressees(s) to
receive a copy of the current file or Outbox message. This allows one file or message
creation to be sent to many users utilizing a limited amount of your time. Enter in the
addressee information into the top fields or select from the Address Book list. The
name is limited to a maximum of 80 characters, the address is 255. Select the Transfer
button to move the name and address entered, into the list on the right. The list on the
left is the current Address Book and can be changed by selecting the AddrBook
Command Button. The Command Buttons between the lists control the transferal of
user(s) from one list to the other. The two radial buttons at the top of the dialog,
determine if the list of CC is added at the bottom of the message. The Standard button
adds the list. The Blind button doesn't.

General Configuration Dialog
The General Configuration Dialog maintains the general options for OzWin. To
activate any changes to the configuration, OzWin must be terminated, then reloaded.
The General Configuration Dialog maintains the file settings, paths, Signature,
options, Protocol Packet size, fonts, color set and message handling features.

The File Paths area maintains the file names and paths for the CIS.INI, scripts and
graphics files. All fields in the File Paths area require full paths without any file
names. The Custom Operations area maintains the Pre-Online and Post-Online
commands. Only one command per line is allowed. The Default Msg Signature field
maintains the text for the Signature feature. The Stock Quotes/Trend Charts area
maintains the full path and file name for the stocks data and the time period for the
Trend Chart. The Save Stock Data To field maintains a full path and filename to save
the Stock Quotes into. The quotes are saved to the file in a Quicken format. The
Options area maintains options for OzWin. The Protocol Packet Size area maintains
the size of packets sent during communications with CompuServe and the maximum
number of files available to download for each event. The fonts command button pops
up the Fonts Configuration Dialog. The Color Set command button pops up the Color
Settings Dialog. The Messages command button pops up the Message
Viewer/Browser Options Dialog.
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The Options area maintains option settings for local OzWin features and Online
events.
The AutoRename Conflicts and AUTHORITATIVE Logos options are Forum
Services Features.

Session Logging This option determines if a Sessional file is created while
online. This file records all that transpires while online
during the previous session.

Multi-Instance Aware This option defines if OzWin is being run on a network and
allows the proper sharing of files between workstations.

Latin-1 Support This option sets the chars inthe #160 - #255 range
(theinternational chars and symbolsof the ISO 8869
character set,commonly known as ISO Latin-1)are
mappedto similarcharacters in the PC ASCII set.The
accuracy of the LatinSupport is dependant upon theDOS
Codepage.

Start "Shrunk" This option sets OzWin to the Shrunk state as the
default.

Do Quotes Always This option automates the Stock Quotes and Trend Charts
services. All stock services attempt to perform each
session.

Show Alerts Dialogs This option displays Alert banners in a dialog which offers
a choice of entering the current Forum or skipping it.

Skip "What's New" This option prevents the What's New This Week and
Update What's New List services from performing while
online.

Skip "News Flash" This option prevents the retrieval of Forum News Flashes.

Color Settings Dialog
The Color Settings Dialog maintains the color setting for the Editor and the Terminal
windows. Select the Foreground or Background buttons to pop up the Color Dialog. A
sample of the current color settings is displayed to help determine the correct settings.
To apply all changes in this dialog OzWin must be terminated then reloaded.

Font Configuration Dialog
The Font Configuration Dialog maintains the font and point size settings for the Edit
File Window, Message Viewers, Reply, Compose New and Edit Outbox Dialogs.
Select the Font command button to pop up a list of fonts, font styles and point sizes.
One important note is that not all fonts can be used in OzWin. The text editors have
certain limitations that prevent some fonts from functioning properly. If the Font
selected is not within the parameters of OzWin specifications, Windows selects
another font as close as possible. Therefore if you select a font and it is not the font
used, try other fonts until you find one that fits your needs.

Message Viewer/Browser Options Dialog
The Message Viewer/Browser Options Dialog maintains settings for messages,
Viewers and browsers. To activate changes within this dialog OzWin must be
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terminated then re-loaded. The Display Options area maintains the format for the
viewers and browsers. The Default Msg Sort Method sets the sort method for the
message viewers and browsers. The Squelch User ITS area blocks messages from
specific users. The last area maintains the fields and rows to display within the
browser. The Hidden Message Types field is a Power Services Feature.

The Display Option area maintains option settings for messages, browsers and
viewers. These options determine if browser or viewer pops up first, if and how a
local index is to be displayed and message handling features. The Sort By Section and
Remove Session Headers options are Forum Services Feature.

Show Browser First This option pops up the Message Browser before the
Message Viewer, when loading Inbox and Out box
messages.

Show Index In Viewer This option displays a Local Index in the Message
Viewer.

Place New Msg at End This option maintains the placement of New messages
within the browsers and Viewers. The New messages
are all sorted to the end of the list in Forum alphabetical
order.

Index has Header Line This option displays a header line for the Local Index in
the Message Viewer.

Mark Skipped as Seen This option sets the Seen flag for all messages getting
skipped by Prov or Next|Thread.

The Squelch User ITS area maintains a list of OURS to block messages from. Before
retrieving any messages, the sender UID is checked against this list. If the sender is on
the list the message is not retrieved. Separate all OURS with semicolons.

The next two fields determine what is displayed for each message in the browsers.
Within each field, a series of letters is used to represent the elements to display. Both
of the fields use a slightly different set of letters. List multiple letters side by side in
the fields without any separation. The same elements can be listed more than once.

The CIS Mail Inbox Index Layout field receives the elements to display for the CIS
Mail Inbox Local Index and Message Browser. The definition of the letters are :

D Message Date
F Flags
S Subject
T Addressee
R Sender

The CIS Mail Outbox Index Layout field receives the elements to display for the CIS
Mail Outbox Local Index and Outbox Browser. The definition of the letters are :

D Distribution Count
F Flags
S Subject
T Addressee
N Attached File
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The last two Layout fields are the Forum Inbox Index Layout and the Forum Outbox
Index Layout both are Forum Services Features.

The # of Index Rows field receives the number of Local Index rows to display in the
viewers. The Inbox Wrap Width receives the column number to word wrap at for the
Inbox message viewer and is the default setting for all Outbox message viewers,
editors and The Edit File Window.

Graphics File Finder Dialog
The Graphics File Finder retrieves a CIS Mail entry of information on files that match
the search criteria entered. The search accesses the Graphics File Finder Database
(IBMFF) to access the file information. The IBMFF database updates can lag behind
the actual Forum, therefore the search results may not be completely accurate. The
search spans across information from multiple Forums are specific to Graphics files.

The Keyboards field receives the Keyboard(s) to search for in the file header
information. The Filename field can receive either a filename only or filename with
extension. CIS filenames are limited to 6 characters on the left of the period. The
Extension field receives an extension only. Use this field if the Filename field does
not contain an extension. The file Type field provides a pick list to select the type of
file to search for. If the type is not known, use the Any Type item. The User ID field
receives the Upholder UID to search for. The Limit Field sets the maximum number
of matching entries to return.

IBM File Finder Dialog
The IBM File Finder retrieves a CIS Mail entry of information on files that match the
search criteria entered. The search accesses the IBM File Finder Database (IBMFF) to
access the file information. The IBMFF database updates can lag behind the actual
Forum, therefore the search results may not be completely accurate. The search spans
across information from multiple Forums which target IBM PC users.

The Keyboards field receives the Keyboard(s) to search for in the file header
information. The Filename field can receive either a filename only or filename with
extension. CIS filenames are limited to 6 characters on the left of the period. The
Extension field receives an extension only. Use this field if the Filename field does
not contain an extension. The file Type field provides a pick list to select the type of
file to search for. If the type is not known, select the Any Type item. The User ID
field receives the Upholder UID to search for. The Limit Field sets the maximum
number of matching entries to return.

Member Directory Search Dialog
The Member Directory Search Dialog assigns an event to search CompuServe's user
list for any matches to the criteria you enter in this dialog. The result is returned to
you in the form of a CIS Mail entry. Make sure you enter in all the information
available. If the search is too generalized it will be cancelled by CompuServe (i.e. last
name and country is not enough).

Upload To Mail Dialog
The Upload to Mail Dialog assigns an event to upload a file to a CIS Mail address and
creates an the Outbox message to store the information. The Name command button,
allows the selection of an addressee from the current Address Book. The Filename
command button pops up the File Dialog to ease in the entry of the filename to
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upload. The Binary check box sets the Binary option for the file. The Hold check box
prevents the file from upholding by setting the Hold flag. The Get Receipt check box
sets the Want Receipt option. This option returns a CIS Mail entry when the
addressee(s) receives the file. The x'd button pops up the Courtesy Copy Addresses
Dialog. The Options Dialog pops up the Mail Options Dialog.

The Courtesy Copy Addresses Dialog
The Courtesy Copy Addresses Dialog maintains a list of addressees to send the
current upload file to. A charge is accrued for each addressee in the list. Refer to the
Courtesy Copy Address Dialog earlier in this section, for more information.

Mail Options Dialog
The Mail Options Dialog maintains options for the current file. The handling of the
charges, importance level, sensitivity and request for a reply is maintained in this
Dialog.

Setup Session Settings Dialog
The Setup Sessions Settings Dialog maintains the information required by
CompuServe to connect to their system or another Network. This dialog and all
dialogs connected to this dialog are the same as the dialogs in CompuServe
Information Manager for Windows (WinCIM). The current Session is viewed when
the dialog pops up. The Session name cannot be changed. To create a new Session
select the New command button. The New Session Name Dialog pops up to receive a
new Session name. When you return to the Setup Sessions Settings Dialog, the new
Session retains the information from the previous Session. The More command button
maintains the information on the procedure of logging in and pops up the More
Session Settings Dialog. The Modem command button maintains the modem type and
settings. The Modem Control Settings Dialog pops up to receive the information. The
Lan command button pops up the Lan Settings Dialog to maintain the Int 14 port
number.

LAN Settings Dialog
The LAN Settings Dialog maintains the port number used by a Int14 connection.
Enter the proper port number and select the OK command button to save.

Modem Control Settings Dialog
The Modem Control Settings Dialog maintains the current modem settings. To select
your modem click on the down arrow on the right of the modem field. A list of
modems alphabetized by manufacturer appears. Select your modem from the list. All
modem control settings are initialized for your modem. If your make and model of
modem is not in the list use the first entry in the list, Hayes. You can then, if needed
customize the individual modem settings, however we recommend you except the
defaults unless you know a setting needs to be changed. NOTE: The modem security
fields are only for use with security enabled modems on networks. If you are unsure
of the meanings of these fields contact your network administrator. If your modem is
connected directly to your system these fields should be blank. The reset button resets
all fields to the default.

More Session Settings Dialog
The first four setting are for custom applications only and should not be changed. The
Eicon X.25 is only if you connect though a Eicon X.25 interface. If using $14, or
NASI, or standard serial port do not use this field.
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New Session Name Dialog
The New Session Name Dialog receives a name for the new connection being created.
Enter the new name and select the OK command button to return to the Set Up
Sessions Dialog.

Stock Quotes Dialog
The Stock Quotes Dialog maintains a list of Stock(s) and their symbol(s). Select
stocks from the list by clicking with a mouse or striking the space bar. The stock
quotes for the selected entries are returned in the form of a CIS Mail entry. If the Save
Stock Data To field of the General Configuration is filled in with a file name, the
Quote is saved off to that file in a Quicken format. Select all quotes in the list by
selecting the All command button. Unsealed all quotes by selecting the Clear button.
Add stocks to the list by selecting the Add button the entering the information into the
Stock Name Dialog. Edit stocks by selecting the Edit button. Delete stocks from the
list by selecting the Delete button.

Stock Name Dialog
The Stock Name Dialog maintains the current entry in Stock Quotes or Trend Charts
lists. The symbol is the four character symbol used worldwide to identify the stock.
The name field is user defined.

Trend Charts Dialog
The Trend Charts Dialog maintains a list of Stock(s) and their symbol(s). Select
stock(s) from the list by clicking with a mouse or striking the space bar. The selected
stocks create events which retrieve trend charts. The charts use the Trends Period
option in the General Configuration Dialog to determine the if the chart reflects daily,
weekly or monthly trends. The stock trend charts are returned in the form of a .GIF
file. Select all stocks in the list by selecting the All command button. Unsealed all
quotes by selecting the Clear button. Add stocks to the list by selecting the Add button
the entering the information into the Stock Name Dialog. Edit stocks by selecting the
Edit button. Delete stocks from the list by selecting the Delete button.

View Graphics Dialog
The View Graphics Dialog displays .GIF files. Enter the file name you wish to view or
select from the list. Use this dialog to view graphics files such as the Weather Maps.

View File Dialog
The View File Dialog provides read-only viewing of any file, regardless of size or
type. File contents can be displayed in either text (suitable for text files) or hex dump
format.

Weather Forecast Dialog
The Weather Forecast Dialog retrieves CIS Mail message(s) containing current
forecast(s) for specific cities. Select the cities from the drop list and/or the Local
Forecast check box. When selection(s) have been made a check mark is displayed in
the menu item.

Weather Maps Dialog
The Weather Maps Dialog downloads current weather maps from around the world. A
CIS Mail entry is retrieved to inform you of specific filenames to view. Select maps
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from a variety of regions available. When maps have been selected a check mark is
displayed in the menu item.



Copyright(c)1994 Alchemy International, Ltd. All rights reserved OzWin page 25

OZ CONTROL RELATED WINDOWS

Address Book Window
The Address Book maintains a list of user names, addresses and comments. The
Address Book supports Oscars style *.adr and OzWin style *.ab files. Only one
Address Book file can be loaded at a time. When the Address Book is called from any
Dialog or Window, and a user is selected information is transferred back to the calling
location. The user name and address information is displayed in the list. The comment
for the current user is displayed in a read-only viewer at the bottom of the dialog.

The Add, Edit and Delete command buttons maintain the individual user records. The
Copy button makes a copy of the current addressee information to allow the addition
of another entry in the current Address Book. The name or address must be changed,
before you can save a new entry. Duplicate records within the same Address Book are
not allowed. The Dupe Button copies the current user information to another Address
Book. The ClpBrd button copies the user info to the clipboard. The Load Button
changes the current Address Book. The Find Button searches across all records within
the current book for the search text. The search begins in the current record and
proceeds in a forward direction. The Repeat button repeats the previous search from
the current user record.

Address Window Related Dialogs
Edit Address
Address Find Text

Edit Address Dialog
The Edit Address Dialog maintains the Address Book entries. The user name field's
maximum length is 80 characters. The Address field's limit is 255 characters. All
Forum messages cut the name and address fields to 25 characters. No duplicate
entries are allowed in the same Address Book. Duplicate records are determined by
comparing the name and address fields to all other records in the current Address
Book.

Address Find Text Dialog
The Address Find Text Dialog receives user input on a specific text to find within the
current Address Book. This Dialog searches all fields within each Address Book
entry. The search is in a forward direction starting at the current entry.
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Edit File Window
The Edit File Window is a full featured file text editor.

Edit File Menu Overview
The Edit File Main Menu maintains the file handling features, printing, clipboard, line
jumping, search, replace and text configuration features. The File sub menu maintains
the file handling features and the exiting of the Edit File Window. The Print menu
item prints the current file. The Edit sub menu maintains all clipboard handling which
all are standard Windows features. The Search sub menu maintains the find, replace
and line jumping features. The Options sub menu maintains all option settings. The
Help menu item activates the OzWin Help System.

The Options sub menu maintains all option settings for the text handling. The Auto-
indentation menu item controls the indention of a row after the Enter key was struck.
This option is normally used without Word Wrap Set since Word Wrapped paragraphs
cannot be indented. The Create Backup File menu item determines if a .BAK file gets
maintained each time the file is saved. The Tabs sub menu maintains control for the
Tab Key. The Word Wrap menu item determines if the editor wraps at a specific
column. The Wrap At Column menu item maintains the column number to control the
Word Wrap feature. The Worlds Commands menu item controls if Worlds rules apply
to the editor. The Auto indentation, Create Backup File, Word Wrap and Worlds
Commands menu items displays a check mark if the option has been set.

The Tab sub menu maintains the Tab options. If the Fixed Tabs option is selected,
pressing Tab advances the cursor to the next Tab Stop, inserting the appropriate
number of spaces. If the Real Tabs option is selected, pressing Tab advances the
cursor the appropriate number of spaces, inserting a tab character at the cursor
position. If the Smart Tabs option is selected, pressing Tab advances the cursor
position below the first letter in the next word in the row directly above the current
row. This option is particularly helpful in making columns The Tab Size menu item
maintains the number of spaces to advance the cursor for the Fixed Tabs option.

Edit File Related Dialogs

Find
Go To Line
Replace Dialog
Wrap At Column

Find Dialog
The Find Dialog activates a search for the search text, entered into the Find What
field. This dialog searches within the current message or file for the search text. When
a match is found, the found text is selected. This dialog remains on the screen until
you close it down. Select the Find Button to start and repeat the search. The Start at
Cursor radio button sets the search starting point at the cursor position. The Selected
Text radio button confines the search to the selected text only. The Search Globally
radio button resets the search starting point at the beginning or end of the message or
file depending on the direction of the search.



Copyright(c)1994 Alchemy International, Ltd. All rights reserved OzWin page 27

Go To Line Dialog
The Go To Line Dialog receives a line number, and jumps to that line. If an invalid
line number is entered this feature jumps to the last row possible.

Replace Dialog
The Replace Dialog activates a search and replace for the search text within the
current file or message. When a match is found the found text is selected. The dialog
remains on the screen until you close it down. The Start at Cursor Radio button sets
the search starting point at the cursor position. The Selected Text radio button
confines the search to the selected text only. The Search Globally radio button resets
the search starting point at the beginning or end of the message or file depending on
the direction of the search. The Find, Replace and Replace all buttons start the search.
Once a match has been found, the text found is selected. The Find button skips an
occurrence of the matched text and continues. The Replace button replaces the
matched text and continues. The Replace All button does not prompt before replacing
the text.

Wrap At Column Dialog
The Wrap at Column Dialog maintains what column to wrap the text in the File Edit
Dialog. This setting is defaulted to the Inbox Wrap Width setting in the Configuration.
This setting does not effect the word wrapping unless the Word Wrap menu item is
selected (i.e. a check must appear to the left of the description).
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Message Viewer Window

The Message Viewer displays Inbox messages in a read-only. The flags are the only
component of the Inbox messages that can be edited.

Message Viewer Menu Overview
The Message Viewer menu bar maintains all features for the Message Viewer
Window. The File menu item maintains the file handling and active windows. The
Edit menu item maintains the text features. The Prov, Next and Jump menu items,
select messages. The Manage menu item maintains the flag settings and message
handling features. The Reply menu item creates a message in reply to the current
message. The Index menu item pops up the Message Browser displaying the current
message. The Tree menu item displays the hierarchy of the Mail Thread. The Subjects
menu item maintains a list of all subjects of the messages in the Message Viewer. The
Tools menu item maintains the Address Book and Outbox message handling. The
Help menu item activates the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Export To File menu item copies the selected
text from the current message to a specified file. The Window List Menu Item
displays the OzControl Popup Menu. The Exit menu item normally terminates the
Message Viewer.

Edit
The Edit sub menu maintains the text in the current message. The Copy menu item
copies the selected text to the clipboard. Quotes copies the selected text to the Reply
editor. For the Quotes to work you must have a reply to the current message in an
active window. The Find and Find Next menu items, search the current message for
the search text. The Go To Line menu item jumps to the specified line in the current
message.

Prov
Next
The Prov and Next sub menus select new messages from exactly opposite directions,
using selected menu items as the criteria. The Next sub menu is the only one defined.
If the Prov sub menu differs from the Next sub menu, then it also will be defined for
that specific situation. The Message menu item selects the next message. The In This
Thread menu item selects the next message in the current thread. The Thread menu
item selects the first message in the next thread. The Root of This Thread menu item
selects the root message of the thread. The root message the first message in the
viewer with the same subject as the current message. The Root of This Thread menu
item is in the Prov sub menu only. The Starting Point menu item selects the next
starting point. A Starting Point is the next message that has been replied to. The
Tagged menu item selects the next tagged message. From "FM" Address selects the
next message with the same sender.

Manage
The Manage sub menu performs operations directly effecting the message(s) and their
flags. The Tag, Save, Print Messages, Mark Seen, Hold, Purge, and Kill sub menu's
all use very similar menu items. Save and Print Messages save and print immediately,
the other sub menus set flags within the message. The Forward Message menu item
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assigns the current message to be sent to another addressee. The Search menu item
searches across all messages within the current File for the given text. The Update
File menu item updates the messages according to the flags set (i.e. Kill flags, Purge
Flags). The Hide and Sort messages menu items are Power Services Features.

Manage|Tag Messages
Manage|Mark Hold
Manage|Mark Hold
Manage|Mark Purge
Manage|Mark Kill
Manage|Save Messages
Manage|Print Messages

The sub menus contain criteria menu items to set flags or perform tasks. The This
Message menu item selects the current message only. The Whole Thread menu item
selects all messages with the same subject. The Thread Back menu item selects all
with the same subject prior to the current message. The Thread Forward menu item
selects all with the same subject after the current message. The All Tagged menu
item, selects all with the Tag flag set. The All Previous menu item selects all
messages prior to the current. The All After menu item selects all messages after the
current. The Clear All menu item unmarked all flags. The Eject Page menu item form
feeds the printer page.

Search
The Search Messages sub menu activates a search for the search text across all
messages in the file. The Text Search menu item activates a search for specific text
across all messages within the current file. The search starts at the cursor position
within the current message and searches through the messages until a match is found
or the search is complete. The Repeat Last Search menu item performs the previous
search again.

Jump
The Jump sub menu selects a new message according to the menu items. The CIS
Number menu item receives a Msg ID# to select as the new message. The Local
Number menu item receives a local message number to select as the new message.
The Local Number is the number OzWin assigns to each message, and is displayed in
the Header of the current window. The Head of File or Tail of File menu items, select
the first or last message in the file. The First New (Unseen) menu item selects the first
message with the Seen flag not set.

Reply
The Reply menu item creates a message replying to the current message. The Reply
editor pops up to receive the message. All addressee information automatically is
filled into the Reply. The flag options of the current message reflect a reply after the
reply is saved.

Index
The Index menu item pops up the Message Browser for the current message file. The
current message in the Message Viewer is displayed as the current message in the
browser.
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Tree
The Tree menu item pops up the Tree Dialog to view the current Mail Thread. The
current message can be changed by selecting a different message. The message
Viewer reflects the new selected message.

Subjects
The Subjects menu item maintains a list of all Subjects for the messages in the current
file. The Subject Dialog pops up to display the subjects and the quantity of messages
per subject. The current subject is determined by the current message. When a new
subject is selected the Message Viewer selects the first message of that subject to
view.

Tools
The Tools sub menu maintains the Address Book and Outbox handling. The Address
sub menu maintains the address book management. The Compose New menu item
composes a new Outbox message. The Compose New window pops up to create the
message. The Edit Outbox menu item maintains the Outbox message(s). The Edit
Outbox Message Window pops up to allow editing of pending messages.

Tools|Address
The Address sub menu pops up the Address Book and adds "From" user(s) to the
current Address Book. Adding is performed by the selection of menu items. The Add
"FM" Address to Book menu item adds the sender of the current message. The Add
Tagged "FM" Addresses to Book menu item adds all senders of messages with the
Tag flag set.

Message Viewer Tool Bar
The Previous Toolbit Group selects previous messages. The Next Toolbit Group
selects messages after the current message. The Compose Toolbit Group composes
new messages, replies and Forwards messages to another addressee. The Text Toolbit
Group copies selected text to the clipboard and files. The Save Copy toolbit group
saves and prints messages. The Message Management toolbit group sets flags for the
current message. The Tree toolbit group displays the hierarchy of the current Mail
Thread. The OzControl toolbit group maintains windows, activates the OzWin Help
System and normal termination of the current window.

The Previous toolbit group contains the Prov Thread, Prov In This Thread and Prov
toolbits. The Prov Thread toolbit selects the first previous message with a different
Subject (Prev|Thread). The Prov In This Thread toolbit selects the previous message
in the current Mail Thread (Prev|In This Thread). The Prov Message toolbit selects
the previous message. (Prev|Message).

The Next toolbit group contains the Next, Next In Thread and Next Thread toolbits.
The Next toolbit selects the next message as the current message (Next|Message). The
Next in Thread toolbit selects the next message with the same Subject as the current
message (Next|In This Thread). The Next Thread toolbit selects the first message that
has a different Subject (Next|Thread).

The Compose toolbit group contains the Compose Reply, Forward Message and
Compose New toolbits. The Compose Reply toolbit composes a message in reply to
the current message. All addressee information is automatically entered (Reply menu
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item). The Forward Message toolbit sends a copy of the current message to another
addressee. The Outbox file holds the message until you upload to CompuServe
(Manage|Forward Message).The Compose New toolbit composes a new message
(Tools|Compose New).

The Text toolbit group contains the Copy to Clipboard and Export toolbits. The Copy
to Clipboard toolbit copies the selected text to the clipboard (Edit|Copy). The Export
toolbit copies the selected text to another file (File|Export To File).

The Save Copy toolbit group contains the Save and Print toolbits. The Save toolbit
saves a copy of the current message to the Save file (Manage|Save Messages|This
Message). The Print toolbit prints the current message (Manage|Print Messages|This
Message).

The Message Management toolbit group contains the Tag, Seen, Hold and Kill
toolbits.
The four toolbits set flags for the current message.
The Tag toolbit sets the Tag Flag (Manage|Tag Messages|ThisMessage).
The Seen toolbit sets the Seen flag (Manage|Mark Seen|This Message).
The Hold toolbit sets the Hold flag (Manage|Mark Hold|ThisMessage).
The Kill toolbit sets the Kill flag (Manage|Mark Kill|This Message).

The Tree toolbit group contains the Tree toolbit. The Tree Toolbit displays the Mail
Thread for the current message (Tree menu item).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Message Viewer normally (File|Exit).

Message Viewer Local Index
The Message Viewer Local Index displays five rows of messages by default. The
Local Index display is controlled by The Show Index in Viewer, CIS Mail Inbox
Index Layout, # of Index Rows and Index Has Header Line options in the Message
Viewer/Browser Options Dialog, which is accessed thru the General Configuration
Dialog. The Show Index In Viewer option determines if the Local Index is displayed.
The CIS Mail Inbox Index Layout option defines what fields are displayed in the
Local Index. The # of Index Rows option determines the number of rows displayed.
The Index Has Header Line option determines if a descriptive header displays above
the fields.

Viewer Control
The Viewer Control displays the current message and is a read only viewer. Change
the current message by selecting toolbits, hot keys, or scrolling in the Message Viewer
Local Index.

OzControl Popup Menu
The OzControl Popup Menu controls navigation between active windows and active
window handling features. The Go To Line Ozcontrol menu item selects the
OzControl Main Window. The Cascade Windows menu item cascades the non
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minimized active windows, The Minimize Windows menu item minimizes all active
windows, The Close All Windows menu item closes all windows including the
minimized windows. The Open Window List is a list of all active windows except
OzControl. The Open Window List is displayed below the menu items. Select a
window to make it the current one.

Message Viewer Related Dialogs

Find Text Across Messages
Mail Address
Subject
Tree

Find Text Across Messages Dialog
The Find Text Across Messages Dialog searches all messages within the current
message list for a match to the search text. When the search text is found, the message
containing the search text is selected. The search begins at the cursor position unless
the Global Search check box is selected. The Global Search option starts the search
from the first or last message in the file depending on the Search Backward option.

Mail Address Dialog
The Mail Address Dialog maintains the header information for the current CIS Mail
Outbox message. Enter the addressee information or select the Name button to choose
from the current Address Book. The name field has a maximum of 80 characters, the
address field limit is 255. Enter the file name or select the Attach File button to assign
a file to upload with the current message. The Binary check box informs CompuServe
to handle this message in a binary format. The Hold check box keeps the message
from being sent. The Get Receipt check box informs CompuServe to create a receipt
after the addressee receives the message. The CC command button activates the
Courtesy Copy Addresses Dialog. the Options command button activates the Mail
Options Dialog.

Mail Address|Mail Options Dialog
The Mail Options Dialog maintains the options for the current message getting
Forwarded to another addressee. For more details about this dialog refer to the Upload
To Mail|Mail Options Dialog definition earlier in this manual.

Subject Dialog
The Subject Dialog displays a list of subjects and the quantity of messages within that
subject. The current subject is highlighted. Select a subject and this dialog returns to
the previous window, with the first message of the selected subject as the current
message. The Tree button displays the hierarchy for the current Thread with the
current message highlighted.
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Tree Dialog
The Tree Dialog displays the hierarchy of the subjects in the current Mail Thread.
The current message is highlighted in the Tree and can be changed. The first message
in the Thread is at the top with all other messages listed in order received after it.
Click or arrow to the desired new current message and select it. This returns to the
previous Window or Dialog with the selected message being the current one.
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Message Browser Window

The Message Browser Window displays Inbox messages. To view the current
message, strike enter or double click with the mouse on the current entry. The
browser menu and tool bar maintain the file handling, flag settings, tree viewing,
subject handling and Address Book features.

Message Browser Menu Overview
The Message Browser Menu maintains most of the features of the Messages Browser.
The File menu item maintains the file and active window features. The Manage menu
item maintains Flag settings, saving and deleting of messages. The Tree menu item
displays the Mail Thread tree. The Subjects menu item maintains the Subject list. The
Address menu item maintains the Address Book and its features. The Help menu item
activates the OzWin Help System.

File
The File sub menu maintains the file handling and active window features. The New
and Open menu items are standard Windows features. The Window List menu item
displays the OzControl Popup Menu. The Exit menu item terminates the Message
Viewer normally.

Manage
The Manage sub menu performs operations directly effecting the message(s) and their
flags. The Tag, Save, Print Messages, Mark Seen, Hold, Purge, and Kill sub menu's
all use very similar menu items. Save and Print Messages save and print immediately,
the other sub menus set flags within the message. Delete Message Online deletes the
current message from CompuServe's data. The Update File menu item searches the
messages for the flag settings and updates the messages accordingly (i.e. Kill flags,
Delete Flags). The Hide and Sort Messages menu items are Power Services Features.

Manage|Tag Messages
Manage|Mark Hold
Manage|Mark Hold
Manage|Mark Purge
Manage|Mark Kill
Manage|Save Messages
Manage|Print Messages

The common menu items used by the sub menus, all select message(s) to set flags or
perform tasks. The This Message menu item selects the current message only. The
Whole Thread menu item selects all messages with the same Subject. The Thread
Back menu item selects all messages with the same subject prior to the current
message. The Thread Forward menu item selects all messages with the same Subject
after the current message. The All Tagged menu item, selects all messages with the
Tag flag set. The All Previous selects all messages prior to the current message. The
All After selects all messages after the current message. The Clear All menu item
clears all flags. Eject Page form feeds the printer page.
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Manage|DeleteMessage Online
The Delete Message Online menu item creates an event to delete the current message
from CompuServe's data. This is dependant on the control given to the you by
CompuServe. If you didn't upload the message you probably cannot delete the
message.

Tree
The Tree menu item displays all messages within the current Thread in the order
received from CompuServe. This allows easy travel from one message to another with
the same subject.

Subject
The Subject menu item maintains a list of all Subjects for the messages in the current
file. This displays the subject and the quantity of messages per subject. The current
subject is determined by the current message. A new subject can be selected from
within here. When a new subject is selected the Message Browser selects the first
message of that subject as the current message in the browser.

Address
The Address sub menu pops up the Address Book and adds the ability to add From
user(s) to the current Address Book. The Add "FM" Address to Book adds the From
user of the current message. The Add Tagged "FM" Addresses to Book adds all
senders of the messages with the Tag flag set.

Message Browser Tool Bar
The Save Copy Toolbit Group maintains the message handling features. The Message
Management Toolbit Group maintains the setting of flags. The Tree Toolbit Group
maintains the tree toolbit. The OzControl Toolbit Group maintains the active
windows, activates OzWin Help System and normal termination of the current
window.

The Save Copy toolbit group contains the Save and Print toolbits.
The Save Toolbit saves a copy of the current message to the save file (Manage|Save
Messages|This Message). The Print Toolbit prints the current message (Manage|Print
Messages|This Message). These toolbits perform the procedure immediately and do
not set any flags.

The Message Management Toolbit group contains the Tag, Seen, Hold and Kill
toolbits. The Tag Toolbit sets the Tag flag for the current message (Manage|Tag
Message|This Message). The Seen Toolbit sets the Seen flag for the current message
(Manage|Mark Seen|This Message). The Hold Toolbit sets the Hold flag for the
current message (Manage|Mark Hold|This Message). The Kill Toolbit sets the Kill
flag for the current message (Manage|Mark Kill|This Message).

The Tree toolbit group contains the Tree toolbit. The Tree Toolbit displays the Mail
Thread for the current message (Tree menu item). The current message in the browser
remains current in the Tree Dialog.

The OzControl toolbit group contains the OzControl, Help and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
naturally terminates the browser (File|Exit).
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Message Browser Related Dialogs
Subjects
Tree

Subjects Dialog
The subjects dialog displays all the subjects of all the messages within the Message
Browser. Refer to the Subjects dialog in the Related dialogs section of the Message
Viewer documentation for more information.

Tree Dialog
The Tree Dialog displays the messages in the browser with the same subject as the
current message. Refer to the Tree dialog in the Related Dialogs section of the
Message Viewer documentation, for more information.
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Quick Scans Window

The Quick Scans window maintains a list of all new message(s). The list is created by
accessing the Online|Custom Mail Processing|Quick Scan Mail. An entry is created
for each message that has not been retrieved. Until a message has been deleted or
retrieved it appears on the list. Set the flags to bypass, read or delete the message(s)
online. The Bypass flag bypasses the message. The Read Flag assigns an event to
retrieve the current message. The Delete flag assigns an event to delete the current
message online. The flag for the current message is set by striking keys, the space bar
and activating the Mark menu item. Enter D for delete online or R for read. The space
bar cycles all three flag settings read, delete online and bypass.

The Quick Scans menu bar controls most of the features for the Quick Scans window.
The Mark sub menu sets the bypass, read and delete online flags. The flags can be set
to the current entry or all entries in the list. The Send menu item saves all changes to
the Quick Scans. The Help menu item activates the OzWin Help System. The Exit
menu item terminates the Quick Scan window normally.

The Quick Scans Viewer Control displays six fields. The FLG, Date, From, Subject,
PBR and Size are displayed for each entry. The FLG displays the flag settings for the
current entry. Three settings are possible, R or read, D or delete and a blank space or
bypass. The Date displays the message date. The From displays the Sender name. The
Subject displays the message subject. The PBR displays three other flags, P or
recipient pay, B or binary and R or receipt notification pending. Size displays the size
of the message.
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Compose Window

The Compose Window composes new Outbox messages.

Compose Menu Overview
The Compose Menu bar can activate all features in the current window. The File
menu item maintains the file handling and active window features. The Print menu
item maintains the printing of the current message. The Edit menu item maintains the
clipboard, Signature and spell checking features. The Search menu item maintains the
text search, replace and line jumping features. The Options menu item maintains the
options for the editing of the text. The post menu item maintains all header
information and posting features. The Address Book menu item pops up the Address
Book. The Help menu item activates the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Import From File menu item copies all text from
another file into the current message. The Export To File menu item copies the
selected text from the current message to a file. The Window List Menu Item displays
the OzControl Popup Menu. The Exit menu item terminates the Compose Window
normally.

Edit
The Edit sub menu maintains the text entry features. The Undo, Redo, Cut, Copy,
Paste and Delete menu items are standard Windows clipboard features. The Signature
menu item imports the Signature from the configuration setting into the current
message. The Spell Check menu item activates a spell checking feature, which is
limited to within the current message.

Options
The Options sub menu maintains all option settings for the text handling. The Auto-
indentation menu item controls the indention of a row after the Enter key was struck.
This option is normally used without Word Wrap Set since Word Wrapped paragraphs
cannot be indented. The Tabs sub menu maintains control for the Tab Key. The Word
Wrap menu item determines if the editor wraps at a specific column. The Wrap At
Column menu item maintains the column number to control the Word Wrap feature.
The Worlds Commands menu item controls if Worlds rules apply to the editor. The
Auto indention, Word Wrap and Worlds Commands menu items display a check mark
if the option has been set.

Options|Tabs
The Tabs sub menu maintains the Tab options. If the Fixed Tabs option is selected,
pressing Tab advances the cursor to the next Tab Stop, inserting the appropriate
number of spaces. If the Smart Tabs option is selected, pressing Tab advances the
cursor position under the first letter of the next word in the row directly above the
current row. This option is very helpful when making even columns. The Tab Size
menu item maintains the number of spaces to advance the cursor for the Fixed Tabs
option.
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Post
The Post sub menu maintains the header information and saves the message to the
Outbox file. The Standard menu item posts the message normally. The Receipt
Request menu item posts the message with the option to receive a receipt when the
Addressee retrieves the message. The Edit Address menu item edits the addressee,
options and CC information for the message.

Compose Tool Bar
The Text Toolbit Group maintains the transferal of text to and from the clipboard and
files. The Message Utilities Toolbit Group maintains the Spell Checker, Signature and
the message header information. The Post Toolbit Group maintains the posting of the
current message. The OzControl Toolbit Group maintains the active windows,
activates the OzWin Help System and normal termination of the current window.

The Text toolbit group contains the Copy, Cut, Paste, Import from File and Export to
file toolbits. The Copy, Cut and Paste toolbits are standard Windows clipboard
features (Edit|Copy, Cut, Paste, Delete). The Import From File toolbit copies all text
from another file into the current message (File|Import From File). The Export to file
copies the selected text from the current message to another file (File Export To File).

The Message Utilities toolbit group contains the Spell Check, Signature and Edit
Address toolbits. The Spell Check toolbit activates the Spell Checker (Edit|Spell
Check). The Signature toolbit imports the Signature into the current message
(Edit|Signature). The Edit Address toolbit manages the current message's header
information (Post|Edit Address).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Compose Window normally (File|Exit).

Compose Editor Control
This is a standard text editor, designed to receive text for the new message.

Compose Related Dialogs
Find
Go To Line
Mail Address
Spell Checker
Replace
Word Wrap

Find
The Find dialog searches for specific text within the current message. Refer to the
Find Dialog in the Related Dialogs section of the Edit File Window documentation,
for more information.
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Go To Line
The Go To Line Dialog jumps to a specific line number in the current message. Refer
to the Go To Line Dialog in the Related Dialog section of the Edit File Window
documentation, for more information.

Mail Address
The Mail Address Dialog maintains the addressee information, Courtesy Copy
Addressees and the options for the current message. Refer to the Mail Address Dialog
in the Related Dialog section of the Message Viewer documentation, for more
information.

Spell Checker Dialog
The Spell Checker Dialog searches the file or message for words not in its' dictionary.
The Spell Checker starts the check from the first word in the message and continues
until the end of the message is reached or the user selects the Cancel Button. When an
unknown word is found it is selected in the message and the Spell Checker Dialog
pops up to prompt the user. Correctly spelled unknown words can be added to the
dictionary.

The command buttons control the features of this dialog. The Ignore and Ignore All
buttons skip the unknown word(s) and continue spell checking. The Change and
Change All buttons change the unknown word(s) to the change to word. The Add
button adds the current unknown word to the Spell Checker Dictionary. The Suggest
button creates a new suggestion list for the current change to word.

Replace
The Replace Dialog searches and replaces text within the current message. Refer to
the Replace Dialog in the Related Dialogs section of the Edit File documentation, for
more information.

Word Wrap
The Word Wrap Dialog maintains the column number to word wrap the current
message at. Refer to the Word Wrap Dialog in the Related Dialogs section of the Edit
File Window documentation, for more information.

Reply Window

The Reply Window pops up from the Message Viewer to create a message in
response to an Inbox message. The Message Viewer displays the current message in
the upper half of the screen, with the Reply Window in the lower half. This allows
viewing of the message, as the Reply is getting created. All addressee information and
default option settings are initiated in the Reply automatically. While the Reply is
getting posted, the correlating Inbox message's Reply flag gets set.
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Reply Menu Overview
The Reply menu bar activates all features in the Reply window. The File menu item
maintains the file handling and active window features. The Print menu item
maintains the printing of the current message. The Edit menu item maintains the
clipboard, Signature and spell checking features. The Search menu item maintains the
text search, text replace and line jumping features. The Options menu item maintains
the options for the editing of the text. The Post menu item maintains all header
information and posting features. The Synchronize menu item selects the correlating
message to the Reply, in the Messages Viewer. The Address Book menu item pops up
the Address Book. The Help menu item activates the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Import From File menu item copies all text from
another file into the current message. The Export To File menu item copies the
selected text to another file. The Window List Menu Item displays the OzControl
Popup Menu. The Exit menu item terminates the Reply Window normally.

Edit
The Edit sub menu maintains the text entry features. The Undo, Redo, Cut, Copy,
Paste and Delete menu items are standard Windows clipboard features. The Signature
menu item transfers the Signature from the configuration into the current message.
The Spell Check menu item activates the Spell Checker.

Search
The Search sub menu maintains the searching, replacing and line jumping within the
current message. The Find menu item activates a text search feature. The search is
limited to text within the current message. The Replace menu item activates a search
and replace feature, which is also limited to the current message. The Find Next menu
item repeats the previous Find or Replace operation. The Go To menu item activates a
dialog to receive a line number , then positions the cursor on that line number.

Options
The Options sub menu maintains all option settings for the text handling. The Auto-
indentation menu item controls the indention of a row after the Enter key is struck.
This option is normally used without the Word Wrap option set, since Word Wrapped
paragraphs cannot be indented. The Tabs sub menu maintains tabbing within the
message. The Word Wrap menu item determines if the editor wraps at a specific
column. The Wrap At Column menu item maintains the column number to control the
Word Wrap feature. The Worlds Commands menu item determines if Worlds rules
apply to the editor. The Auto indention, Word Wrap and Worlds Commands menu
items display a check mark if the option has been set.

Options|Tabs
The Tabs sub menu maintains the Tab option settings. If the Fixed Tabs option is
selected, pressing Tab advances the cursor to the next Tab Stop, inserting the
appropriate number of spaces. If the Smart Tabs option is selected, pressing Tab
advances the cursor to the position in the current row, below the first letter of the next
word in the row directly above the current row. The Tab Size menu item maintains the
number of spaces to advance the cursor for the Fixed Tabs option. The Fixed tabs and
Smart tabs menu items display a check mark in the menu for the selected option.
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Post
The Post sub menu maintains the message header information and posts the message
to the Outbox file. The Standard menu item saves the message normally. The Receipt
Request menu item saves the message with the option to receive a receipt when the
Addressee retrieves the message. The To All Tagged menu item, posts the Reply
normally and adds all senders of tagged messages to the CC list. The To All Tagged
with Receipt menu item, posts the Reply with the option to receive a receipt and adds
all senders of the tagged messages to the CC list. The Edit Address menu item edits
the addressee, options and CC information for the message.

Reply Tool Bar
The Synchronize Toolbit Group synchronizes the current message in the Message
Viewer, to the Reply. The Text Toolbit Group maintains the transferal of text to and
from the clipboard and files. The Message Utilities Toolbit Group maintains the spell
checking, Signature and message header information. The Post Toolbit Group
maintains the posting of the current message. The New Toolbit Group composes new
Outbox messages. The OzControl Toolbit Group maintains the active windows,
activates the OzWin Help System and the termination of the current window.

The Text toolbit group contains Copy, Cut, Paste to clipboard, Import from File and
Export to File toolbits. The Cut (Edit|Cut), Copy (Edit|Copy) and Paste (Edit|Paste)
toolbits are standard Windows features. The Import from File toolbit copies all text
from another file into the current message (File|Import from File). The Export to File
toolbit copies the selected text from the current message to another file (File|Export to
File).

The Message Utilities toolbit group contains the Spell Check, Signature and Edit
Address toolbits. The Spell Check toolbit activates the Spell Checker (Edit|Spell
Check). The Signature toolbit imports the Signature into the current message
(Edit|Signature). The Edit Address toolbit maintains the current message's header
information (Post|Edit Address).

The Post toolbit group contains the Post, Post Receipt Request and Edit Address
toolbits. The Post toolbit saves all changes made in the current message
(Post|Standard). The Post Receipt Request toolbit saves all changes to the current
message and sets the Receipt Requested flag (Post|Receipt Request).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
toolbit activates the OzWin Help System (Help menu item). The Exit toolbit
terminates the current window normally (File|Exit).

Reply Editor Control
The Reply Editor Control is a standard text editor, designed to receive the text of the
current message being created.
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Reply Related Dialogs
Find
Go To Line
Mail Address
Replace
Spell Checker
Word Wrap

Find
The Find dialog searches for specific text within the current message. Refer to the
Find Dialog in the Related Dialogs section of the Edit File Window documentation,
for more information.

Go To Line
The Go To Line Dialog jumps to a specific line number in the current message. Refer
to the Go To Line Dialog in the Related Dialogs section of the Edit File Window
documentation, for more information.

Mail Address
The Mail Address Dialog maintains the addressee information, Courtesy Copy
Addressees and the options for the current message. Refer to the Edit Address Dialog
in the Related Dialogs section of the Message Viewer Window documentation, for
more information.

Spell Checker Dialog
The Spell Checker scans the current message for words not within its' dictionary.
Refer to the Spell Check Dialog in the Related Dialogs section of the Compose
Window documentation, for more information.

Replace
The Replace Dialog searches and replaces text within the current
message. Refer to the Replace Dialog in the Related Dialogs section
of the Edit File Window documentation, for more information.

Word Wrap
The Word Wrap Dialog maintains the column number to word wrap the
current message at. Refer to the Word Wrap Dialog in the Related
Dialogs section of the Edit File Window documentation, for more
information.
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Outbox Viewer Window

The Outbox Viewer Window maintains the Outbox messages before they have been
sent to CompuServe.

Outbox Viewer Menu Overview
The Outbox Viewer menu bar activates all features of the Outbox
Viewer Window. The File menu item maintains the file handling and active window
features. The Edit menu item maintains the clipboard, Signature and spell checking
features. The Search menu item maintains the text search, replace and line jumping
features. The Prov menu item selects the previous Outbox message. The Next menu
item selects the next Outbox message. The Manage menu item maintains the message
handling features and multiple message searches. The Jump menu item selects new
messages. The Index menu item pops up the Outbox Browser Window. The Options
menu item maintains the options for editing the text within the current message. The
Tools menu item pops up the Address Book and composes new messages. The Post
menu item saves all changes made to the current message, edits the header
information and maintains the setting of the Hold flag. The Help menu item activates
the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Import From File menu item copies all text from
another file into the current message. The Export To File menu item copies the
selected text to another file. The Window List Menu Item Displays the OzControl
Popup Menu. The Exit menu item terminates the Outbox Viewer Window normally.

Edit
The Edit sub menu maintains the text handling features. The Undo, Redo, Cut, Copy,
Paste and Delete menu items are standard Windows clipboard features. The Signature
menu item transfers the Signature from configuration into the current message. The
Spell Check menu item activates the Spell Checker.

Search
The Search sub menu maintains the searching, replacing and line jumping within the
current message. The Find menu item activates a text search feature. The search is
limited to text within the current message. The Replace menu item activates a search
and replace feature, which is also limited to the current message. The Find Next menu
item repeats the previous Find or Replace operation. The Go To menu item activates a
dialog to receive a line number , then positions the cursor on that line number.

Manage
The Manage sub menu maintains cross message searches and the message handling
features. The Search Messages menu item searches all messages in the file for the
search text. The Save Message menu item saves the current message to the save file.
The Print Message menu item prints the current message. The Delete Message deletes
the current message.

Manage|Search Messages
The Search Messages sub menu maintains the multiple message searching. The Text
search menu item activates the search feature. A dialog pops up to receive the search
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text. the Repeat Last Search menu item searches for the next occurrence of the search
text starting at the position the previous search ending.

Jump
The Jump sub menu selects a new message according to the menu items. The Local
Number menu item is the number OzWin assigns to each message, and is displayed in
the Header of the current window. The Head of File or Tail of File menu item, select
the first or last message in the file.

Options
The Options sub menu maintains all option settings for the text handling. The Auto-
indentation menu item controls the indention of a row after the Enter key was struck.
This option is normally used without Word Wrap Set since Word Wrapped paragraphs
cannot be indented. The Tabs sub menu maintains control for the Tab Key. The Word
Wrap menu item determines if the editor wraps at a specific column. The Wrap At
Column menu item maintains the column number to control the Word Wrap feature.
The Worlds Commands menu item controls if Worlds rules apply to the editor. The
Auto indention, Word Wrap and Worlds Commands menu items display a check mark
if the option has been set.

Options|Tabs
The Tab sub menu maintains the Tab options. If the Fixed Tabs option is selected,
pressing Tab advances the cursor to the next Tab Stop, inserting the appropriate
number of spaces. If the Smart Tabs option is selected, pressing Tab advances the
cursor to the beginning of the next word in the row directly above the current row.
The Tab Size menu item maintains the number of spaces to advance the cursor for the
Fixed Tabs option.

Post
The Post sub menu maintains all changes and the header information for the
messages. The Standard menu item saves changes to the current message. The
Receipt Request menu item saves changes to the current message and sets the Receipt
Request flag. The Edit Address menu item maintains all addressee, attached file, CC
and flags.

Outbox Viewer Tool Bar
The Previous toolbit group selects new messages in the list prior to the current
message. The Next toolbit group selects new messages after the current message. The
Text toolbit maintains the transferral of text to and from the clipboard and files. The
Message Management toolbit group maintains the message handling features. The
Message Utilities toolbit group maintains the spell checking, Signature and message
header information. The Post toolbit group maintains the posting of the current
message. The New toolbit group composes new Outbox messages. The OzControl
toolbit maintains the active windows, activates the OzWin Help System and normal
termination of the current window.

The Previous toolbit group contains the Head of File toolbit and the Prov Message
toolbit. The Head of File Toolbit selects the first message in the Outbox (Jump|Head
of File). The Prov Message toolbit selects the previous message (Prov menu item).
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The Next toolbit group contains the Next toolbit and the Tail of File toolbit. The Next
Toolbit selects the Next message (Next menu item). The Tail of File toolbit selects
the last message in the Outbox file (Jump|Tail of File).

The Text toolbit group contains Copy, Cut, Paste to clipboard, Import from File,
Export to File toolbits. The Cut (Edit|Cut), Copy (Edit|Copy), Paste (Edit|Paste)
toolbits are standard Windows features. The Import from File toolbit copies all text
from another file into the current message (File|Import from File). The Export to File
toolbit copies the selected text to another file (File|Export to File).

The Message Management toolbit group contains the Save, Print, Delete and Hold
toolbits. The Save toolbit saves the message to the Save file (Manage|Save Message).
The Print toolbit prints the current message (Manage|Print Message). The Delete
toolbit deletes the current message immediately (Manage|Delete Message). The Hold
toolbit sets the Hold flag for the current message (Post|Mark Hold).

The Message Utilities toolbit group contains the Spell Check, Signature and Edit
Address toolbits. The Spell Check toolbit activates the Spell Checker (Edit|Spell
Check). The Signature toolbit imports the Signature into the current message
(Edit|Signature). The Edit Address toolbit manages the current message's header
information (Post|Edit Address).

The Post toolbit group contains the Post and Post Receipt Request and Edit Address
toolbits. The Post toolbit saves all changes to the current message (Post|Standard).
The Post Receipt Request toolbit saves all changes to the current message and sets the
Receipt Requested flag (Post|Receipt Request).

The New toolbit group contains the Compose New toolbit. The Compose New toolbit
composes a new Outbox message (Tools|Compose New).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Outbox Viewer normally (File|Exit).

Outbox Viewer Local Index
The Outbox Viewer Local Index displays five rows of messages by default. The Local
Index display is controlled by The Show Index in Viewer, CIS Mail Outbox Index
Layout, # of Index Rows and Index Has Header Line options in the Message
Viewer/Browser Options Dialog, which is accessed thru the General Configuration
Dialog. The Show Index In Viewer option determines if the Local Index is displayed.
The CIS Mail Outbox Index Layout option defines what fields are displayed in the
Local Index. The # of Index Rows option determines the number of rows displayed.
The Index Has Header Line option determines if a descriptive header displays above
the fields.

Outbox Viewer Control
The Outbox Viewer control is a text editor which displays the current message and
allows editing of all messages within the current Outbox file.
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Outbox Viewer Related Dialogs
Find
Find Text Across Messages
Go To Line
Mail Address
Replace
Spell Checker
Word Wrap

Find
The Find dialog searches for specific text within the current message. Refer to the
Find Dialog in the Related Dialogs section of the Edit File Window documentation,
for more information.

Find Text Across Messages
The Find Text Across Messages Dialog searches across all messages in the current
file for the specific text. Refer to the Find Text Across Messages Dialog in the
Related Dialogs section of the Message Viewer Window documentation, for more
information.

Go To Line
The Go To Line Dialog jumps to a specific line number in the current message. Refer
to the Go To Line Dialog in the Related Dialog section of the Edit File Window
documentation, for more information.

Mail Address
The Mail Address dialog maintains all header information for the current message.
Refer to the Mail Address Dialog in the Related Dialogs section of the Message
Viewer Window documentation, for more information.

Spell Checker Dialog
The Spell Checker scans the current message for words not within its' dictionary.
Refer to the Spell Checker Dialog in the Related Dialogs section of the Compose
Window documentation, for more information.

Replace
The Replace Dialog searches and replaces text within the current message. Refer to
the Replace Dialog in the Related Dialog section of the Edit File Window
documentation, for more information.

Word Wrap
The Word Wrap Dialog maintains the column number to word wrap the current
message at. Refer to the Word Wrap Dialog in the Related dialogs section of the Edit
File Window, for more information.
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Outbox Browser Window

The Outbox Browser displays Outbox messages. The text of the message can be
viewed by striking the Enter Key or double clicking the message with the mouse. The
Menu Bar and Tool Bar maintain the features of the Outbox Browser. The Outbox
Browser maintains file handling, flag setting, message header information, message
handling, address book and help menu features.

Outbox Browser Menu Overview
The Outbox Browser menu bar activates the features of the browser. The File menu
item maintains the file and active window handling. The Flags menu item maintains
the flag setting. The Edit Address menu item maintains the addressee, attach File, CC
and options for the current message. The Save menu item saves the current message
to the default Save file. The Print menu item prints the current message. The Delete
menu item immediately deletes the current message. The Address Book menu item
pops up the Address Book. The Help menu item activates the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Window List Menu Item displays the OzControl
Popup Menu. The Exit menu item terminates the Outbox Browser normally.

Flags
The Flags sub menu sets flags for the current message. The Mark Hold menu item
sets the Hold flag. The Mark Binary menu item sets the Binary flag. The Mark Get
Receipt sets the Receipt flag. The Mark Want Reply sets the Reply flag.

Outbox Browser Tool Bar
The Previous toolbit group and the Next toolbit group, select new messages. The
Message Management toolbit group maintains message handling features. The Edit
Address toolbit group maintains the header information for the current message. The
OzControl toolbit group maintains the active windows, activates the OzWin Help
System and terminates the Outbox Browser normally.

The Previous toolbit group contains the Head of File toolbit. The Head of File Toolbit
selects the first message in the Outbox file.

The Next toolbit group contains the Tail of File toolbit. The Tail of File toolbit selects
the last message in the Outbox file.

The Message Management toolbit group contains the Save, Print, Kill and Hold
toolbits. The Save toolbit saves the message to the default Save file (Save menu item).
The Print toolbit prints the current message (Print menu item). The Kill toolbit deletes
the current message immediately (Delete menu item). The Hold toolbit sets the Hold
flag for the current message (Flags|Mark Hold).
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The Edit Address toolbit group contains the Edit Address toolbit. The Edit Address
toolbit maintains all header information for the current message (Edit Address menu
item).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Outbox Browser normally (File|Exit).

Outbox Browser Control
The Outbox Browser Control displays the messages for easy and quick scanning. The
Browser Control displays five fields by default. For custom control refer to the
Message Viewer/Browser Options Dialog. The Flags, Subject, Addressee, Attached
and number of CC are displayed.

Outbox Browser Related Dialogs

Mail Address

Mail Address
The Mail Address dialog maintains all header information for the current message.
Refer to the Mail Address Dialog in the Related Dialog section of the Message
Viewer documentation, for more information.
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Terminal Window

The Manual Terminal
The Manual Terminal Window maintains all text from CompuServe, responses from
the user to CompuServe and a menu bar. The menu bar maintains the capturing of the
text displayed on the screen, Script handling and an external editor.

The Capture sub menu maintains a file which records all text displayed on the screen
during the session until Capture is turned off or the Manual Terminal window is
closed. A file dialog pops up to receive the file name to save the captured information
into. If the file does not exist it is created; if the file already exists, capture appends to
the existing file.

The Scripts sub menu maintains all Script handling within the Manual Terminal
Window. The Run Script menu item allows the running of a Script. Select this menu
item to select a script filename to be executed. To abort the execution of a script,
select this option a second time. The Learn Script menu item allows the program to
"learn" a script by recording the prompts CompuServe presents and the responses you
enter to those prompts; this information is written to a Learn (.LRN) file that you
specify. To turn Learn Mode off, select this option a second time. The Edit Learn
Buffer menu item allows you to edit the current file of Script language saved by the
Learn Script feature while Learn Mode is active.

The Tools menu item activates an external editor. The File Dialog pops up to receive
the editor filename to activate.

Automatic Terminal
The Automatic Terminal Window displays the communication between OzWin and
CompuServe, displaying all events as they are performed. A menu bar gives you
access to the available commands while in this mode.

The menu bar allows aborting of the current session and toggles the current session
between automatic and manual mode. When the Session Terminal option is selected,
the session drops into manual mode only after all automatic events have been
performed. The Manual Terminal begins from the CompuServe "TOP" menu. Select
the Exit menu item in the Manual Terminal Window to return to automatic mode. The
Forum Terminal option waits until the current auto-processing function block is
performed (either CIS Mail processing or Forum Processing in the current forum) and
then drops into manual mode. If the program is performing CISMail processing when
you select this option, manual mode is entered at the CompuServe "TOP" menu; if the
program is performing Forums processing when this option is selected, manual mode
is entered at the "Forum !" prompt in the forum that just completed automatic
processing. Select the Exit menu item in the Manual Terminal Window to return to
automatic mode. The Forum Terminal option resets each time you return from the
Manual Terminal Window.
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THE FORUM SERVICES UNIT

This section only defines Forum Services User. Refer to the Basic Services Feature or
Power Services Feature for a definition of all other features.

OzControl Window
The OzControl Window maintains Forum messages, Forum handling, Libraries and
going online to CompuServe.

OzControl Menu Overview
The OzControl main menu activates the features for OzWin. The Message menu item
maintains Forum messages and online message searches. The Libraries menu item
maintains file handling features. The Services menu item updates the Forums list. The
Online menu item controls sessions and their events. The Setup menu item maintains
the configuration information for the current Forum.

Messages
The Messages sub menu maintains the Forum messages features. The Read Inbox
Messages menu item views the active Inbox messages for the current forum. The
Messages in Folders menu item views Saved and Purged messages. The View
QuickScan Headers menu item maintains a list of subjects with new messages. The
View Watch Subjects menu item maintains a list of subjects to auto-retrieve
messages. The Compose New Message menu item composes new Forum message(s).
The Edit Outbox menu item maintains the Outbox Forum messages. The Custom
Message Services assigns an event to search for a message(s) within the current
Forum while online. The Job Cards menu item creates a custom online session.

Messages|Messages In Folders
The Messages In Folders sub menu views Saved and Purged message files. The
Purged Messages menu item views the Purged messages. The Saved Messages .SAV
menu item views the Saved Inbox messages from .SAV files. The Save Outbox
Messages menu item views Saved Outbox messages. The Other menu item views all
Saved Inbox messages from files not ending in .SAV.

Messages|CustomMessage Services
The Custom Message Services menu item assigns a search for messages within the
current Forum. The Custom Message Search Dialog pops up to receive the criteria for
the search. The search can retrieve messages or only message headers. The result of a
message headers search is added to QuickScan headers list.

Libraries
The Libraries sub menu maintains the file handling. The Download Files menu item
maintains a list of all files waiting to download from CompuServe. The Catalog
Entries menu item is a list of files and their abstract that resulted from a search. The
Listing Entries menu item displays a list of files without the abstract. The Upload
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Files menu item maintains a list of files to upload to CompuServe. The Library
Searches menu item assigns a search for files that correlate with specific criteria
entered.

Services
The Services sub menu maintains events that retrieve services information from
CompuServe. The Update Forums List menu item is an option to retrieve a new list of
all available Forums on CompuServe. When this option is selected a check mark is
displayed in the menu item.

Online
The Online sub menu activates all Sessions with CompuServe. Each menu item
performs a different series of online events. All Forum related menu items perform
any pending Services events while online.

Online|The New(1st), All Active Forums
Online|The New(1st), Current Forum
The New (1st) Pass, All Active Forums and the New (1st) Pass, Current Forum menu
items perform the same events, the only difference is the number of Forum(s)
involved. Both New 1st. Pass menu items retrieve and send CIS Mail messages,
perform any pending Services, retrieves waiting messages for the current Forum,
retrieves New Messages, performs Quick Scans, all Custom Message Searches and
sends all pending outfox message(s) and file(s).

Online|Send (2nd), All Forums
Online|Send (2nd), Current Forum
The Send (2nd) Pass, All Forums and The Send (2nd) Pass, Current Forum menu
items perform the same events, only the number of Forums entered are different. Both
2nd Pass menu items retrieve and send CIS Mail, preform any pending Services, and
enters any Forum with pending work. Within the Forums the 2nd Pass retrieves all
waiting messages, send all pending Outbox message(s) and file(s), Read Waiting and
New messages, retrieve messages from marked headers in Quick Scan list, perform
any custom message searches, perform any pending file searches, upload files,
download and perform any pending Category and Library libs.

Online|Job Cards,All Forums
Online|Job Cards,Current Forum
The Job Cards, All Forum and Job Cards, Current Forum perform the same events,
the only difference is the number of Forums entered. The Job Cards menu items
perform events according to the Job Card Dialog.

Online|Manual Terminal
The Manual Terminal sub menu maintains the manual connection to CompuServe.
The Log On to Current Forum menu item automatically connects to CompuServe,
enters the current Forum and drops to Manual Terminal mode.

Setup
The Setup sub menu maintains the input of information for OzWin. The Maintain
Groups menu item maintains a list of Groups. This menu item performs the same as
the Current Group area's Maintain command button. The Maintain Forums menu item
maintains the Forums within the current Group and edits the current Forum
configuration settings.
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Setup|Maintain Forums
The Maintain Forums sub menu contains menu items that match the command
buttons in the Defined Forums section of the OzControl Window. The Add menu item
pops up a list of forums available to add to the current Group. The Edit menu item
maintains the Forum configuration settings. The Delete menu item deletes the current
Forum from the current Group. The Sort menu item sorts the Forums within the
current group by Service Prefix then by Forum name. This will increase performance
while online by possible eliminating entering the same node more than once. The
Copy menu item copies the current Forum into another Group. The Move menu item
changes the Forums position within the Group. The Sections menu item pops up a list
of all sections for the current Forum. The Libs menu item pops up a list of all
available Libraries available for the current Forum. The Active menu item turns on the
Active option for the current Forum.

OzControl Tool Bar
The Forum Toolbit Group maintains features for the current Forum. The Online
Forum Toolbit Group maintains online Forum features.

The Forum toolbit group contains the Read Inbox Messages, Compose New,
QuickScan, Download and Library Searches toolbits. The Read Inbox toolbit views
the Inbox messages for the current Forum (Messages|Read Inbox Messages). The
Compose New toolbit composes a new Outbox message for the current Form
(Messages|Compose New Message).The QuickScan toolbit maintains the QuickScan
list (Messages|View QuickScan Headers). The Download toolbit maintains a list of
files to download (Libraries|Download Files). The Lib Srch toolbit activates the
Library Search feature (Libraries|Library Searches).

The Online Forum toolbit group contains the New (1st) Pass and Send (2nd) Pass
toolbits. The New (1st) Pass toolbit performs online events (Online|New (1st) Pass,
Current Forum). The Send (2nd) Pass toolbit performs 2nd pass on-line events.
(Online|New (2nd) Pass Current Forum). Refer to the Online menu documentation for
this window.

OzControl Current Group
The OzControl Current Group area maintains the Forum Groups. The current Forum
Group is displayed at the top of the Drop List. Choose from the Drop list to select a
different Group. The Forums within the current Group are displayed in the Defined
Forums Area. The Maintain command button maintains the list of Groups.

OzControl Defined Forums
The Defined Forum List maintains all Forums within the current Group. The Forum
name is displayed with the correlating Activity Indicators below it. Double click the
Forum to Read the Inbox Messages. The current Forum is highlighted in the list and
also displayed in the header of the window.
The command buttons maintain the current Forum features. The Add button adds a
new Forum to the current Group. The Edit button edits the current Forum. The Delete
button deletes the current Forum from the current Group. The Sort button sorts the
Forums by the Service Prefix then Forum name. The Service Prefix is stored in the
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Configure Forum Dialog. Sorting the Forums save time while online by decreasing the
switching between Service Prefix nodes. The Copy button copies the current Forum to
another Group. A list of Groups pop up to receive a selection. The Move button
moves the current Forum to another position within the Group. The Sections button
pops up the current Forum Sections list. The Libs button pops up the current Forum
Libraries list. The Active button toggles the active status of the current Forum.

OzControl Related Dialogs (Forum Services User)
Add Forum
Configure Forum
Current DLs
Current Uploads
Custom message Search
Download File
Edit Groups
General Configuration
Job Cards
Library Search
Message Viewer/Browser Options
Subjects
Upload File
Watches List

Add Forum Dialog
The Add Forum Dialog contains a pickiest of all the available Forums, arranged in
alphabetical order. This Dialog returns the information from the selected Forum into
the current Group. To add a New Forum to the list, select the New Command Button.
The Configure Forum Dialog pops up to receive the information.

Configure Forum Dialog
The Configure Forum Dialog maintains the current Forum information. All changes to
this Dialog are applied when the dialog is closed.

NOTE Multi-Instance User(s) : Do not change the Forum Name or Files Path unless
Your workstation is the only one in the current Forum.

Enter the Forum name or select the Forum Name command button to choose a Forum.
The Active check box determines if any Forum events get performed while online.
The Forum must be active to execute any events. The Update Forum Info check box
retrieves the Section list, Library list and Announcements for the current Forum. The
Save Outbox Msg option sets an option which allows all Outbox messages to be saved
to the Save Outbox File when they are successfully posted. The Files Path receives the
destination path for all of the current Forum's Files. The Downloads Path menu item
receives the path for all Downloaded files. The Script File field maintains the file
name for the current Forum's Script file. The Signature field maintains the signature
for the current Forum. The Save Outbox File field maintains the filename for the
Outbox messages to be saved in.
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The Read Sections field receives the section numbers to retrieve messages from. The
Scan Sections field receives the sections to Perform Quick Scans in. The previous two
fields have command buttons to pop up the Forum Section list to make selections
from. Comma separate multiple sections in each field. The Read Waiting in New Pass
and Read Waiting in Send Pass check boxes determine when to retrieve waiting
messages. Select the Auto DL Watch Matches check box to assign all messages that
match the Watch Subjects to be retrieved. Unsealed the Option to retrieve header
information only. The header information is returned in the Quick Scans list. The
Single Pass Style check box determines if a 1st Pass performs the features of a 2nd
Pass also. Select the option to perform 1st and 2nd Pass features when the 1st Pass
feature is selected.

The Catalog and Listing Libs fields determine which Libraries to receive Catalog list
and Listing lists for. Enter the Libraries or select the correlating Libs buttons to pop
up a list of libraries to choose from. Comma separate multiple libraries. There are
three radio buttons below each Library List, which maintain if a list is retrieved and if
so, what type of a list. The New Catalog and Listing options download a new list if
files for the current Forum. The Update Catalog and Listing options retrieves an list of
new files since the last time a list was retrieved. If the previous list has not been
merged in the Master Catalog or Master Listing windows it is overwritten when
another list is retrieved. The No Catalog and No Listing options determine if any list
gets retrieved. The AutoUpd Period maintains the number of days between automatic
updates for the Master Catalog and Listing.

The Message Count Limit determines the maximum number of messages for the
current Forum. The Thread Purge Age option determines the number of days to hold
the Thread(s) before purging them. All messages within the Thread must be older
than the Thread Purge Age before they are purged. The Message Purge Age
determines how many days to hold solo messages before purging them. The Message
Purge Age does not effect Threads. Enter a Zero into any of these three fields to
disable the feature.

The High Msg # button maintains the highest message number read for the current
Forum.

Forum Msg Numbers
The Forum Msg Numbers Dialog maintains the High Message Number for the current
Forum. The High Message Number is the highest message that has been retrieved for
the current Forum. Reading messages and the retrieval of messages through Quick
Scanning updates the High Message Number. The Quick Scan method updates the
High Message Number only if the section is not in the Read Sections field of the
Configure Forum Dialog. The lowest and current high message number for the current
Forum are displayed. The Set High Number To field receives a number for
CompuServe to set as the highest message number retrieved by you for the current
Forum. The number entered must be between the lowest on board and CompuServe's
High Message Number. Select the Force HMN to Highest on Board check box to set
the local High Message Number for the current Forum to CompuServe's High
Message Number.

Current DLs Dialog
The Current DLs Dialog maintains a list of files and file searches to download from
the current Forum. The file name, Library number, file size and estimated time to
download are displayed for each file. The Lib column displays the Libraries to
download from or search thru. Only three characters are displayed in the list for this
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field. If more than one section has been entered, select the Edit button to view all
sections. The DLs list is automatically updated after the files have been downloaded.

Current Uploads Dialog
The Current Uploads Dialog maintains a list of file(s) to upload. The list contains
uploads for the current Forum only. The filename, Library to upload to and the format
type are displayed for each entry. The list is updated after the file(s) are uploaded. If
the upload is successful the entry is deleted from the current list. The Add, Edit and
delete command buttons maintain the current upload entry.

Custom Message Search Dialog
The Custom Message Search assigns a search for messages that comply with the
criteria entered in this dialog. The search retrieves messages or message headers from
the current Forum. Enter the Sections in the Section field or select the Sections
command button to pop up a list to choose from. The Sections field is a required entry
and defaults to All. The Age field receives the maximum age of the files in days. If
the Scan Headers Only option is selected, the results of the search is returned in the
Quick Scan list.

Download File Dialog
The Download File Dialog maintains the current entry in the Current DLs list. The
Download Dialog assigns files to download and creates file searches. When adding
enter the CIS Filename, Local Filename and Library number to download from. To
create a search, enter as much information as possible. The maximum number of files
that can be downloaded per search is 50. The MaxBatchDLs option in the General
Configuration Dialog maintains any number less than 50. When a File successfully
downloads the Download file dialog is updated and a CIS Mail entry is created.

Enter in the CIS filename to download or a file mask including wild cards (i.e.
File1.lzh or File1.*). The Local Filename is automatically filled in with the default
path. The size field is used when the Master Catalog or Master Listings Dialog adds a
file to be downloaded. Enter the Libraries to download from or select the Libraries
button to pop up a list to choose from. Separate multiple Libraries with comma's. The
Age field receives the maximum age of files in days.

Edit Groups Dialog
The Edit Groups Dialog maintains the Groups of Forums. A list of Groups is
displayed with the current group highlighted. The Active check box displays if the
current group is the active group or not. The Add command button adds a new group
name to the list of Groups. Adding Forums to the Group is maintained by the Defined
Forums, Add command button. The Delete command button deletes the current
Group. The Move command button pops up the Move Group dialog to reposition the
Group within the list. The Rename command button pops up the Rename Group
Dialog. The Rename Dialog receives a new name for the current Group.

General Configuration Dialog
The General Configuration Dialog maintains the general options for OzWin. To
activate any changes to the configuration OzWin must be terminated then reloaded.
The Options area is the only Forum related section of the General Configuration
Dialog .

The Options area maintains the options for OzWin. The AutoRename Conflicts option
determines if duplicate files are to be renamed while downloading from CompuServe.
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When this option is selected the file is automatically be renamed. If this option is not
selected CompuServe prompts you to see if you want to continue with the download.
Select the AUTHORITATIVE Logos option to retrieve Forum Logos.

Jobcards Dialog
The Job Card Dialog creates a custom built session for the current Forum. Assign the
desired features to the session, by selecting check boxes. The session is activates by
selecting the Online|Job Cards menu items.

Read Waiting Messages This option retrieves waiting messages from the current
Forum.

Read New Messages This option retrieves all messages with numbers larger
than the HMN for the current Sections within the
current Forum.

Send Outbox Messages This option sends all Outbox messages for the current
Forum.

Perform Quick Scan This option retrieves a new Quick Scan Headers list.
Pick Up Marked Headers This option retrieves marked messages within the

current Forum.
Perform Custom Commands This option performs the Pre-Online and Post Online

commands.
Get Announcements This option retrieves each Announcement for the

current message in the form of a Forum message entry
with a number of 9100000. If the Announcement is too
large for a Forum message it is transferred into a file
with the Forum name as the filename. The extension is
AN + the Announcement number.

Catalog Scans This option retrieves a Master Catalog list for the
current Forum.

Library Scans This option retrieves a Master Listing for the current
Forum.

Library Searches This option performs all pending Library Searches for
the current Forum.

Pending Downloads This option performs all pending download events for
the current Forum.

Pending Uploads This option performs all pending upload events for the
current Forum.

Update HMN as Needed This is a Power Services Feature.

Library Search Dialog
The Library Search Dialog creates an online event to search for file(s) within the
current Forum. The results of the Library Search Dialog is determined by selecting
radio buttons. The three choices are Return Matches, Download File(1 file) and
Delete File Online. The Return Matches radio button returns header information for
every file that matches the search and creates an entry in the Master Category. The
Download File (1 file) radio button performs two different features. If only one file
matches the criteria, it is downloaded. If more than one file matched, headers are
retrieved to the Master Catalog. The Delete File Online radio button deletes a file(s)
from CompuServe's data, if you have the control over the file. CompuServe makes all
final decisions on file deletions.
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The Libraries field receives the libraries to search thru. Enter in the Libraries to
search thru or select the Libraries command button to pop up a list to choose from.
Separate multiple libraries with comma's. Select the Upholder UID button to pop up
the Address Book or enter a User ID into the Upholder ID field. The Age field
receives the maximum age of a file in days. The Keyboards field searches through the
Keyboards field in the files for a match.

Message Viewer/Browser Options Dialog
The Message Viewer/Browser Options Dialog maintains information for messages,
viewers and browsers. To activate changes within this dialog OzWin must be
terminated then re-loaded. The last area maintains the fields and rows to display
within the browsers.

The Remove Duplicates option searches thru the messages for the current Forum and
automatically deletes any messages that are duplicate. Set the Remove Session
Headers option to purge and hide the Session Header entries while they are loading in
the viewer or browser. Unmarked this option to automatically set the Kill flag in all
Session Header entries.

The Forum Inbox and Outbox Index Layout fields determine what is displayed for
each message in the browsers. Within each field, a series of letters are used to
represent the fields to display. Each of the two fields use a slightly different set of
letters. Enter multiple letters side by side in the fields without any separation. The
same field letters can be listed more than once.

The Forum Inbox Index Layout field receives the elements to display for the Forum
Inbox Local Index and Message Browser. The definition of the letters are:

D Message Date
N Message Number
F Flags
S Subject
T Addressee
R Sender
C Section

The Forum Outbox Index Layout field receives the elements to display for the Forum
Outbox Local Index and Outbox Browser. The definition of the letters are :

P Parent CIS Number
F Flags
S Subject
T Addressee
C Section

Subjects Dialog
The Subject Dialog displays a list of subjects and the quantity of messages within the
current Forum for the subject. The current subject is highlighted. Select a subject and
this dialog closes and returns to the previous window, with the first message of the
selected subject as the current message. The Tree button displays the hierarchy for the
current Thread with the current message highlighted.
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Upload File Dialog
The Upload File Dialog maintains the file upload entries for the current Forum. Enter
the filename or select the Local Filename button to pop up a list to choose a file from.
Enter the Library to upload the file into or select the Library button and pop up the
Forum Libraries to choose from. The Title field receives a brief description of the file.
The Keyboards field receives specific word(s) which define the contents of the
current file one word at a time. The Abstract field receives a detailed description of
the file.

Watches List Dialog
The Watches List Dialog maintains a list of Forum Thread Subjects. The list is
created by selecting the Add button and adding an entry or thru the Message
Viewer|Tools|Watch Subject.

This list is used to retrieve messages or header information depending on the Auto DL
Watch Matches option in the Configure Forum. If the option is selected matching
messages get retrieved. If the option is nor selected header information is retrieved
and placed in the Quick Scan Headers list.
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Forum OzControl Related Windows

Message Viewer Window

Message Viewer Menu Overview
The Message Viewer Menu Bar maintains the selection of new current message,
deletion of the current message and additions to the Address Book. The Prov, Next
and Jump menu items select messages according to menu items. The Manage menu
item maintains the online deletion of messages and the deletion of Pass Session
Headers. The Tree menu item displays the hierarchy for the current Thread. The
Tools menu items maintains additions to the current Address Book, the Watch Subject
and the Quick Scan list.

Prov
Next
The Prov sub menu selects message(s) previous in the list from the current message.
The Next sub menu selects message(s) after the current message. Both sub menus use
similar menu items to determine which message to select.

Prev/Next|In This Thread
The In This Thread menu item selects the Prev/Next message in the current Forum
Thread. The Root of This Thread menu item selects the first message in the current
Forum Thread. The Starting Point menu item selects the next message in the current
Thread that has been replied to it. The Thread menu item selects the first message
Prev/Next of the current message, in a different Thread. The Session menu item
selects the first message Prev/Next to the current message in the Prev/Next Session.
The To You menu item selects the Prev/Next message addressed to you. The From
You menu item selects the Prev/Next message that you are the sender.

Manage
The Manage sub menu maintains message handling and flag setting features. The
Delete Message Online menu item sets the Kill flag for the current message and
assigns an event to delete the file online. The Forward Message menu item assigns a
copy of the current message to be sent to another addressee. The Mail Address Dialog
pops up to receive the new addressee information. The Remove Groups menu item
sets the Kill flag for all Session Header entries.

Jump
The Jump sub menu selects a new message according to the menu items. The CIS
Number menu item selects messages by the CIS Number entered into the Jump to CIS
Number Dialog. The Parent Message menu item selects the Parent message to the
current message.

Tree
The Tree menu item pops up the Tree Dialog to display all messages within the
current Thread. The Tree Dialog displays the messages in the order received from
CompuServe. The current message can be changed inside the Tree Dialog.
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Tools
The Tools sub menu maintains the Address Book, Watch Subject list and message
creation. The Address sub menu adds the Addressee to the current Address Book. The
Watch Subject menu item adds the current messages subject to the watch list. The
Quick Scan List menu item pops up the Quick Scan Window to maintain the Quick
Scan list for the current Forum.

Message Viewer Tool Bar
The Previous toolbit group selects previous messages. The Next toolbit group selects
messages after the current message. The Tree toolbit group maintains the hierarchy
for the current Thread.

The Previous toolbit group contains the Prov Thread, Prov In This Thread and Prov
toolbits. The Prov Thread toolbit selects the first previous message in the previous
Thread (Prev|Thread). The Prov In This Thread toolbit selects the previous message
in the current Forum Thread (Prev|In This Thread). The Prov Message toolbit selects
the previous message. (Prev|Message).

The Next toolbit group contains the Next, Next In Thread and Next Thread toolbits.
The Next Message toolbit selects the next message (Next|Message). The Next in
Thread toolbit selects the next message in the current thread (Next|In This Thread).
The Next Thread toolbit selects the first message that is in the next Thread in the list
(Next|Thread).

The Tree toolbit group contains the Tree toolbit. The Tree Toolbit pops up the Tree
Dialog. The current message in the Tree Dialog is the same as in the Message
Browser (Tree menu item).
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Message Browser Window

Message Browser Menu Overview
The Message Browser Menu Bar maintains the selection of new current message and
the deletion of the current message. The Manage and Tree are the only Forum related
menu items.

Manage
The Manage sub menu maintains message handling and flag setting features. The
Delete Message Online menu item sets the Kill flag for the current message and
assigns an event to delete the file online. The Remove Groups menu item sets the Kill
flag for all Session Header entries.

Tree
The Tree menu item pops up the Tree Dialog to display all messages within the
current Thread. The Tree Dialog displays the messages in the order received from
CompuServe. The current message can be changed inside the Tree Dialog.

Message Browser Tool Bar
The Tree toolbit group maintains the hierarchy for the current Thread. The Tree
toolbit group contains the Tree toolbit. The Tree Toolbit pops up the Tree Dialog. The
current message in the Tree Dialog is the same as in the Message Browser.

Message Browser Related Dialog
Tree

Tree Dialog
The Tree Dialog displays the hierarchy of the current Forum Thread. The current
message is highlighted in the Tree and can be changed. The first message in the
Thread is displayed at the top with all replies dropping from it. Click or arrow to the
desired new current message and select it. This returns to the previous Window or
Dialog with this message being the current one.
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Quick Scans Window

The Quick Scans Window maintains a list of Threads from the current Forum. The
Quick Scans list provides an efficient way of determining which messages get
retrieved. The Quick Scans lists are created in three ways, request a Quick Scans list,
create a Custom Message Search with the Scanning Headers Only option selected and
read messages while Watch Subjects are defined and the Auto DL Watch Matches
option is not selected. The High Message Number is updated if messages are retrieved
and the current section is not in the Read Sections list. The Read Sections List is
stored in the Configure Forum Dialog.

The normal Quick Scans method scans specific Sections for new messages. A new
message is defined as any message(s) sent to this Forum, with a message number
higher than the High Message Number. The Sections are maintained in the Scan
Sections field of the Configure Forum Dialog. Quick Scans only process if the current
Pass allows Quick Scans.

Once the Quick Scans list has been created and the current Pass is complete. A pair of
eyeglasses appear in the Activity Indicators section of the defined Forums in the
OzControl Window. Edit the Quick Scan list and select the Send menu item. An open
mailbox with the flag up is displayed in the Activity Indicators section. The Quick
Scan is now ready to Retrieve Marked Header(s).

The Menu Bar activates most of the features for this window. The Viewer Control
maintains some flag setting features and selection of the current subject.

Quick Scans Menu Bar
The Quick Scans Menu Bar maintains most features for this Window. The Mark menu
item maintains all flag settings. The Options menu item maintains the options for the
current Forum Quick Scans. The View menu item views the current Forum message
list. The current message in the viewer is set to the last message in the current section
with the current subject. The List menu item pops up the Forum Sections Dialog. The
Send menu item finalizes the operation and closes the Quick Scans window normally.
The Help menu item activates the OzWin Help System. The Exit menu item exits
Quick Scans normally.

Mark
The Mark sub menu toggles the flag settings for the message(s). The Bypass menu
item sets the Bypass flag for the current message. The Read menu item sets the Read
flag for the current message. The Download menu item sets the Download flag for the
current message. The Skip menu item sets the Skip flag. The All menu item sets the
All Flag. The All/Days menu item sets the flag to the number one. The All/Every
menu item sets the Every Flag. The Mark All as Read menu item sets the Read flag
for all entries. The Mark All as Bypass menu item sets the Bypass flag for all of them.

Quick Scans Viewer Control
The Quick Scans Viewer Control displays a list of Threads by section within the
current Forum. Set the desired flags to determine which Threads to retrieve messages
from while online. The flags are set by selecting the Mark menu item or striking the
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flag character key (i.e. Read flag enter R). The list is sorted according to the flag
settings then by Section number within each flag. All new sections are listed at the
bottom of the list. Each flag setting is separated by a flag title row with the flag name
listed in the center.

The Viewer Control is split into 5 columns, the Flag, Msg#, Count, Subject and
Section. The Flag column displays the character for the flag. The Msg# column
displays the CIS number given to the Parent message of this Thread. The Count
column displays the number of new messages for the current subject. The Subject
column displays the Subject of the Thread. The Section column displays the section
number and name.

Quick Scans Related Dialogs

Forum QS Options

Forum QS Options Dialog

The Forum QS Options Dialog maintains options for the current Forum Quick Scans.
The Load Message Index For QS option loads all messages for the current Forum into
memory for viewing, each time the Quick Scan window becomes active. The Mark
New Headers a Read option automatically sets the read flag for all new Subject
Headers. The Max History Count field determines how long the Subject Header
remains in the Quick Scans list.

The Max. History Count field is compared to the number of History Changes to
determine when to delete it from the list. A History Change occurs each session that a
Quick Scan list is downloaded but no new messages were in the subject. The smaller
the History Count the sooner the header is deleted and the smaller the Quick Scan file
remains. A zero entry does not delete the Headers at all.
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Catalog Viewer Window

The Catalog Viewer window maintains two lists containing file headers and the
abstract for files. The first list is the Update Catalog, it is created by CompuServe as a
result of a Library Search or a request for a new or updated list. This list is of files,
from specific sections, that have not been downloaded by you. The sections to retrieve
lists from are maintained in the Forum Configuration dialog. The second list is the
Master Catalog, it is created by OzWin. The Master Catalog is a result of editing the
Update Catalog in this window. The window is a browser/viewer, allowing only
setting of flags and deletion of entries. The menu bar and tool bar maintains the
features of the Catalog Viewer window. The browser area of the window displays the
file entries and the viewer area displays the abstract.

Catalog Viewer Menu Bar
The Catalog Viewer window menu bar activates most of the features for this window.
The File menu item maintains file handling and active window features. The
Download menu item creates an event to download the specified files. The Edit menu
item maintains the Download list, copy to clipboard and search features. The Sort
menu item maintains the sort order for the Catalog Viewer window. The Merge menu
item combines the Update Catalog and Catalog Viewer together and deletes the
Update Catalog. If these two lists do not get merged and another update is retrieved,
data is lost. The Switch menu item toggles the viewer between the Update Catalog and
the Master Catalog. The Tag menu item maintains the Tag flag. The Delete menu
item maintains the deletion of files from both lists. The Save menu item maintains the
save flag. The Help menu item activates the OzWin Help System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Export To File menu item copies the selected
text to another file. The Window List Menu Item displays the OzControl Popup
Menu. The Exit menu item terminates the Catalog Viewer normally.

Edit
The Edit sub menu maintains the text in the current message. The Edit DL List
maintains the Download file list. The Copy menu item copies the selected text to the
clipboard. The Find and Find Next menu items search the current message for the
search text.

Catalog Viewer Tool Bar
The Catalog Viewer tool bar activates the common features for this window. The
Select New toolbit group selects a new file to be current. The Download toolbit group
maintains the downloading of files. The Text toolbit group maintains the transferal of
text. The File Management toolbit group maintain flag settings. The Tag toolbit group
maintains the Tag Flag setting. The OzControl toolbit group maintains the open
windows, the OzWin Help System and exit handling.

The Select New toolbit group contains the Prov toolbit and the Next toolbit.Both
toolbits select file headers in opposite directions.
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The Download toolbit group contains the Download toolbit. The Download toolbit
creates an event to download the current file (Download|Current Entry).

The Text toolbit group contains the Copy to Clipboard and Export to File toolbits.
The Copy to Clipboard toolbit is a standard Windows feature (Edit|Copy). The Export
to file toolbit copies the selected text to another file (File|Export to File).

The File Management toolbit group contains the Save (Save|Current Entry), and
Delete (Delete Current Entry) toolbits which all are standard Windows features.

The Tag toolbit group contains the Tag toolbit. The Tag toolbit toggles the Tag flag
setting (Tag:Current Entry).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Catalog Viewer normally (File|Exit).
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Listing Browser Window

The Listing Browser window maintains two lists of file headers. The Update Listing is
created by CompuServe. This list is of files, from specific sections, that have not been
downloaded by you. The sections to retrieve lists from are maintained in the Forum
Configuration dialog. The second list is the Master Listing which is created by
OzWin. The Master Listing is a result of editing a Update Listing in this window. The
Listing Browser window is a browser allowing only the setting of flags and deletions
of entries. The menu bar and tool bar maintain the features of the Listing Browser
window. The browser area of the window displays the file entries.

Listing Browser Menu Bar
The Listing Browser window menu bar activates most of the features for this window.
The File menu item maintains file handling and active window features. The
Download menu item creates an event to download the specified file. The Edit menu
item maintains the Download list and search features. The Sort menu item maintains
the sort order for the Listing Browser. The Merge menu item combines the Update
Listing and Master Listing together and deletes the Update Listing. If these two files
do not get merged and another update is retrieved, data is lost. The Switch menu item
toggles the viewer between the Update Listing and the Master Listing. The Tag menu
item maintains the Tag flag. The Delete menu item maintains the deletion of files
from both lists. The Retrieve menu item assigns an event to bring down a Master
Catalog entry for the current Listing. The Help menu item activates the OzWin Help
System.

File
The File sub menu performs most of the file handling. The New and Open menu items
are standard Windows features. The Window List Menu Item displays the OzControl
Popup Menu. The Exit menu item terminates the Listing Browser window normally.

Edit
The Edit sub menu maintains the text in the current message. The Edit DL List
maintains the Download list. The Find and Find Next menu items search the current
message for the search text.

Listing Browser Tool Bar
The Listing Browser tool bar activates the common features for this window. The
Download toolbit group maintains the downloading of files. The Delete toolbit group
maintains the deletion of the current entry. The File Management toolbit group
maintains flag settings. The OzControl toolbit group maintains the active Windows,
the OzWin Help System and exit handling.

The Download toolbit group contains the Download toolbit. The Download toolbit
creates an event to download the current file (Download|Current Entry).

The Delete toolbit group contains the Delete toolbit. The Delete toolbit deletes the
current entry from the Listing Browser (Delete|Current Entry).



page 68 OzWin Copyright(c)1994 Alchemy International, Ltd. All rights reserved

The File Management toolbit group contains the Tag and Retrieve toolbits. The Tag
toolbit toggles the Tag flag setting (Tag|Current Entry). The Retrieve toolbit sets the
Retrieve flag for the current entry (Tag|Current Entry).

The OzControl toolbit group contains the OzControl, Help, and Exit toolbits. The
OzControl toolbit displays the OzControl Popup Menu (File|Window List). The Help
Toolbit activates the OzWin Help System (Help menu item). The Exit Toolbit
terminates the Listing Browser Window normally (File|Exit).
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Compose Window

The Compose Window composes new Forum messages.

Compose Menu Overview
The Compose Menu maintains the saving of the current message. The Post sub menu
posts the message as Private, Preserve Formatting and both Private and Preserve
Formatting. The Private menu item sets the Private flag and saves the current
message. The Preserve Formatting menu item sets the Preserve Formatting flag to
prevent CompuServe from reformatting and saves the message. The Both PRI/UNF
menu item sets the Private and Preserve Formatting flags and saves the message.

Compose Tool Bar
The Post Toolbit Group maintains the posting for the current message. The Post
Toolbit Group contains the Standard, Private and Unformatted toolbits. The Standard
toolbit posts the current message (Post|Standard). The Private toolbit posts the current
message and sets the Private flag (Post|Private). The Unformatted toolbit posts the
current message and sets the Unformatted flag (Post|Preserve Formatting).

Compose Related Dialogs

Forum Address
Forum Sections

Forum Address Dialog
The Forum Address Dialog maintains the Addressee information and options for a
Forum message. Enter the Addressee information or select the Name button to pop up
the Address Book to choose from. Enter the section number to send the message to, or
select the section button to pop up the Forum Section Dialog to choose from. The
Private check box sets the privacy of the message. The Unformatted check box sets
the format type as unformatted. The Hold check box prevents the message from
sending. The Fwrd to CIS Mail check box tells CompuServe to generate a copy of this
message and send it to the CIS Mail Inbox for the addressee.

Forum Sections Dialog
The Forum Sections Dialog is a pick list of the Sections within the current Forum. The
Section list returns information to the previous window when a new Section is
selected.
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Reply Window

The Reply Window pops up from the Message Viewer to create a message in
response to an Inbox message. All addressee information and default settings are
inserted into the Reply automatically. While the Reply is getting saved, the correlating
Inbox message's Reply flag gets set.

Reply Menu Overview
The Reply menu bar can activate all features in the Reply window. The post menu
item maintains all header information and posting features. The Post menu item is the
only Forum specific menu item in the Reply window.

Post
The Post sub menu maintains the header information and saves the message to the
Outbox file. The Standard menu item saves the message normally. The Private menu
item sets the Private flag and saves the message to the Outbox. The Preserve
Formatting menu item sets the Preserve Formatting Flag and saves the message. The
Both PRI/UNF menu item sets both the Private and Preserve Formatting flags and
saves the message. The Forward to CIS Mail menu item creates an event to send a
copy of the current message as CIS Mail to the addressee. The Use "TO" Address
menu item saves the message and uses the addressee of the message getting replied to
as the addressee. The Edit Address menu item maintains the addressee and header
information for the current message.

Reply Tool Bar
The Post Toolbit group maintains the posting of the current message. The Post toolbit
group contains the Standard, Private and Unformatted toolbits. The Standard toolbit
posts the message (Post|Standard). The Private toolbit posts the current message and
sets the Private flag (Post|Private). The Unformatted toolbit posts the current message
and sets the Unformatted flag (Post|Preserve Formatting).
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Outbox Viewer Window

The Outbox Viewer Window maintains all out going messages for the current Forum.

Outbox Viewer Menu Overview
The Post sub menu maintains the posting of changes to the current Outbox message.
The Private menu item sets the Private flag. The Preserve Formatting menu item sets
the Unformatted flag. The Both PRI/UNF menu item sets the Private and
Unformatted flags. The Forward to CIS Mail menu item assigns a copy of the current
message to be sent to the same addressee as a CIS Mail message.

The Outbox Viewer Tool Bar
The Outbox Viewer Tool Bar maintains the posting of the current message. The
Forum related Toolbit group is the Post Toolbit Group. The Post toolbit group
contains the Standard, Private and Unformatted toolbits.The Standard toolbit posts the
current message (Post|Standard). The Private toolbit posts the current message and
sets the Private flag (Post|Private). The Unformatted toolbit posts the message and
sets the Unformatted flag (Post|Preserve Formatting).
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The Power Services Unit

OzControl Window

OzControl Main Menu Overview
The OzControl Menu Bar only has one Power Services Feature. The Messages|Job
Cards menu item. The Job Cards menu item maintains a feature which creates custom
online sessions. The Job Cards controls the events getting performed during the
session.

OzControl Configuration Area
The OzControl Configuration Area maintains the Preferences. Select the Preferences
command button to pop up the preferences Configuration Dialog. This Dialog
changes the Preference portion of the configuration options for OzWin. After changes
have been made OzWin must be terminated then reopened to reset the changed
information. The information in this area should not be changed often.

OzControl Related Dialogs

Job Cards
Message Viewer/Browser
Preference Configuration

Job Cards Dialog
The Job Card Dialog creates a custom built session for the current Forum. Select the
checkbooks next to the desired events. The session is activates by selecting the
Online|Job Cards menu items. The only Power Services related checkbook is the
Update HMN as Needed option. The Update HMN as Needed check box assigns an
event to update the current Forums High Message Number if changes have been made
in the Forum Msg Numbers Dialog.

Message Viewer/Browser Options Dialog
The Message Viewer/Browser Options Dialog maintains information for messages,
viewers and browsers. To activate changes within this dialog OzWin must be
terminated then re-loaded. The only Power Services field in this dialog is the Hidden
Message Types.

The Hidden Message Types field maintains a list of characters that represent flags.
The flags are used as criteria to determine which message(s) get automatically hidden
(i.e. P hides all messages with the Purge Flag set).
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N New
! Tagged
S Seen
K Kill
P Purged
D Delete Online
V Saved
R Replied To
H Hold
G Group Headers (Forum Services)

Preferences Configuration Dialog
The Preferences Configuration Dialog maintains the settings within the Preferences,
and is comprised of configuration and option settings from various other dialogs. The
settings in this dialog work as an over-ride system for existing settings. Once
Preferences have been created, enter the preference name into the field , then select
the Load button to edit that preference. The Reset button changes all settings in the
current Preference to the defaults. The Forum Options command button maintains the
current Preference options for all Forums. Any editable field within the Preferences
Dialog can be blanked out or removed. When a field is blanked out the setting is an
empty string and is still a valid setting. A blanked out field tells OzWin to do nothing
with the setting. To remove the setting from the preference enter an "*" in the desired
field. When a preference setting is removed, OzWin refers to the default setting.

Preference Forum Options
The Preference Forum Options Dialog maintains the Forum options for the current
Preference. Each Preference created can save option settings for each Forum. Select
the desired Forum from the Forum Drop list to maintain the options for the current
Preference. The Def Save Inbox field maintains the full path and file name of the
default Inbox save file. If this field is left empty OzWin creates a file using the
standard. Enter your user name and personal Signature into the next fields. The Save
OutBox check box determines if OutBox messages will automatically be saved when
they successfully have been posted. If this field is left empty, OzWin creates a file
using the Forum name as the default. Select the Accept command button to save the
current changes. The Done button it only closes the dialog and returns to the
Preferences Dialog.
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Message Browser Window

Message Browser Menu Overview
The Message Browser Window displays Inbox messages. To view the current
message, strike enter or double click with the mouse on the current entry. The
browser menu bar maintains the flag settings and sort order.

Manage
The Manage sub menu hides the messages and changes the Sort order for the browser.
The Hide Messages menu item hides the messages using menu items as criteria. The
Sort Messages menu item maintains the sort order for the Browser.

Manage|Hide
The Hide Message sub menu sets the hide flag for messages, by using menu items as
criteria. The This Message menu item hides the current message. The Whole Thread
menu item hides all messages within the current Thread. The All Tagged menu item
hides all messages with the tag flag set. The Unheeded All menu item unmarked the
hide flag to re display the messages. The With Flags sub menu automatically sets the
hidden flag if the flags meet the criteria of the menu items.

Manage|Hide|With Flags
The Tag menu item hides all messages that have the tag flag set. The Seen menu item
hides all messages with the Seen flag. The New menu item hides all messages that are
new. The Hold menu item hides all messages with the Hold flag set. The Saved menu
item hides all messages with the Save flag on. The Purged menu item hides the
messages with the save with the Purged flag set. The Kill menu item hides the
messages with the kill flag. The Replied-To menu item hides the messages with a
reply flag. The Delete Online menu item hides all messages with the Delete Online
flag set. The Group header menu item hides all group header messages.

Sort
The Sort Messages sub menu changes the sort order of the Message Browser. The
Sort sub menu uses menu items to determine how the list is to be sorted. The New To
End menu item sorts the newest message to the bottom of the list in order with the
oldest at the top. The Sort To Secs (Thread) sorts the messages by sections within the
Thread. This is only effective if the Sort Messages|Threads is turned on. The New To
End and Sort To Secs menu items are option settings. When they are active a check
mark is displayed on the side of the menu item. The Threads menu item sorts the
messages in alphabetical order by the Subject. The Message Number menu item sorts
the messages by the CIS message number. The Addressee menu item sorts the
messages by the addressee. The Sender menu item sorts the messages by the sender.
The Unsorted menu item sorts the messages in the order received from CompuServe.
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Message Viewer Window

Message Viewer Menu Overview
The Message Viewer Window displays Inbox messages. To view the current message,
strike enter or double click with the mouse on the current entry. The Viewer menu bar
maintains the flag settings and sort order.

Manage
The Manage sub menu hides the messages and changes the Sort order for the viewer.
The Hide Messages menu item hides the messages using menu items as criteria. The
Sort Messages menu item maintains the sort order for the viewer.

Manage|Hide
The Hide Message sub menu sets the hide flag for messages, by using menu items as
criteria. The This Message menu item hides the current message. The Whole Thread
menu item hides all messages within the current Thread. The All Tagged menu item
hides all messages with the tag flag set. The Unheeded All menu item unmarked the
hide flag to re display the messages. The With Flags sub menu automatically sets the
hidden flag if the flags meet the criteria of the menu items.

Manage|Hide|With Flags
The Tag menu item hides all messages that have the tag flag set. The Seen menu item
hides all messages with the Seen flag. The New menu item hides all messages that
have not been seen. The Hold menu item hides all messages with the Hold flag set.
The Saved menu item hides all messages with the Save flag set. The Purged menu
item hides the messages with the Purged flag set. The Kill menu item hides the
messages with the kill flag. The Replied-To menu item hides the messages with a
reply flag. The Delete Online menu item hides all messages with the Delete Online
flag set. The Group header menu item hides all group header messages.

Sort
The Sort Messages sub menu changes the sort order of the Message Browser. The
Sort sub menu uses menu items to determine how the list is to be sorted. The New To
End menu item sorts the newest message to the bottom of the list in order with the
oldest at the top. The Sort To Secs (Thread) sorts the messages by sections within the
Thread. This is only effective if the Sort Messages|Threads is turned on. The New To
End and Sort To Secs menu items are option settings. When they are active a check
mark is displayed on the side of the menu item. The Threads menu item sorts the
messages in alphabetical order by the Subject. The Message Number menu item sorts
the messages by the CIS message number. The Addressee menu item sorts the
messages by the addressee. The Sender menu item sorts the messages by the sender.
The Unsorted menu item sorts the messages in the order received from CompuServe.

Message Viewer Related Dialogs

Mail Options
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Mail Options Dialog
The Mail Options Dialog maintains options for Outbox messages. Select the check
box to set the option that controls the Sensitivity of the message. This option displays
in the header portion of the message. This is not a required check box. OzWin saves
and displays this information , but the message is not handled in a different fashion.
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APPENDICES

OZWIN.INI and CIS.INI

OZWIN.INI
OZWIN.INI is a configuration file, which controls many areas of OzWin. Read this
section before changing OZWIN.INI. A copy of OZWIN.INI should be made and put
onto floppy, for easy retrieval, if the current version gets corrupted.

Any line beginning with a semicolon is considered to be a comment and is be ignored.
Some options may require or be capable of handling more than one response per line,
in those cases use a semicolon to separate the respective responses. This
documentation is not in the OZWIN.INI because of the performance loss by placing
all the comments in the file. Any words to the left of the equal sign or between
brackets are control and cannot be changed. Any line that ends in a equal sign uses the
default setting, but do not remove it from the file.

There are three types of options boolean, numeric and string. The boolean option can
receive YES/NO, TRUE/FALSE, or ON/OFF, response. The numeric option can
receive a number or hexadecimal response. If responding in HEX you must proceed
the number with the $ character. The string type is normally used for file or path
information. If this is the case, a complete path is always required.

[General] :

This section of options are used by OzWinOL

The following option sets the path for OzWin to find the CIS.INI.

CISINIPath=C:\OZWIN

The following option sets the path for OzWin to find the CISScripts.

CISScriptsPath=C:\OZWIN\SCRIPTS

The following option sets the path for OzWin to find the OzScripts.

OzScriptsPath=C:\OZWIN\OZSCRIPT

The following option sets the path for OzWin to find the graphics files to display.

GIFSPath=C:\OZWIN\GIF
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The following option determines the maximum number of files that can be
downgraded per files search. The maximum is 50.

MaxBatchDLs=20

The following option determines if a session.log file is created when online. If set to
NO (the default) no file is created. If set to YES a SESSION.LOG file is created to
store information on what transpired during the previous online session.

SessionLog=NO

When The following option is set to YES, the chars in the #160 - #255 range (the
international chars and symbols of the ISO 8869 character set, commonly known as
ISO Latin I) are mapped to similar characters in the PC ASCII set. The degree of
accuracy of the Latin-1 Support is dependant upon the DOS Codepage.

SupportLatin1=YES

The following option, when set to YES automatically renames any duplicate files
getting down loaded. If The following option is set to NO then you are prompted to
determine if you want to abort this file down load or rename the file. The following
option might save online time, if you like to start an online session and leave the
computer or if you have OzWin auto-run at certain times.

AutoRenameConflicts=YES

The following option controls the size of each block (packet) of data in a BPlus
protocol transfer. If set to YES OzWin checks the next option Packet Size to
determine the size of blocks to send.

SmallPackets=NO

The following option sets the size of the blocks sent during a BPlus protocol transfer.
This needs to be set only if the SmallPackets option is set to YES.

PacketSize=

The following option maintains the Terminal color setting. The TermColor option has
two settings, the foreground is first then the background separated by a comma.

TermColor=E8FFFF,000000

The following option maintains the Editor color setting. The EditColor option has two
settings, the foreground is first then the background separated by a comma.
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EditColor=000000,FFFFFF

The following option determines if the Stock Quotes event should attempt to perform
every session. The default setting is NO.

DoQuotesAlways=NO

The following option determines if the What's New This Week and Update What's
New List events are performed. Setting to Yes prevents the features from performing.

NoWhatsNew=NO

The following option determines the period of time the trend charts reflect. The three
available choices are Daily, Weekly and Monthly.

TrendsPeriod=Weekly

The following option pertains to systems running a 16 color Windows driver. Set this
option to YES to create clearer and more precise coloring in GIFs than contain more
than 16 colors. For all 256 color Window drivers and greater this option is irrelevant.

DitherGIFs=YES

The following option determines if Alert banners for forums are displayed in a dialog
or as text on the screen. Alert banners are displayed while entering a Forum online. If
the Show Alerts option is selected a dialog displays the alert and give a choice of
continuing or skipping the Forum.

ShowAlerts=NO

The following option determines if Logos for the Forums are retrieved while online.

GetLogos=YES

The following option displays a signature in the current message. The signature can
be any literal characters desired. Seven sets of characters display information or
perform specific tasks.

^M Carriage Return
^J Line Feed
^H Backspace
^I Tab
%d Date
%t Time
%v Current version number of OzWin
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Signature=UserName. ^M^J%d %t ^M^J

The following option determines if more than one message viewer can be created
from the browser. Set this option to YES if you would like a new viewer for each
request to view a message. Set this option to no if you want only one viewer. All new
requests for a viewer will re-use the current viewer.

SingleViewerMode=YES

The following option maintains a Pre-Online command to execute before logging on
to CompuServe. Only one command is allowed.

PreCommandLine=

The following option maintains a Post-Online command to execute after exiting
CompuServe. Only one command is allowed.

PostCommandLine=

The following option determines the Inbox wrap column number when they are
loaded into the Message Viewer. This option also is used as the default wrap column
for all Outbox message editors, viewers and the Edit File Window.

WrapCol=76

The following option determines if the OzControl window defaults to the Shrunk
state. If set to YES only the Header, Menu Items and the Tool bar are displayed. If set
to NO then all of the OzControl main window is displayed. This is the same affect as
selecting the Shrink toolbit on the OzControl Tool bar.

OZControlSmall=NO

The following option is to set the OzWinFontName, which is defined by Windows,
and can be found in Windows manuals.

OzWinFontName=BorlandTE

The following option is to set the OzWinFontSize, which is defined by Windows, and
can be found in Windows manuals.

OzWinFontSize=9

The following option is to set up for a network. If set to YES OzWin allows the
sharing of files between different workstations. If set to NO then OzWin responds as a
single user system and create an error if operated under a network environment.
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MultiInstanceAware=NO

The following option determines of the Stock Quotes data that has been retrieved
from CompuServe gets saved to a Quicken Format file.

SaveQuotesData=NO

The following option maintains the path and filename for the Stock Quotes data to get
saved off to. The SaveQuotesData option above must be set to YES for this option to
benefit you. The data is copied into the file under a Quicken format.

QuotesDataFile=

[Messages] :

This section of options have control within the Forum and CIS Mail messages.

The following option controls the default sorting method for Forum messages. This is
only a default. You can re-sort by your preference setting in the Preference Dialog or
select the Manage|Sort Messages menu item in the Message Viewer. The sort options
available are as follows

1. NONE No sorting is performed.
2. THREADS The messages are sorted into thread tree order (the same order

CIS uses when displaying messages when using the READ
THREAD command).

3. NUMBER The messages are sorted into CIS msg number order, ignoring
subject.

4. ADDRESSEE The messages are be sorted into "TO" field order.
5. SENDER The messages are be sorted into "FROM" field order.

SortBy=None

The following option places all unseen messages to the end of the list. All other
options for sorting effect the seen and unseen messages as two different lists.

NewToEnd=YES

The following option determines how the Forum messages get sorted. If set to YES
the messages are sorted by Root message number then the Section Number. If set to
NO then the messages are sorted by the Root message number only.

SortToSecs=YES
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The following option maintains the Forum Session Header entries. Set the option to
NO to set the Kill flag for all Forum Session Headers. Set this option to YES to set the
Purge and Hidden flags.

PurgeGroupMarkers=NO

The following option controls which window pops up when calling Read InBox
Messages and while Viewing Outbox Messages. If set to YES the Message Browser
pops up first. If set to NO the Message Viewer pops up first.

BrowseFirst=NO

The following option controls if a Local Index is displayed in the Message Viewer.
Set the option to YES to display a Local Index.

ShowIndex=YES

The following option maintains the automatic setting of the Seen flag for messages
when moving from thread to thread in the Message Viewer. If this option is set YES,
using the Next|Thread, Prev|Thread menu items or correlating toolbits, marks all
messages in the skipped thread as Seen. If set to NO the flags are not changed.

MarkSkippedSeen=YES

The following options control the Index layouts for Mail Inbox messages. Any order
and/or combination of fields is acceptable. Repeats are allowed.

D Message Date
F Flags
S Subject
T Addressee
R Sender

MailLayout controls the index format for Mail Messages. Here is an example to
display in the following order :

Date  Flags  Subject  Sende r

MailLayout=DFSR

The following options control the Index layouts for Forum Inbox messages. Any order
and/or combination of fields is acceptable. Repeats are allowed.

D Message Date
N Message Number
F Flags
S Subject
T Addressee
R Sender
C Section
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ForumLayout controls the index format for Forum Messages. Here is an example to
display in the following order :

Date  Number  Flags  Subject  Sende r   To  Se c tion

ForumLayout=DNFSRTC

The following options control the Index layouts for Mail Outbox messages. Any order
and/or combination of fields is acceptable. Repeats are allowed.

D Distribution Count
F Flags
S Subject
T Addressee
N Attached File

MailOutLayout controls the index format for Mail Outbox Messages. Here is an
example to display in the following order :

Flags  Subject  AddresseeDate  Attached File

MailOutLayout=FSTDN

The following options control the Index layouts for Forum Outbox messages. Any
order and/or combination of fields is acceptable. Repeats are allowed.

P Parent CIS Number
F Flags
S Subject
T Addressee
C Section

ForumOutLayout controls the index format for Forum Outbox Messages. Here is an
example to display in the following order :

Sende r   Flags  Subject  ToSec tion

ForumOutLayout=RFSTC

The following option controls how many of the Local Index's rows are visible in the
Message Viewer (excluding any Header line).

IndexNumRows=5

The following option controls whether the Message Viewers Local Index box has a
header line in addition to the number of visible rows it has. If set to YES the Header
line defining the columns is displayed.

IndexHasHeader=YES
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The following option determines the character that divides the Message Viewers
columns. If left blank, nothing splits the columns. Refer to the ASCII chart for other
possibilities.

IndexSepChar=124

The following option sets the maximum number of characters in a Forum's message.
This should not be changed from 10000, due to the Forums software limitations.

MaxCompSize=10000

This option controls which if any messages are hidden during viewing. This is only a
start-up condition. Any and all masks may be set from the Menu Items. The default is
P for Purged messages. (i.e. Purged messages do NOT appear in the Message Viewer
Index or while flipping through the messages during READ in the Message Browser.
{ NOTE: Setting Seen AND New is NOT Allowed. } A list of the Flag choices ar as
follows :

H = Hold
K = Killed
P = Purged
V = Saved
R = Replied To
! = Tagged
D = Delete On-line
G = Group Headers (not a normal flag)

Hidden=P

This option controls the filename extension OzWin uses for file of purged messages
in Forums and Mail. The default is PRG for compatibility with versions of OzCIS.
However, external message and/or thread managers may expect a different extension
(i.e. RECON uses the extension .OLD) so this option is provided for compatibility
with those other programs.

PurgeExt=PRG

The following option provides a way to screen your messages. It is called a squelch
list or a twit filter. It is a list of UID's that you do not wish to receive any message
from. The UID must appear in the Header portion of the message or this can not
function properly. If you receive a message from someone on the list, their message is
automatically deleted from the message file (and *not* copied to the saved-purge
file), when the file is updated at the end of the viewing session. You must use this
capability with extreme care. The format of this option: all UIDs must be on the one
line, separated by semicolons (;) and with no extra space, and the line cannot exceed
127 chars in total length. For example:

Squelch=77777,1212;70000,101
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Also, this option applies to Forum messages, not just Mail messages, and affects all
Forums equally. Leave it blank to not squelch any UIDs.

[Active Session] :

This sets up the default active session.

Active=TMI-DRF19200NoMail

[DRF19200NoMail] :

This section defines the individual sessions.

The first option determine if the current session is Attended or not. This information
is passed on to the Online Module allowing it to properly perform events.

Attend=YES

The following option determines for this particular session if OzWin processes Mail
while it is online.

ProcessMail=NO

[CIS Mail] :

These options settings control the CIS Mail.

The first option sets the path for the files that pertain to CIS Mail. Be sure to use the
full path name as in the example.

FilesPath=C:\OZWIN\FILES

The following option maintains the filename to save CIS Mail OutBox messages to
when they are saved. If left blank OzWin will create a filename.

SaveOutboxFile=

The following option determines if Outbox messages automatically get saved when
they are successfully posted.
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SaveOutbox= YES

The following option determines if a confirmation record is stored in the accounting
log each time a CIS Mail message is successfully posted.

LogMailConfirmation=YES

The following option determines how to handle messages with postage due, while
online reading messages. This option has three settings, they are Read, Scan and
Delete. Read retrieves all messages with postage due. Scan retrieves headers for all
messages with postage due. The headers are returned into CIS Quick Scans. Delete
assigns an event to delete all messages online with postage due.

PostageDueHandling=Read

The following option maintains your postal mailing address.

ReturnAddress=

The following option sets the default flags for the CIS Mail. This field is under
program control, do not change the setting.

Flags=$0000

The following option sets the maximum number of CIS Mail Inbox messages OzWin
can handle.

InboxLimit=1500

The following option maintains the maximum number of days to save Threads before
purging them. All messages in the Thread must be older than the ThreadPurgeAge
before they are deleted.

ThreadPurgeAge=0

The following option maintains the maximum number of days to save messages
before purging them.

MsgPurgeAge=0

[Groups] :
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Define the default names and descriptions of the Groups of Forums. The left side of
equal sign is for the name of the Group. The right side of equal sign is for the
description of the Group.

General=General

TempGroup=TempGroup

[Active Group] :

Define the Group that is to be active.

Active=General

[Forums (General)] :

Define all the Forum names and descriptions for the current Group. Note that the
Group name is in parenthesis, each Group must be defined separately. The Forum
name and description can be the same or different. The name goes on the left of the
equal sign, and the description goes on the right as shown below.

OzWin Support=OzWin Support

[Active Forum (General)] :

Define which Forum within the Group you want to be Active. The Group name goes
inside the parenthesis.

Active=OzWIN Support

[Forum (OzWIN Support)] :

Define the individual Forum options. The Forum name goes between the parenthesis.
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The following option maintains the current Forums GOword.

GOword=CIS:OZCIS

The following option maintains the active subdirectory for the current Forum.

FilesPath=C:\OZWIN\FILES

The following option sets the Forum to active and display the Activity Indicator below
the Forum name in the OzControl Main Window.

Active=YES

The following option maintains the sub directory for all files downloaded for the
current Forum.

DownLoadsPath=

The following option is under program control, do not change this option.

Flags=$0000

The following option determines if a new Section and Libraries list is retrieved from
CompuServe, for the current Forum.

UpdNames=NO

The following option determines if the Outbox messages get saved after they are
successfully posted.

SaveOutBox=YES

The following option maintains the filename to store all Outbox messages to when
they are successfully posted. This option is only active if the SaveOutbox option, for
this Forum is True.

SaveOutBoxFile=

The following option determines if waiting mail gets read during a first pass session.

ReadWaiting1st=YES
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The following option determines if waiting mail gets read during a second pass
session.

ReadWaiting2nd=YES

The following option maintains the section(s) to read new messages from. Separate
multiple sections with commas.

ReadNew=All

The following option maintains the section(s) to perform QuickScans in. Separate
multiple sections with commas.

QuickScan=

The following option determines if the message file is loaded into memory when the
QuickScan list is loaded.

QSLoadIndex=YES

The following option determines if new Quick Scan headers automatically have the
Read flag set.

QSMarkAsRead=YES

The following option maintains the number of History changes before deleting a
header from the QuickScan list. A History Change occurs each session that a Quick
Scan list is downloaded but no new messages were in the subject. The smaller the
History Count the sooner the header is deleted and the smaller the Quick Scan file
remains. A zero entry does not delete the Headers at all.

QSHistoryCount=0

The following option determines if a Master Catalog scan event is pending for the
current Forum. There are three settings for this option. If set to YES a new Master
Catalog event is pending. If set to NO, there are no pending Master Catalog events. If
set to UPD an update Master Catalog is pending.

CatScan=NO

The following option maintains the libraries to retrieve the Master Catalog from.
Separate multiple libraries with commas.

CatSecs=
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The following option maintains the date of the last Master Catalog retrieval. This
option is reset regardless of the scan type received.

CatDate=

The following option maintains the number of days since the last Master Catalog
scan, until OzWin automatically retrieves an update.

CatAuto=

The following option determines if a Master Listing scan event is pending for the
current Forum. There are three settings for this option. If set to YES a new Master
Listing event is pending. If set to NO, there are no pending Master Listing events. If
set to UPD an update Master Listing is pending.

LstScan=NO

The following option maintains the libraries to retrieve the Master Listing from.
Separate multiple libraries with commas.

LstSecs=

The following option maintains the date of the last Master Listing retrieval. This
option is reset regardless of the scan type received.

LstDate=

The following option maintains the number of days since the last Master Listing scan,
until OzWin automatically retrieves an update.

LstAuto=

The following option maintains the scanning order for the catalog and listing scans. If
this option is set to YES, the scan result is in Section then alphabetic order. If this
option is set to No the scan result is in date order.

CatsByLib=No

The following option maintains the user name for the current
Forum.

UserName=TechMate, Inc.
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The following option maintains the true Forum Name. This is not displayed in the
defined Forums area.

RealName=

The following option is under program control, do not change this option.

AlertFlags=$0000

The following option is under program control, do not change this option.

RestrictionFlags=$0020

The following option maintains the lowest message number CompuServe has for the
current Forum.

MsgBase=107709

The following option maintains the highest message number read for the current
Forum.

MsgHigh=110788

The following option maintains a High messages number to send to CompuServe so
they can reset their High Message Number setting for you in the current Forum.

ResetHigh=

The following option resets OzWin's High Message Number to the last message in the
current Forum.

HMNToLast=NO

The following option is under program control, do not change this option.

AvailMsgSecs=0,1,2,3,4,5,6,7,8,9,10,11,13,14,15,16

The following option is under program control, do not change this option.

AvailLibSecs=0,1,2,3,4,5,6,7,8,9,10,11,13,14,15,16



page 92 OzWin Copyright(c)1994 Alchemy International, Ltd. All rights reserved

The following option maintains the maximum number of messages the current Forum
message file will maintain before OzWin will automatically start deleting some of the
messages. Enter a 0 into this option disables the feature.

InboxLimit=500

The following option maintains the maximum number of days to save Threads before
purging them. All messages in the Thread must be older than the ThreadPurgeAge
before they are deleted. Entering a 0 into this option disables the feature.

ThreadPurgeAge=0

The following option maintains the maximum number of days to save messages
before purging them. Entering a 0 into this option disables the feature.

MsgPurgeAge=0

The following option determines if Subject Watches are automatically retrieved. If the
option is set to YES, any matched messages are retrieved. If the option is set to NO
only headers are retrieved and placed in the QuickScans.

AutoDLWatchMatch=NO

The following option determines if the First Pass performs the features of the Second
Pass. If the option is set to YES both First and Second Passes are performed during a
First Pass.

SinglePassStyle=NO

The following option is under program control, do not change this option.

JobCard=$0000

The following option maintains the current Forums Signature. this is Signature.

Signature=UserName. %t^H^H^M^J

The following option maintains the full path and file name of the Entry Script.

EntryScript=

[Preference (UserName)] :
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This set of options is over-riding some of the defaults in the other sections in the INI.
These are one person's own way of displaying and operating OzWin. If you have a
network set up this comes in very handy, each person can have OzWin the way they
like it without affecting anyone else. If you are a single User this section is not
necessary, you can simply set the defaults the way you prefer them. You may also
notice that some of the options have a Forum name in () after the description and
before the equal sign. These settings are specific to that Forum.

NOTE : not all options can be put in the preference.

The following option is the same as the [Active Session] definition.

DefSession=TMI-DRF19200wMail

The following option maintains the default group name.

DefGroup=General

The following option is the same as the OZControlSmall option in the General section
of the INI.

OZControlSmall=YES

The following option is the same as the OzWinFontName option in the General
section of the INI.

OzWinFontName=

The following option is the same as the OzWinFontSize option in the General section
of the INI.

OzWinFontSize=7

The following option is the same as the SortBy option in the Messages section.

SortBy=NONE

The following option is the same as the MailLayout option in the Messages Section of
the INI.

MailLayout=DFSR

The following option is the same as the Forum Layout option in the Messages Section
of the INI.
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ForumLayout=DNFSRTC

The following option is the same as the MailOutLayout option in the Messages
Section of the INI.

MailOutLayout=FSTND

The following option is the same as the Forum Layout option in the Messages Section
of the INI.

ForumOutLayout=PFSTC

The following option is the same as the BrowserFirst option in the Messages section
of the INI.

BrowseFirst=Yes

The following option is the same as the ShowIndex option in the messages section of
the INI.

ShowIndex=

The following option is the same as the IndexNumRows option in the messages
section of the INI.

IndexNumRows=5

The following option is the same as the IndexHasHeader option in the messages
section of the INI.

IndexHasHeader=FALSE

The following option is the same as the Hidden option in the messages section of the
INI.

Hidden=P

The following option is the same as the Signature option in the General section of the
INI.

Signature=UserName. %t^H^H^M^J
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The following option is a Preference feature only. This option saves a file to use as
the default for the Select File dialog. the Select File Dialog pops up when the Save
menu item or toolbit is selected, within the specified Forum. The Forum name is in
parenthesis just before the equals sign.

DefSaveMsgFile (OZCIS)=I:\OZWIN\OZCIS\OZCIS.MSG

The following option maintains the filename of the default address book.

DefAddrBook=I:\OZWIN\ADDRBOOK.AB

The following option is the same as the SingleViewerMode in the General Section.

SingleViewerMode=NO

The following option is the same as the PreCommandLine option in the General
section of the INI.

PreCommandLine=

The following option is the same as the PostCommandLine option in the General
section of the INI.

PostCommandLine=

The following option determines if the Spell Checker is activated in the Message
Editors during the posting procedure.

AutoSpellCheck=

The following option is the same as the SortToSecs option in the Messages section.

SortToSecs=YES

The following option is the same as the NewToEnd option in the messages section.

NewToEnd=YES

The following option is the same as the MarkSkippedasSeen option in the Messages
section.

MarkSkippedAsSeen=YES
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The following option maintains the filename to save Forum Outbox messages.

SaveOutBoxFile (Forum Name)=

The following option maintains the user name for the current Forum.

UserName=

The following option is the same as the Signature option in the General section of the
INI.

Signature=UserName. %t^H^H^M^J

The following option is the same as the SaveOutBox option in the Messages section.

SaveOutBox=YES

CIS.INI
Do not let anyone have your CIS.INI! This contains your password and your user id.
With your CIS.INI anyone with OzWin will be able to use your account - and
CompuServe will BILL YOU!.

The format of the CIS.INI file is proprietary to CompuServe, and formal
documentation on it is unavailable. You should never edit the CIS.INI file directly.



Copyright(c)1994 Alchemy International, Ltd. All rights reserved OzWin page 97

For Users of OzCIS/DOS
We have taken pains to make OzWin as compatible as possible with OzCIS/DOS and
other 3rd-party tools for message-file and catalog-file manipulation. However, there
are some differences you should be aware of, especially regarding CISMail, and
multi-user situations. Some of these are necessitated by the differences in how
Windows works, some by how the HMI protocol differs from the traditional ASCII
interface used by OzCIS/DOS, and others by how OzWin itself works. Note that
references in this section to OzCIS/DOS refer specifically to the 2.x versions of that
program; we will make Version 3 of OzCIS aware of and compatible with most of
these issues.

1. OzCIS/DOS forums data (FORUMS.DB) and hosts data (HOSTS.DB) files are
not compatible with OzWin. Use the included conversion tools to convert
OzCIS/DOS files to OzWin. IMPORTANT NOTE: OzCIS/DOS allows forum and
host "titles" to be up to 40 characters long. Due to limitations in the HMI system,
OzWin must limit these titles to 20 characters or less. BEFORE converting
OzCIS/DOS hosts or forums to OzWin, it is VERY IMPORTANT that you edit
the forums and/or hosts definitions so that each one's title is less that 20 characters
in length, and that each name is unique! IF YOU DO NOT DO THIS, THE
CONVERSION PROCESS MAY NOT CONVERT THE ENTRIES PROPERLY!

2. The format of OzWin outbox files .OUT is drastically different from that used by
OzCIS/DOS. OzCIS/DOS does not understand OzWin outbox files, although
OzWin does understand OzCIS/DOS outbox files. You can use OzWin to post
outbox messages composed in OzCIS/DOS, but not vice versa.

3. We do not recommend that you try to share CISMail message files between
OzWin and OzCIS/DOS or any other 3rd-party message tools. In order for OzWin
to support multi-user environments and provide inbox security (i.e. where each
user on the network can only see and reply to messages addressed to him) it must
track extra information about each message. To do so it must add this data to the
message's header, and that extra information will confuse most other 3rd-party
tools as well as OzCIS/DOS. Specifically, OzCIS/DOS 2.x will *not* read OzWin-
captured CISMail messages correctly. OzWin can read OzCIS/DOS CISMail
inbox files, but will not provide inbox security on those files.

4. OzWin Forum Message .MSG files are compatible with OzCIS/DOS, with the
following cavat: HMI sends message text differently than does ASCII, and
Windows text display tools provide automatic re- wrapping of text that
OzCIS/DOS does not. For these reasons, the default method of storing Forum
message text in OzWin files is to not wordwrap the incomming data; if files
written by OzWin in this mode are viewed in OzCIS/DOS, the lines of text in the
message will run off the right side of the screen. To prevent this from happening,
you can manually edit a setting in the OZWIN.INI file: in the [General] section,
change the InboxWrapWidth=0 setting to InboxWrapWidth=79.Doing this will
force OzWin to wordwrap incoming messages to a right margin of 79. Note
however that messages wrapped by this setting may display oddly in OzWin.

5. OzWin Forum Library listing and catalog (.CAT and .LST) files are compatible
with OzCIS/DOS.

6. Generally, OzCIS/DOS and OzWin scripts (other than CCS connection scripts) are
compatible. There are a couple of minor exceptions; see the OzWin script
language documentation files for details.
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7. OzCIS/DOS QuickScan information .QSN files are NOT compatible with OzWin
or vice versa, nor are OzCIS/DOS QS History .QMR files.

8. OzCIS/DOS Macros files cannot used by OzWin, nor can they be used by the
Windows RECORDER applet.
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Modems, CompuServe and OzWin
In general, modems and OzWin are not much of an issue: when you set up a
connection definition, you specify the modem settings based on your particular make
and model of modem, and that's it. The modems database included with OzWin
contains almost 300 different modem makes/models, so the chances are good that
your modem will be listed. However, some people will find that their modem is not
included, or the default command strings don't work well for their particular
configuration. In this section we provide some guidelines for optimizing your modem
configuration and some common mistakes to avoid.

Users of OzCIS, NOTE: Modem strings are handled in a totally different manner in
OzWin than they are in OzCIS, to conform to the CIS.INI conventions used by the
HMI library. If you are familiar with WinCIM, you are already familiar with these
strings; if not, consult the setup section of this documentation, or the online help.

As always, if you are unsure about a modem configuration issue, please post a
message to our modem experts in the Win Modems/Connect section of the OZCIS
Forum.

Incorrect strings
The most common error is typographical errors in commands, such as using an O
(upper-case letter "O") where a 0 (zero) is required, or vice versa. While we are not
aware of typos in the existing database, we don't have all the modems either, so such
typos are possible. Likewise, such typos are possible in strings you input, so type
carefully, and double-check your strings.

Errors in data compression
CompuServe's modems generally support error correction, but do not support data
compression. If your modem strings turn on data compression, edit them to turn it
back off. Consult your modem manual for the specific commands required.

Errors in flow control
The HMI protocol generally wants to see software flow control (XON/XOFF) used.
This is unfortunate, because most modems default to using the more common
hardware flow control (CTS/RTS). The default strings in the modems database
generally set this up correctly, but if you experience dropped characters or lots of
protocol errors you may want to double-check your modem strings to see if flow
control is improperly set.

Com Port Configurations
A serial port in the PC has an address in the system that allows the processor to find
it. This address (called the base address) varies, but is usually consistent depending on
with com port it is (i.e. COM1 is usually at base address 3F8 hex.) Serial ports also
have a second addressing value, called the IRQ (interrupt request line, the signal line
in the PC's buss that the com port uses to signal the processor when it needs
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attention.) The PC/XT has 8 IRQ lines while 286 and better systems have 16. Many
of these IRQ lines are used by other devices such as printer ports, so the number of
available lines is fairly limited. The standard base addresses and IRQs for the four
com ports:

PC/AT/386/486IBM PS/2
Port Addr IRQ Addr IRQ
COM1 3F8h 4 (same)
COM2 2F8h 3 (same)
COM3 3E8h 4 3220h 3
COM4 2E8h 3 3228h 3

Note that the same IRQ is shared by both COM1 and COM3, and by COM2 and
COM4. Due to the design of the PC, you cannot reliably share an IRQ line between
two active comm devices (for example, a serial mouse on COM1 and a modem on
COM3.) PS/2 machines do not have this limitation, but many comm programs do not
recognize this difference between PS/2s and PCs.

Many serial ports and internal modems allow the base address and/or IRQ to be
configured via jumpers or switches. It is not uncommon for a manufacturer or system
vendor to configure an internal modem as being at the COM3 base address but use a
different IRQ (such as IRQ 5) so the modem won't conflict with the COM1 and
COM2 ports. Where a modem or port has been configured for one of these non-
standard IRQs and/or base addresses, you will need to tell Windows the actual base
address and/or IRQ in use.

NOTE: Comm port/Modem base address and IRQ settings are configured via the
Ports applet in the Windows Control Panel, and are not set within OzWin or any other
Windows comm program. Once you change the setting for base address and/or IRQ
for a port in that applet, you must terminate Windows itself and restart it for the
change to take affect.
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Getting the Most From Your CompuServe Dollar

The Reality: You May Not Save Any!
That's right, you may not save a penny. A navigator program can significantly reduce
the time you actually spend connected to CIS and therefore on the clock... but
historically, users of navigators tend to take advantage of the much greater efficiency
and call CIS more often. The bottom line is this: if you stick to performing the same
online chores with a navigator as you did without, you will save money - often a
substantial amount. If, on the other hand, you expand the number of forums you
regularly visit, and/or visit your usual forums more often, and/or start using CIS Mail
as a common means of communicating with others, your CIS bill is likely to stay
pretty much the same or even increase. It's your choice: you can save money, or you
can expand your horizons (and increase the efficiency and effectiveness of your
online time.)

Many people have asked me: "Why does CIS allow programs like OzWin to even
exist? If a navigator saves me money, it's cutting down on CIS' income; they can't like
that!" On the contrary, CIS is quite happy to have the navigator programs around.
Why? Time has shown that all too often a person will sign up for CIS, and find that
it's just too expensive for them, or find that keeping track of all the information
available is too involved, and quit. The navigator programs eliminate much of the
headaches of keeping track of volumes of information, and give the member more of a
sense of getting his money's worth from his access - he's much more likely to stay a
member and use the Service.

Still, we all want to save money - chances are, that's what led you to OzWin in the
first place. So here are some tips and hints on doing just that:

How to Conserve

Know Thy Enemy
"Enemy" really isn't a good choice of words in this case. Nevertheless the phrase
applies, because an informed consumer is a smart consumer. Make sure you have
reviewed your Membership Agreement and the Service Terms and Conditions, so you
understand what your rights and responsibilities are in relation to CIS. Also, make
sure you thoroughly understand your Billing Option, how it works, how charges are
calculated and what your responsibilities are relative to billing and payment. A solid
understanding of how your bill is calculated can resolve a lot of billing issues before
they start.

If you have questions, you can post a message to CIS Feedback.
Also, you can do a GO MEMBER while in Manual Terminal, and be taken to a menu
of information and online services related to membership and billing.

Pick Your Spots and Times
Multiuser systems such as CIS are affected by the number of users online at the same
time - the more people online at the same time, the slower the system will respond to
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any one user. It therefore makes sense to try to restrict your times of access to those
times when the Service is not heavily loaded with users. There are no hard and fast
rules for this, but the general rules of thumb are: 1) avoid Monday evenings, which
historically is the highest usage time; 2) avoid early evening hours generally. Late
evenings and early mornings are usually the best times, followed by weekend
evenings.

In the same vein, the CIS node you call can affect performance. For example, I live in
Colorado Springs, which does not have a 9600bps node; I have to call Denver to get
9600bps access. The Denver node is a long way from Columbus, and the node is often
"loaded" (has a high number of other callers connecting thru the same node.) Add to
this the fact that a connection from Denver to Columbus may require several links
(connection points in the phone system), which can hurt performance. By calling the
Columbus node (a local node for the CIS computers) I can improve thruput. Since
both calls are long distance and end up costing about the same in that respect, the
improved thruput of the Columbus node makes it worthwhile for me to call there.
However, if the Columbus node is very busy (and it often is), it will be slower than the
Denver node.

Bottom line: careful selection of when and where you call can have a noticeable affect
on your total bill.

Safety in the (Online) Workplace
Ever left the phone off-hook accidentally? Most of us have, without too dire a
consequence (unless the previous call was long distance...) Leaving the modem
offhook on a call to CIS, on the other hand, can be costly. While OzWin works hard to
protect you from such occurrences, there are so many possible glitches between the
various parts of the connection that it's impossible to prevent every possible one. So,
while it's nice to be able tell OzWin to perform its online duties and go watch a movie,
it's not a good idea to just forget it completely - you should check in on it every few
minutes, so you can break the connection if things go awry.

A user of OzWin 1.0 once told me that he set off a long download process and went to
bed, only to wake up several hours later and find that CIS had gotten into a loop and
had been doing noting since very early in the download process. What made this
really bad was that the user was calling long distance - from Hawaii! (CompuServe
was understanding, and credited the user's access time; the phone company was not so
understanding...) The moral of the story: never leave the system totally unattended
while performing online processing.

Ordering Your Access
Many users access multiple Services under the CIS umbrella. They may access some
forums in ZiffNet, some in CIS, and some in other Service Provider areas, during the
same online session. If this is the case for you, it is a good idea to order the access
areas in your forums list so that all areas under one Service Provider are accessed
together, followed by the areas under the next Provider, etc. This cuts down on the
time spent "jumping through the gateway" between Service Provider systems.

Use High-Speed Modems Wisely
That fancy new V.32bis faxmodem is just the thing to save you big bucks on CIS,
right? Maybe not!
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The time you spend online breaks down to two specific types: the time you are
actually receiving data, and the time you spend waiting for CIS to respond. While the
time it takes to receive data relates more or less directly to the connect speed, the time
it takes CIS to respond to commands remains fairly constant irrespective of connect
speed (it's much more dependent on things like system user load, network delays, and
what it is you're asking CIS to do.) What this means is that the time spent waiting on
CIS becomes a bigger percentage of the total connect-time picture as connect speed
increases.

Efficiency of the connection is measured from the characters- per-second (cps)
transferred. The connect speed determines the maximum possible efficiency; for a
2400bps connection this is 240cps, and a 9600bps connection can theoretically
achieve 960cps. The percentage of the actual cps to the maximum possible cps is the
efficiency ratio, and will almost always be considerably less than 100%. From this
efficiency ratio we can calculate the "cost-per-byte- transferred" from the current CIS
charges for the given connect speed, and determine if high speed access is cost
effective.

At the time of this writing, 2400bps access cost $8.00/hour, while 9600bps access
cost $16.00/hour (on the Standard Plan.) At those prices, 9600bps access would need
to achieve at least 480cps to equal the cost-per-byte of 2400cps access. In practice,
you will find that such efficiencies are often difficult to achieve unless you are
downloading files or capturing large amounts of streaming data such as a library
catalog.

So, it's often a good idea to reserve your 9600 access for those times when you will be
downloading larger files or capturing large amounts of data (for example, performing
a scan of a complete library.) The accounting logs generated by OzWin can help you
determine which access is the most cost effective under what conditions.

Also remember that if you must call long-distance or pay network access or
surcharges, the above calculation becomes meaningless - in most cases, surcharges
(and especially long distance charges) throw the whole equation off. Where long
distance charges or network surcharges make a significant portion of the overall cost
to connect, most users find it more efficient to connect at the highest possible speed.

Standard Pricing vs. Pay-As-You-Go
When I wrote this section for the OzCIS version 1.0 docs, CompuServe's pricing
structure was such that choosing one pay plan over the other was a difficult decision.
That's no longer the case. At this writing, CIS has announced a new "Standard
Pricing" plan that makes the old pay-as- you-go plan a very poor choice for the vast
majority of CIS members. If you are not already on the Standard Pricing plan, I
recommend switching to it. You will save money.

Real-Time Conferencing
Conferencing can be the most expensive time you spend on-line. I'm not discouraging
conferencing; it can be a wonderful way to meet people, learn new things, familiarize
yourself with a forum's membership and "spirit," or just spend some time chatting
with friends. But in terms of raw data throughput, no use of CIS will give you less
per-minute return on your dollar. If your bill is important to you, make sure you limit
your conferencing to those areas and things that will give you a return on your
investment.
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Tip: ALWAYS conference at 300 BAUD. Real-time conferences run at typing speeds;
few people can type 30 characters per second, so conferencing at 300 BAUD gives
you the cheapest connect rate while still being plenty fast enough to keep up.

Using CIM
The CompuServe Information Manager (CIM), for simplifying access to the Service,
is a program written and sold by CIS itself. While it is quite limited in its automation
capabilities compared to OzWin and the other navigator programs, it excels in
interactive on-line operation, especially in certain areas like the Executive News
Service and the Airlines areas, and in conferencing. Its user interface is quite similar
to that of OzWin in several ways, although the two cannot share files such as
messages or forums lists.

I recommend WinCIM for conferencing and many other manual chores. It is an
excellent vehicle for "getting your feet wet" with CompuServe, and for accessing the
areas OzWin does not automate it is difficult to beat. Like anything else, there is a
correct tool for the job at hand; WinCIM is a good tool for accessing certain parts of
CIS. I recommend you have a copy and become familiar with it.

WinCIM can be ordered on-line (manual, GO ORDER). The cost is $25, but an
included $20 usage credit means the net cost is $5 and is well worth it.

The PRACTICE Forum
Becoming familiar with CIS, even when using an automated program, can be an
expensive process. CIS provides a free forum called PRACTICE, where connect time
charges are waived (but network surcharges still apply!) and in which you can "play."
The sysops are friendly, knowledgeable people, ready to answer any question and
understanding of people who don't know the ropes and get confused over the
multitude of commands, etc. If you're unsure about doing something on the Service,
stop by the PRACTICE forum and try it out on CompuServe's nickel - instead of your
own.

Saving Money with OzWin
As mentioned throughout the preceding section, YOU are the primary determining
factor in how your CIS bill looks at the end of the month. However, OzWin provides
several things that can be used to your advantage.

1. As mentioned in the discussion of 9600bps access, using the access log files
generated by OzWin to keep track of the on-line time you spend and where you
spend it can be very helpful in determining ways to save money. The Accounting
Logs facility included in the program can help you quickly make sense of the logs.

2. Keep your access limited to later evening and weekend hours as much as possible,
especially when doing file transfers or library scans; you'll get higher efficiency.
Avoid Tuesday early evenings if possible; this is traditionally the highest-access
time for the Service, followed by Monday evenings. By the same token, don't start
long scans or downloads in the wee hours of the morning unless you are familiar
with the down-for-maint. schedule for that forum. All forums are taken down for a
short time every day, to do a complete backup and freshen programs as needed;
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usually this is done between 3AM and 5AM EST, but some forums come a bit
earlier or later.

3. Short-format scans of forum libraries take MUCH less time to retrieve than do
long-format scans. If you are investigating a new forum's libraries, do a short-
format scan first. If you need more information about particular files, use the
Library Search tools to get the abstracts of just those files.

4. By the same token, never re-scan a complete long catalog unless you have to; use
the Update option to retrieve only new files. Or use the Library Search facility to
reduce the scan list even further.

5. Looking for a file, but aren't sure what forum it's in? Never just start hopping from
forum to forum browsing the libraries - use the FileFinders instead! The
FileFinders can zero in on the file you're looking for rapidly.

6. If you access a non-forum area regularly, look into writing or acquiring a script to
automate it as far as possible rather than always doing it manually.

7. Never send a mail message "Receipt requested" unless it's REALLY nessessary.
Those 25-cents-per-receipt charges can add up quickly when you RR most or all
of your mail messages.

8. Ditto for CC'ed messages.

9. When setting up or sorting your forums, if you have one or more forums in a
different "gateway" (such as ZiffNet), group those forums together and put them
at the end of your forums list. Doing so reduces the "dead" time CIS spends
switching thru the gateway.

10. Never start a file transfer and walk away, especially if you don't use an error-
corrected modem and the line has been showing symptoms of being noisy or
problematic. If a download is visibly slow due to high network loading, or is
getting a number of errors, abort the transfer and try again later (taking advantage
of the B+ protocol's "resume" feature.)

11. Unless it's your primary reason for using CIS, never set up areas such as Weather
or ENS to be processed each and every time you log on. These areas generally are
slower processing than the forums and CISMail, and can sometimes result in a
large amount of data being re-captured.

12. Save processing of Weather Maps until mid- to late-afternoon if possible. Some of
the maps do not become available until the afternoon, so requesting one of these
maps before they are available means a deadhead pass thru the AWM area.

Activity Logs
OzWin generates and maintains an activity log of all on-line sessions. This log
contains both timing information for accounting purposes, and reports of file transfer
success or failure. Activity log files are named OZWAyymm.LOG, where "yy" is the
last two digits of the current year and "mm" is the number of the current month. A
new log file is created when you log on (or after) the first of each month and is stored
in the directory where OzWin itself is stored. These log files can grow quite large,
depending on the frequency with which you log onto CIS, how many forums you visit,
how often you run scripts, and how often you operate in manual terminal mode. Once
you are finished with activity log files that are no longer current, I recommend you
archive them off to floppy disk or otherwise store them away.
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OzCIS activity logs attempt to track costs. However, as CIS has expanded its support
internationally, trying to keep track of all the possible combinations of connection
charges, network surcharges and prime- vs. non-prime-time premiums, varying phone
rates, etc., has made any kind of accurate tracking impossible - as a result, the OzCIS
logs are rarely very accurate, and have proven to be a major point of confusion for
many users. Therefore, OzWin does not attempt to track costs on a per-con- nection
basis. It simply tracks connections, time spent in given areas, and any specific mail
surcharges you may accrue. The Accounting Report Generator utility program
included in the OzWin package can be used to generate several different reports,
which can then be used to crosscheck your actual CIS billing report.
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General Forums Use, Online Courtesy and Behavior

CompuServe is, among other things, a social event. This is especially true in the
Forums, where public user interaction is frequent and, occasionally, heated.

One of my favorite quotes: "Moving parts in contact will burn up unless lubrication is
applied. Good manners are the lubrication for human contact." (Robert Heinlein, The
Notebooks of Lazarus Long). Nowhere is this more true than online. Some basic
ground rules, along with common courtesy, will go a long way towards making your
use of CIS more enjoyable, and more enjoyable for other users as well.

The following information was written by Nancy Jacobsen of the Microsoft FOX
forums - it is the best discussion of this topic I have ever seen, and much, much better
than I could have written. I reprint it here with her permission. Note that there are
several references to the Microsoft Forums; the rules and principles discussed herein
apply to all forums on CIS, not just the MS forums.

Hard and Fast Rules
Most forums request that you use your full name in your CompuServe (CIS)
identification. If you have omitted your first name or last name, please change it.

If you normally use a company CompuServe account with the company name but plan
to be a regular participant, please change the identification (at least locally in the
specific Forum) to your name and enclose the company name (or abbreviation) in
brackets after your name if you wish. If several people will be using the *same*
account, each individual should include his or her complete name in the body of the
message.

Please refrain from using profanity, being abusive, advocating illegal actions, or
performing any act that may injure another. Microsoft reserves the right to deny
access to the forum to anyone posting offensive messages.

This isn't a "hard and fast rule" but it's close - please do not type your messages all in
upper case (use mixed case as you would in a letter). Upper case is hard to read and is
considered "SHOUTING" on CompuServe.

There are no other "rules" but there are some conventions of behavior that will ease
your life in the forum. Please see the "Manners and Ambience" section.

Manners and Ambience
This is the Fox Forum, so naturally what brings people together is an interest in
Microsoft Fox products - most of the people here are working with FoxPro,
FoxBASE+, or FoxBASE+ for Macintosh. These include developers, people using the
products to manage their own data, and hobbyists. The range of skill and expertise is
very wide - from the loftiest Xbase guru to the absolute beginner. Experts and
beginners are equally valued - beginners sometimes ask the best questions!

In addition to the people who write messages on the forum, there is another group we
(affectionately) call "lurkers" - people who monitor the forum (reading messages,
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downloading files) but for one reason or another haven't chosen to write any messages
to us. We might tease lurkers from time to time (that's why I said *affectionately*),
but we value them as well, and if you want to lurk, that's fine with us.

Although intended as a "working" forum for sharing information and professional
expertise, this forum is also a friendly and informal place. People here can become
quite close - and a newcomer quickly finds him/herself accepted. When you join the
forum, "old timers" will treat you as a friend as long as you behave yourself (smile).

As with any group of friends, you'll find that there are lots of "in" jokes, many teasing
comments, heated debates, occasional spats and feuds, people having a bad day who
may be cranky - the usual stuff of human interaction. You'll find the reason we're
friends is that we share common interests, are working in generally the same field, and
appreciate the opportunity to communicate. For some of us who are isolated, the
forum members are the only people we know who understand what we're talking
about.

So, when you "walk" into the forum, it will be more like walking into a large party
with people who share professional interests than like walking into an office or a
professional association. It's like a user's group with no specific agenda. I don't have
any personal experience of other CompuServe forums, but I hear that not all other
forums share our "friendly" attitude and you may be in for a shock if you're used to a
more formal atmosphere.

As with all CompuServe forums, forum members range widely in personality,
geography, race, gender, religion, etc., and this is definitely an equal opportunity
forum.

Manners
As for manners, all we ask is that you be considerate of everybody else. When I say
"considerate", I mean *consider* that the person on the other end of your message is a
human being with ups and downs, strong and weak points, good days and bad days.
Consider that a person may reside in a non-English speaking country and use English
as a second language. Consider that a person might have a disability or that a person
may not be the gender you think he or she is based on his or her name.

Also, please consider that people here represent different nationalities, races, ethnic
groups, religions, abilities/ disabilities, and genders, and respect these differences. In
this forum, it is important to us that we provide an environment where we all feel safe.
If any one of us is ridiculed or insulted, we all lose since we lose that person's
enthusiasm to participate with us and contribute to the work we do.

Consideration can be most important when you are upset. Within the bounds of
consideration, you can complain, whine or throw tantrums, if you need to - I think we
all have at one time or another. But it takes a certain amount of skill to complain,
whine or throw a tantrum politely and with consideration for others. If you're upset,
consider how your message might affect *you* if you were to receive it.

If you're considerate, you shouldn't run into too many problems here. But I must warn
you that you are subject to teasing (because you're considered a *friend* from the
beginning - please don't take this personally) and if you should stray beyond the
bounds of what's considered "appropriate" behavior, you may receive a gentle
admonition. If you are really out of line, a Sysop may decide to step in - a Sysop is a
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final authority on behavior, and even long-term forum members quake before a
Sysop's pronouncements (smile).

As a rule of thumb, a belligerent attitude is frowned upon - it tends to make us
uncomfortable because it upsets the balance of friendliness and consideration and
retards the free flow of communication. Frankly, we seem to be able to have very
"loud" arguments without resorting to this approach.

What To Do If You're Upset
It's not uncommon for people to log onto the forum for the first time because they're
upset - because they've spent hours and hours working on a problem and can't solve it
- because something about one of the Fox products doesn't work the way it should or
the way they think it should (often there's a difference) - because they've tried calling
tech support and haven't received an acceptable answer yet - because they had
something working in one product that suddenly doesn't work in an upgrade.

*Believe me*, we understand (grin) - and it just may be that we can help you if you
give us a chance. If this is true for you, here's what I recommend: First, consider the
other forum members (see Manners) and second, start your message with "I'm upset"
(this lets us know that you're upset (grin) and we'll be sympathetic, I promise). Then
try to explain your problem as succinctly as possible. For further guidelines, see
Asking Questions.

Emoticons and Acronyms
If you've noticed, so far I've been trying to express humorous comments with such
things as (grin) or (smile). One of the things that most puzzles newcomers is the use
of acronyms and what are called "emoticons."

Emoticons
In an electronic medium such as the forum, it's pretty hard to get across certain
elements of face-to-face communications that would otherwise be expressed with tone
of voice, inflection or body language - elements like humor, irony, sadness and
various non-verbal "comments" on what is being discussed. Consequently, certain
conventions have arisen to express this kind of thing.

Technically, an emoticon is an "icon designating emotions" depicted with symbols.
Perhaps the most common of which is:

:-) = a smiling face on its side (tilt your head to the left to read it).

There are literally hundreds of others. However, I am also using the term to apply to
text-based equivalents which are more commonly used on this forum.

<g> grin - either the previous comment was meant humorously or one is responding
with a laugh to somebody else's humorous comment - perhaps the most widely used
symbol on this forum.

<s> smile - usually means that one is smiling at somebody else's comment or could
refer to one's own comment that is slightly humorous.
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<gd&r> grinning, ducking and running - the previous comment was a "tease" and the
person issuing the tease is now hiding out from his or her target. Some variations of
this are a simple <gd> (grinning and ducking) or <gd&r vvf> (grinning, ducking and
running, very very fast).

<rofl> or <rof,l> rolling on the floor laughing - the ultimate acknowledgement of
somebody else's humor or an indication that you think you just said something
yourself that is pretty ridiculous.

"*" or "_" as in *emphasize* or _emphasize_ - equivalent to italics or underlining.

Creative people on the forum will sometimes make up their own emoticons from time
to time but they almost always explain them since nobody would otherwise know
what they're talking about <g>.

Acronyms
Many acronyms have also become standard - mainly to save typing. Some of the
common ones are explained here. Any others you encounter, you'll have to figure out
for yourself, but once you've got the "trick" down, it's kind of fun.

General CIS-wide acronyms:

AFAICS As far as I can see
BTW By the way
CIS CompuServe Information Service
FWIW For what it's worth
IAC In any case (also IAE - in any event)
IANALI am not a lawyer
IMO In my opinion
IMHO In my honest/humble opinion (in the latter case a sure sign the opinion is not
going to be humble at all <g>)
OIC Oh, I see!
OTOH On the other hand
PITA Pain in the "acronym"
POV Point of view
PPN Project/Programmer number, i.e. a CIS user's id#
RSN Real soon now (computer lingo for "don't hold your breath")
RTFM Read the f* manual (variously interpreted as read the fine manual, read the
fabulous manual, you figure it out <g>).
TIA Thanks in advance
TSR Terminate and stay resident program
WTHDIK What the heck do I know? (also WTFDIK)
WYSIWYG What you see is what you get
YA...Yet another.... (as in YAA - yet another acronym)

Forum Organization - Messages, Threads and Sections
The forum is comprised of individual messages from one forum member to another.
These messages are organized by thread. A "thread" is simply a string of related
messages and replies brought together under a "thread topic", which serves as the
"message header" for every message in that thread.
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Threads begin when an individual creates a new message (not replying to a previous
message) and grow as other individuals reply. A new thread may also be created when
replying to a previous message by changing the topic or posting the reply to a
different section.

New threads should be posted to the section appropriate to the topic.

Messages themselves may be either public or private (see below) and cannot exceed
about 10,000 characters in length. For assistance in composing and posting messages,
please refer either to the CIS help files or to the documentation provided with your
communications software.

Message Traffic and Scroll Rate
Message traffic is the number of messages which get posted to a forum in a day. The
volume on the Fox Forum is very high - ranging from about 100 messages a day when
a lot of folks are at the developers conference to as many as 700 messages a day when
something really interesting happens (like a new version of one of the Microsoft Fox
line of products). Message traffic probably averages about 300- 400 per day.

A CIS forum is limited to a certain number of message "slots" or total number of
messages at any one time. As messages are posted, the message slots fill up. When
they are full, messages begin to "scroll off" (disappear) on a first in, first out basis
(early messages scroll off before later ones). With message traffic (also called the
scroll rate) of 300 messages a day, the first messages in the queue will disappear in
about 6 days.

Private and Public Messages
Some forums allow members to post private messages to each other. Private messages
can cut down on some of the extraneous messages that everybody has to wade
through, but they also take up message slots. Please delete private messages to or
from you when they have been received. Many forums do not allow private messages
because the sysops can't delete them. However, Microsoft feels that its forum
members are responsible enough to delete their own messages so that important
public m ages will be available longer.

What This All Means to You
The nature of threads and the high scroll rate in this forum frequently have
consequences for how you ask questions, how you formulate replies, and how you can
help the forum function efficiently. Details will be included in later discussions where
appropriate.

Asking Questions
Forum members are very helpful, patient and forgiving - no matter what level of
expertise you have. You will almost certainly get an answer to your questions, if you
are aware of certain facts of life.
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Due to the high message volume on the Fox Forum, forum members who read all the
messages (and there are many) are trying to keep up with forum traffic, be helpful,
earn a living, and live something like normal lives - all at the same time.

It's recommended that you check in again within two or three days after you leave a
message and that you read all the messages in your thread - otherwise you might 1)
miss responses that have disappeared due to the high scroll rate and 2) miss responses
that may not have been addressed *directly* to you - people tend to reply to the most
recent message in the thread rather than going back to your original inquiry. Any
message sent *directly* to you and not read before it scrolls will automatically be s to
you via CompuServe Mail.

Before You Ask
You are welcome to ask just about anything, but you might want to check out our
archives first.

It should be no surprise that over the course of this forum's existence, many questions
are asked over and over again and many have already been answered. But this is
FoxPro/FoxBASE+ territory and we've got a solution to this. We have archivists who
patiently and unselfishly accumulate the collected wisdom of the forum messages into
database and text files which are available in the Forum libraries. The database files
are in the form of the FoxPro or FoxBASE+ for Macintosh Help file and can be
access in FoxPro and FoxBASE+ for Macintosh by issuing the command: SET HELP
TO <archive file name>. They can also be read via BROWSE or EDIT in any flavor
of Fox product. Moreover, FoxPro users can take advantage of several programs that
were written specifically to view the file. If your question is one of the most common,
you may be directed to the archives - especially the databases - for an answer, and if
you use the Microsoft Fox line of products a lot, you'll want them anyway - they're an
invaluable resource.

For more information, see Libraries.

Phrasing Your Question
The way you phrase your question can make a big difference in the kind of response
you get.

Here's the "worst case" question - one that forum members will want to avoid (tech
support will answer, of course, but you may be missing an opportunity to get a speedy
reply from someone else):

"I just got <XYZ> and it doesn't work. Can anybody help?"

Obviously, the first things anybody has to ask are: Which of the <XYZ> products are
you using and what version of it? What do you mean it "doesn't work"? Just finding
out the basics could take quite a bit of time.

So, here are some guidelines:

Be specific. Tell us exactly which product you're using (and be sure to post your
message in the appropriate section of the forum.
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Tell us whether you are writing a program or using a product interactively.

Tell us exactly what error messages you are getting, if any.

Tell us what you are trying to do, what you did just before the problem occurred, and
*exactly what happened*.

If it's a programming problem, post the actual bit of code that you think is causing the
problem or a close approximation. For really difficult problems, it helps to post code
that can be extracted from your message and run *without modification*. Obviously,
if this involves data files, it helps to know what files are needed, what their structures
are, what kind of fields they have, and how they relate to each other. However, for
brevity's sake, try to post something that's informative but not necessarily complete. If
further action is required, you can begin to fill in the details.

In addition:

Post your question to the proper forum section. Some forum members only read
messages in specific sections - if you post in the wrong place, the person with the
answer might not see it. And choose a suitable, informative, and specific *topic* for
your message. "Debugging UDFs" in the Report Writer section will almost certainly
get a better response than "HELP!"

Post any program code unformatted. CompuServe normally "formats" or "word
wraps" code that's uploaded to the forums - i.e. it strings all the lines together if they
are not separated by a completely blank line. This will turn your carefully indented
code into a garbled mess which is very difficult to read. You can avoid this when
you're on-line with CIS by using the "POST UNFORMATTED" command. With
various programs such as OzWin or Navigator (that allow you to read and respond to
messages off-line use their "Unformatted" option. You may also insure proper
indentation by preceding each line of code with one or more spaces.

Roughly, if you're having a problem with an error that is listed in the documented
error messages (per the manuals for the product), please provide us with the version
of the product you have. Each version of a Microsoft Fox product has a version
*date* as well as a number and you can get the version date by typing "?
VERSION(1)" (without the quotes) at the dot prompt (FoxBASE+) or the command
window (FoxPro or FoxBASE+ for Macintosh). If you're having a problem with a
Runtime version, you need to a development version to write and compile a program
that shows the version date and then *run* it under Runtime.

Roughly (again) if you're having a problem which appears to involve the way a
Microsoft Fox product interacts with your hardware such as loading or operating
slowly, not loading at all, running out of memory or disk space, operating in Windows
or DesqView, running under QEMM, running on a network, etc., environment,
perhaps including your operating system (MS-DOS 3.3, MS-DOS 4.1, Mac System
6.05), your MS-DOS CONFIG.SYS, AUTOEXEC.BAT, Windows .PIF settings,
DesqView settings or your Mac INITs, type of network, network settings, and so on.

Uploading Files
If you have a very difficult or complex problem, it may eventually be resolved only by
sending it to someone else for review. There are two approaches:
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If tech support specifically requests that you send them your problem (and at no other
time), upload it to the forum libraries. Problems sent this way will be treated as
private communications - however, if you want to have the problem reviewed by non-
Fox folks, you may specifically ask the sysops to post it publicly to the libraries.
Uploading to forum libraries is free of connect charges so this is definitely the most
efficient way to send things to Microsoft.

If a non-Microsoft forum member has been assisting you, you can send your problem
to him or her via CompuServe mail. However, there _is_ a "rule" about this:

DO NOT UPLOAD ANYTHING TO ANYBODY WITHOUT THEIR SPECIFIC
PRIOR APPROVAL.

Downloading something from CompuServe costs the recipient money in phone and
CIS connect charges. Many active forum members use automated programs to
download their messages and files and these programs do not give them the chance to
refuse a download - anything in their box is downloaded automatically. It's simply not
fair to impose this burden on them without their consent. The above rule also means
that if somebody has been kind enough to look at something before, it doesn't
necessarily mean not to look at it again. It's a simple matter to request and receive
permission before you upload.

In EITHER CASE, when you upload something to somebody, be considerate again -
send them the minimum that's necessary to "get the job done", in other words, give
them the information they need to assist you (a small sample program with sample
.DBF files, etc. if possible) and compress the file (using PKZIP for DOS or Stuffit for
the Mac) to reduce transmission time.

Responding to Answers
If you have asked a question and someone has replied with an answer, read what they
have to say carefully. If they've solved, your problem, great! If they haven't, but are
trying to help, answer their questions. Remember they may be in a hurry, or have
misunderstood your question or situation, or may even be telling you something
incorrect (not on purpose, of course), so if you don't understand something they say,
don't be afraid to say "I don't understand."

Acknowledgments
If somebody helps you out, a simple "Thanks!" is appreciated. However, these simple
messages add to the forum message traffic and take up precious message slots. If you
want to thank a lot of people, generally one "thanks Bob and Ann" message will
suffice. If you're thanking just one person, post it privately (and make sure to delete it
when it's received) or, better yet, send it via CompuServe mail.

If you've had a particularly knotty problem that appears to have been a challenge to
resolve and/or if many people have made a lot of different and possibly conflicting
suggestions - when you've finally got it working, we'd appreciate knowing what
exactly you did that worked. The reason we appreciate this kind of summary is
because many of us may have or anticipate having the same kind of problem. In
addition, it may be valuable to the forum archives.
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If You Don't Get an Answer
If you leave a message and nobody responds, it may be because it "just happens" that
nobody has time to respond, because everybody simultaneously decides that
"somebody else will answer", or because your message was unclear and nobody knew
*how* to respond.

You can increase your chances of having a response to your message by:

Posting your message again - and saying that your original message was not
addressed.

Posting your message directly to a sysop or to "all".

Rephrasing your message.

Tips for the Active Participant
As I mentioned earlier, the message traffic on the Fox Forum is very high, averaging
300 - 400 messages a day. It can be quite a chore to manage this volume of
communication and keep CIS connect charges to a minimum. Here are a variety of
hints that may prove useful.

Thread Integrity and Continuity
All forum members, experienced and novice, benefit from the forum threads. Often a
thread will address a problem that many other forum members have or anticipate
having. Consequently, it is important that all messages that contribute to the thread
remain available during its lifetime (thread integrity). In addition, it's extremely useful
if relevant messages are contained _within_ the thread and in the proper order
(continuity). With this in mind:

Public messages should not be deleted if they contribute to the thread.

Relevant responses to existing messages should be generated by *replying* to the
message rather than starting a new message.

Multiple-part messages, as much as possible, should be kept together.

Related to this issue is the "other side of the coin" where messages are no longer
relevant to the topic. It is possible on CIS to scan available messages by "message
header" or thread topic. This can be a useful approach if you're trying to save on
connect charges. However, this is not *guaranteed* to be a foolproof approach.
Threads on this forum tend to wander, and strict adherence to a thread topic is not
rigorously enforced. Consequently if you're downloading a thread whose topic looks
interesting, you may discover:

the messages have wandered off the thread topic
the messages have deteriorated into a series of jokes

At a rough guess, some of us estimate that the really relevant messages in a thread are
the first 1 to 10, although that is not necessarily the case - when a topic is
complicated, messages may still be useful during the thread's entire life or, OTOH, a
thread may deteriorate into jokes almost immediately. Unfortunately, due to the high
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message traffic, the beginning of a thread may scroll off so that all that remains in the
forum are the less relevant messages. This is not to say that the messages which aren't
relevant to the topic aren't useful <g> - indeed, they are frequently useful - and the
jokes are often good, too.

Message Etiquette
In consideration of forum members who do not read all the messages (those who
download the threads whose topics sound interesting) and to support thread integrity
and continuity, please observe the following suggestions:

Please post your message to the most applicable section.

When starting a new thread, try to name it something that captures the essence of your
message and be as specific as possible - unless it's the Chatter section where you can
name it anything you like.

When replying to a message, if your reply is substantially changing the subject, please
post it under a different topic and to a different section if applicable. If you want to
have fun for awhile, post it to "Chatter."

If your reply is directly relevant to the current topic, please don't post it to a different
topic or section. Use CIS or your off-line software to REPLY to the message.

If you want to make sure that a specific person sees your message and sees it as
quickly as possible, make sure you address it specifically to him or her and be sure to
include his/her CIS ID number. This is important because:

Some people only read messages addressed directly to them and will miss your
message entirely. (Note: reading only personal messages is not recommended practice
in this forum because you will almost certainly miss further possibly relevant
messages in a thread.)

Many active participants will read their personal messages during the day and
download everything else in the evening - so they might not see a particular message
until later.

If the message scrolls off before the addressee sees it, CompuServe can not forward it
to CompuServe mail without an id number.

Long messages: If you have a particularly long message, remember that individual
messages are limited to about 10,000 characters. When a message exceeds that limit,
you can either send it via CIS Mail to an individual or you can split it into parts and
post it on the forum. There are very few cases where a message needs to be longer
than 10,000 characters; if your message is longer than that, you need to review it and
cut out unnecessary parts. If the message contains source code or the like and runs too
long because of that, consider offering to upload the source if needed rather than
posting it all in a message. Remember that other users who are uninvolved in your
thread will also be retrieving your message; keeping the size down saves everybody
(including you) money.
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Deleting Messages
If someone sends you a private message, please delete it (after you read it) so that it
will not take up a message slot. Private messages can _only_ be deleted by the sender
or receiver so the sysops can not sweep them out when they have been received.
Sysops can delete public messages and may delete simple "thank you" notes when
they have been delivered. Do NOT delete public messages if they are relevant to a
thread. DO delete public messages that were garbled or duplicated in transmission,
that co in errors or misstatements, or that were ill- considered (in this particular case,
"repent in haste" <g>).

Sysops
Forum sysops are the people who keep the forum running smoothly. They handle
chores such as making sure uploaded files are free of viruses, keeping order in the
threads, managing the libraries, answering questions about the Microsoft Fox line of
products, and offering technical support. The forum sysops, and their CIS
identification numbers change from time to time so I won't give you a detailed list
here. A list of current sysops is published frequently in a public notice on the forum.

Tech support questions should be addressed either directly to a specific sysop (once
you know who they are), including their CIS id number, or to "sysop" or "all". The
tech support sysops keep a close eye on all messages and may respond if no one else
has given you an answer - however, to get the quickest response from tech support, a
message directly to them is most effective.

Tech support may download messages in groups. If your messages are posted
afterwards, you may not receive a response from the sysops until the following day
(Monday, if you miss the last Friday download). Response time from tech support is
also dependent on the message traffic and other factors. For instance, Monday's
download, a download after a holiday, or a day of high message traffic may take
longer for tech support to process.

Libraries
The forum libraries contain many informative and useful files. An exploration of the
libraries is well worth the trouble.

Files in the libraries come in two basic forms: ASCII and binary. ASCII files are text
files which will be readable without further attention. Binary files are *either* files
(including text files) that have been compressed to save space and downloading
connect charges *or* other binary files like programs or graphics files.

Compressed Files
There are several types of compressed files:

.ZIP files - Compressed using PKZIP - these are uncompressed by using
PKUNZIP.EXE. PKZIP/UNZIP are shareware programs available in the forum
libraries under the name PKZ110.EXE.

.EXE files - Mostly this extension indicates that the file is a "self-extracting"
compressed file. This means that the file will unpack itself when you type the file
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name. Usually these files are also compressed using PKZIP or LHA - however since
they're self- extracting, they do not require an extractor program. Generally, when a
file is a self-extractor, the file is marked "SFX" (short for self- extractor.)

.COM files - Sometimes also self-extracting files.

.ARC files - Compressed using Arc utilities or such commonly available compatible
programs as ARC-A.COM. Can be uncompressed with ARC-E.COM, available in the
IBMCOM forum, and elsewhere (look for ARC- E.COM and ARC-E.DOC).

.LZH files - Compressed using the LHA program, or its predecessor LHARC. The
same program can decompress the files. LHA is available in the IBMCOM forum
(look for LHA213.EXE, a self- extractor.)

.ARJ files - Compressed using the ARJ program, and can be decompressed with the
same program. Again, ARJ is available in IBMCOM.

(Note: The PKxxx programs are the most popular, and you will see probably see more
.ZIP files than any other. LHA is also quite popular (it's what I use, because it does a
very good job of compression and is free rather than shareware) so you will see quite
a few .LZH files as well. ARC is an older format, not frequently seen any more, but
there are still quite a few of these older files on the Service. ARJ is not frequently
seen either; it does a good job of compression and has some handy features, but it is
much slower in its processing than the other programs. If you plan to handle a large
number of files from CIS, you really need a copy of each of these
compress/decompress programs. S.S.)

Downloading Files
Scanning the library listings for files to download can often be rather confusing. This
is especially true if you're trying to scan them on-line. To make things slightly less
confusing, I recommend first downloading either the file FOXFIL (.ZIP or .SIT) or
the file LIBDBF (.ZIP or .SIT) which contain all library listings, updated
approximately monthly.

It's somewhat confusing that updates to files may coexist with earlier versions.
Usually the file name and narrative make it clear which is the most recent and the date
will also provide a clue. For instance, PROER5 is an upgrade to and *replaces*
PROER4. (Note to people uploading files: you can help alleviate this problem if you
upload a revised file under a different name, by deleting the old file yourself at the
CIS Library menu.)

However, some upgrade files are not *replacements* to prior files but *additions* to
them. For example, the updates to the second forum archive THREADS2.DBF are
named THD01, THD02, etc. - each of these files contains completely separate
information and should be *appended* (preferably in order and using the updating
programs) to THREADS2.DBF.

NOTE: When files are uploaded, there is a delay between the time they are sent and
the time they are merged into the libraries. This time is needed to check for viruses
and evaluate the suitability of the file for the Forum.
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Uploading Files
Most files in the libraries have been uploaded by forum members for use by other
forum members and we encourage you to do the same. If you have developed a utility
or a function or a bit of code or have some particular information to share that appears
to spark general interest, please send it on up! Remember, uploading to forum
libraries is free of connect charges.

If tech support specifically requests it (and at no other time), you can also upload
code that you're having a problem with and which appears to be too lengthy or
complex to post on the forum itself.

The mechanics of uploading a file can be fairly tricky. Please refer either to CIS Help
or your CIS communications software documentation. If you want additional help,
CIS has a practice forum (GO PRACTICE) where you can practice uploading a file,
writing messages, etc. Time spent in the practice forum is free of connect charges.

Here are some guidelines for uploading:

Combine and compress any files you are sending into one archived file using PKZIP,
LHA or the self-extracting options of other compression schemes.

CIS limits file names in libraries to only 6 characters (not including extension). It's
better if you limit your file name to 6 characters yourself - otherwise CIS may
truncate the file name in a way that you don't really want. File names should begin
with a letter and contain *only* letters and numbers. They should not contain spaces
or punctuation (including underlines and hyphens), or misc. characters like * or ^.

When uploading, please include a brief but complete description of the files included
and what they do. If space allows, I always like to see the name of the person who's
sending it and a note about how large the file will be when uncompressed (disk space
is sometimes tight).

The sysop will check the file for viruses and perform some other maintenance.
Consequently, it may take a few days before the file becomes available to others.

Let people on the forum know that you've uploaded the file, what its name is, and
where you sent it.

NOTE: If you are uploading a file with the *same* name as a file you previously
uploaded, the old file will be replaced with the new one. However, if you are
uploading a revision and want to use a new name, please help with library
housekeeping by deleting the old file yourself using the CIS Library Menu.

Afterword - The Spirit of Contribution
One of the things I feel distinguishes the Fox Forum from many others is the very
unselfish way forum members help each other day after day. I feel there is an
underlying intent on the part of most forum folk to make a contribution to others on
the same path. I also feel as long as this "spirit of contribution" remains a force, the
forum will work well for all of us.

You can really help maintain the value of the forum by logging on with an intent to
contribute. If you want to ask a question, ask it with an eye toward contributing to our
knowledge as well as yours. Share experiences that you feel will be of value to others.
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Answer the questions of others. And try, especially, to keep to the public agenda and
avoid self-promotion.

There's certainly opportunity on the forum for vendors of products and services to
offer their wares (in moderation), and vendors are *just the kind of people we need*
to help us. Yet it's always a little irritating when we see a vendor log on *only* to
promote something while so many others are helping for free. If you are a vendor,
hang around a little and contribute; give back a little to the community that supports
you. (And from a purely practical point of view, establishing a helpful presence on the
forum should serve to enhance your marketability.)

Although making a contribution is always a source of personal satisfaction, I firmly
believe that there's more at stake here - we are building a community that can support
us in our work and in our lives. I think that's something worth investing in -
contribution is truly an investment in our future.
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Common Questions and Answers

Q. When I attempt a file download, OzWin immediately gives me "Remote out
of disk" error message. What's wrong?
A. The "Remote out of disk" message is not from OzWin, it is from CIS. This error
message is generated when OzWin cannot create the new file being downloaded and
aborts the transfer. CIS doesn't know why OzWin aborted, only that it did, so it
displays this default message. What caused the problem? It can be exactly what the
message says: you don't have enough free disk space to hold the new file. However,
the most common reason for this error is that the Downloads Path specified in the
Host Config is invalid. Other reasons include attempting to download to a network
path with read- only permissions, a garbaged Host Configuration, or having used the
DOS commands SUBST or ASSIGN on the download drive/path.

Q. My system gets a little way into on-line processing and locks up, always in a
different place, at 9600bps; at 2400 everything works fine. Bug?
A. The single most common cause of lockups at 9600bps and higher port speeds, for
_all_ comm programs, is having a slow disk cache or other TSR or driver running that
takes a lot of time processing its interrupts. This can include programs like Stacker
and other runtime disk compression programs, EMS/XMS drivers, TSR's that sit on a
regular interrupt like the clock-tick interrupt, etc. To find out if this is your problem,
un-install as needed all TSR's, EMS/XMS device drivers, Stacker, etc., and run the
program (it should work fine.) Then add back one driver or TSR at a time and retest,
until you hit the one causing the problem. (Note: load order can also be important.)
Consult the documentation for the TSR, driver or tool causing the problem, or contact
that company's tech support line. Many disk cache and other programs have specific
sections in their documentation on this problem, because it is so common. One other
MAJOR help: install a 16550AFN UART chip if you can. This kind of serial chip
provides an internal 16-byte buffer than can eliminate the vast majority of such
problems. OzWin automatically detects and takes advantage of a 16550AFN is one
exists. Consult your hardware vendor for more information.

Q. My CPS readings at 9600bps seem awfully low, often less than 300 characters
per second. Shouldn't 9600 access be much faster than this? What's wrong with
OzWin?
A. See the section on 9600 access above. OzWin can handle data at any speed CIS
will send it; the program is not slowing down CIS. CIS itself slows down when host
computer and/or network traffic is high, and this slow-down is more apparent at 9600
than at 2400. Review your 9600 access per the guidelines above - you may well find
that using 9600 is not economical for your access patterns.

Q. My modem won't connect. I've juggled the init string, but it still balks. Why?
A. Different modems work differently; while the Hayes "AT" command set _style_ is
pretty much universal today, there are a lot of variations. For example, some modems
don't use the standard "ATZ" command to reset the modem, they add a numeric
parameter such as "ATZ1", or use a stored profile via "AT&F". OzWin allows
flexibility in how you configure the modem.

Q. I've grown accustomed to using RECON and TAPPET to manage my forum
messages and threads, and scan headers. Can I use these tools with OzWin?
A. Yes to RECON, no to TAPPET, with a couple of notes. You can use RECON with
OzWin for all forum messages (sorry, not CISMail messages) by doing the following
things:
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1) In the Forum Config dialog for the forums you wish to manage with RECON, set
all purging options to 0.
2) Create a PARAMS.OZ file. This is a special file used by RECON that contains
configuration information used by RECON. See the RECON documentation for
details on this file.
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Manual Terminal

While OzWin works hard to automate your online chores, there will always be times
when you need to do something manually while connected to CIS. OzWin provides
you with a manual terminal, similar in many ways to other general-purpose
communications terminal programs, to make these chores easier.

Accessing the Manual Terminal
There are two ways to access the manual terminal: while on-line in automated mode
via the Alt-S or Alt-T commands, or from the main menu.

When on-line in automated processing mode, pressing Alt-T tells OzWin to complete
processing the current area (Mail, Forum, etc.), then enter manual mode. Pressing Alt-
S in that situation tells OzWin to complete ALL automated processing before entering
manual mode.

When you're not on-line with CIS, access to the manual terminal is via the
"Online|Manual Terminal|Manual, no logon" menu option. If you want to have the
program log on for you before entering Manual Terminal mode, select the
"Online|Manual Terminal|Logon to Manual Terminal" option instead. Finally, to have
OzWin log on, go to one of your defined forums and then enter Manual Terminal
mode, select the "Online|Manual Terminal| Log on to Forum" option.

Using The Manual Terminal: The CIS Side
Once in manual mode, any text you enter via the keyboard will be sent to the modem,
and any data received will be displayed. Certain keys or characters act as special
commands to CIS. (The following information is taken from the CIS "General Help"
area.)

Every command must end with a carriage return. Pressing the carriage return key
(which may be marked ENTER on some keyboards) transmits the command to
CompuServe.

In on-line information, the carriage return key is represented by the symbol <CR>.
Pressing <CR> at the end of an article returns you to the previous menu.

T TOP menu page
M previous MENU
H or ? HELP
GO word or GO page GO directly to a service
FIND topic FIND all references to topic
OFF or BYE sign off
S n SCROLL from n
R RESEND a page
F FORWARD a page
B BACK a page
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N display NEXT menu item
P display PREVIOUS menu item
SET option SET terminal option
PER exit to Personal File Area

SCROLL allows you to to enter lists and/or ranges of menu selections. The ALL or
SCROLL ALL command displays every choice on the current menu, including
multiple page menus.

Examples:

 ! ALL
 ! SCROLL ALL

Multiple menu selections are valid. Menu choices can be entered as a list or a range,
or any combination of the two. The same selections arguments are valid with the
SCROLL command.

Examples:

 ! 1,2,3 and ! S 1,2,3
 ! 5-9 and ! S 5-9
 ! 9-5 and ! S 9-5
 ! 1,3-5 and ! S 1,3-5
 ! 3-5,1 and ! S 3-5,1

Control character commands
NOTE: These commands are entered by pressing two keys together: the Control key
and a letter key.

Control C Stops the program being used.
Control O Discontinues the flow of information to your computer or

terminal without stopping the current program.
Control S Immediately suspends output from the host computer.
Control Q Resumes output at the point where it was interrupted by

Control S.
Control U Deletes the line you currently are typing.

Command summary
Most CompuServe commands can be abbreviated to uniqueness. One letter is
sufficient in most cases. (Exceptions are FIND, SET, PER, EXIT, OFF and BYE.)
Terminate all commands with a carriage return (which may be marked ENTER on
some keyboards and is represented on- line as <CR>).

On the following pages, you will find a listing of commands with their respective
descriptions to assist you in using CompuServe.

T TOP
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Goes directly to the first page (TOP) of CompuServe.

M Menu
Goes back to the menu page that points to the current page. A single <CR> will also
return to the last menu if there isn't a next page.

H or ? HELP
Displays this information. Other HELP messages area available within specific
services.

GO word or GO page GO directly to a service. Takes you immediately to the service
identified by word or page.

"word" is any Quick Reference Word, as in GO WEATHER or GO TRAVEL. To
display a list of these words, enter GO QUICK.

"page" identifies a specific page (screen display) by database name and page number,
as in GO HOM10. The database name by itself identifies the first page of the database
(for instance, GO HOM is the same as GO HOM1). The page number by itself
identifies a page in the current service.

S n - SCROLL n
SCROLLs remainder of an article, displaying pages continuously without pausing. At
a menu, S n selects item n and scrolls through all the pages for that item. Please note
that a space is required between the S and item n.

B BACKWARD
Returns to the page preceding the current page.

R RESEND
RESENDS the current page. This is useful if the current page has scrolled off the
screen or after a HELP command.

FIND topic
Finds all index references to a topic and displays a menuized list with corresponding
page numbers.

N NEXT
Goes to the NEXT item from last selected menu. If 5 was the last choice, N will
display item 6.

P PREVIOUS
Goes to the PREVIOUS item from last selected menu. If 5 was the last choice, P will
display item 4.

F FORWARD
Displays the next page in a series of pages. A single <CR> will do the same thing.

PER or EXIT
EXITs to the Personal File Area. From some subsystems, EXIT takes you to the
previous menu.

OFF or BYE
Disconnects you from CompuServe immediately.
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Control character commands
Control characters transmit special commands to the host computer. These commands
are entered by pressing two keys together: the Control key and a letter key.

Control C
Stops the program you are using. You then can type another menu selection or
command. ^C is displayed on your screen.

Control O
Discontinues the flow of information from the host computer.  Entering a second
Control O turns the display back on at a later point in the transmission. ^O is
displayed on your screen.

Control S
Immediately suspends output from the host computer.

Control Q
Resumes the running display of output at the point where it was interrupted by
Control S.

Control U
Deletes the line currently being typed. ^U is displayed.

For additional assistance type GO INSTRUCTIONS.

A Lot To Learn...
Detailing all of the available CIS menu options, and for that matter the dozens of
available command words, would take a book. Such books are available! CompuServe
sells a guidebook to the service, and third-party authors have written several excellent
books on the subject. (My personal recommendation is David Peyton's GETTING
THE MOST OUT OF COMPUSERVE.) Some of these books are available from your
local bookseller, and CIS also provides an area (GO ORDER) where you can order
books to be sent directly to you and charged to your CIS account. If you are a novice
CIS user, one of these books will prove invaluable.

A Word About Conferencing...
CompuServe makes real-time conferencing among many users easy. But as with any
group of people talking together, common courtesy and a few simple rules of the road
go a long way toward making the experience an enjoyable one. The PRACTICE
forum keeps a list of information on conferencing rules, etiquette and commands;
reviewing the information will help you understand conferencing and enable you to
participate faster and more effectively. (For more information on the PRACTICE
forum, see MISC.DOC.)

There are two general categories of conference: "formal" and "informal". Formal
conferences are usually planned offerings by forums or other services, with a guest
speaker or speakers and a moderator whose job is to keep the conference running
smoothly.
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This type of conference may be held in a forum's conference area, or may be held in
the special CIS Conference Center (GO CONFERENCE). In formal conferences, no
one "speaks" until he or she is recognized by the moderator, at which time he or she
enters the statement or question. To signify that you want to ask a question, enter a
single question mark (?); to let the moderator know you want to make a statement, use
a single exclamation mark (!). The moderator will recognize each questioner in turn.
The Conference Center area maintains a list of formal conferences scheduled to be
held in the Center, but does not keep track of conferences held in forums.

Informal conferences are friendly free-for-alls, held in a forum's conference rooms.
Everyone "talks" at once, and often there are a dozen or more conversation threads
rolling by on the screen; keeping up with the chatter can be an enjoyable challenge.
Many forums have regularly-scheduled periodic informal conferences, while others
almost never have conferences or only have announced conferences for specific
purposes. Usually the forum's Conference announcement will list the time and day for
any regular conference, and/or show a schedule of any planned formal conferences.
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OzWin and CIS script language

IMPORTANT NOTE

OzWin actually uses two script languages: the CompuServe Connection Script
language (CCS) used only by the connection and disconnection processes, and the
OzWin Script language used during online processing of scripts. The CCS script
processor is build into the CompuServe-provided HMI toolbox, while the OzWin
script processor is internal to the program itself.

Refer to the Sample Script files which accompany OzWin for a detailed description of
both languages. These files are in standard ASCII format and can be searched through
easily for the exact information desired.

Glossary

Activity Indicators Characters used to convey information to the user about Inbox and
Outbox procedures or information to be performed or viewed.

AutoNavigator A program, such as this one, that automates access to CompuServe
Mail and Forums. Also "AutoNav", "Autopilot", "Navigator" or "Nav".
The acronym "OLR" (for "Off-Line Reader") is sometimes used to
refer to this general catagory of program, however "OLR" is
considered improper when refering to programs specific to
CompuServe.

Browser An index-like list of the available messages in CISMail or a selected
Forum.

Connection A Connection in OzWin is defined as the set of data that defines how
your system connects to CompuServe (comm port, modem settings,
phone number, User ID and Password, etc.) This information is stored
in the CIS.INI file.

Inbox Message(s) or file(s) from CompuServe or other users that you have
retrieved.

Forum Group A collection of one or more forum definitions that are processed
together during online events. Forum Groups allow you to order your
online activities in a more controlled manner.

Forum Thread A Forum Thread is a group of Forum messages that have the same
subject. A thread consists of a "root" message and replies to that
message, along with replies to the replies, and so on.

Help Hint Help Hint is the help text displayed at the bottom of all main windows.
The text gives a basic idea of the features performed by the current
window. Help Hint has a second hidden feature. Click and hold the left
button of the mouse on top of any toolbit. Notice the Help Hint at the
bottom changes to define the toolbit. If the toolbit you have selected is
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not the desired toolbit, drag off. The Help Hint will change back to the
current Window Help Hint.

Keywords Keyword(s) are used to identify files by words for searching purposes.
Keywords are used in the Library Searches, both File Finders and
Upload File Dialogs. Keywords can consist only of uppercase letters,
numbers, and the underscore character. Multiple keywords must be
separated with spaces and cannot contain apostrophes or hyphens. The
maximum number of keywords is 10, with a total length of 80
characters including the spaces. Some common words are ignored if
included in the list of keywords (ie. a, and, the, to, etc.).

Local Index A Local Index is the browser section in a viewer which displays a
portion of the entries of the current message file.

Mail Thread A Mail Thread is a group of CIS Mail messages containing the exact
same Subject.

Menu Bar A Menu Bar is a row of menu items that activate windows or perform
specific features. Menu Bars are located in windows just below the
header. Menu items are activated by clicking with a mouse or entering
ALT+underlined letter.

Outbox Message(s) or file(s) from you to CompuServe or another user, that are
waiting to be sent.

Pass The process of automatically connecting to CompuServe, performing
specified or pending operations, and disconnecting. Also called an
"Online Event".

First ("New") Pass A Pass used to collect new and/or waiting messages, and to retrieve
new QuickScan headers for review. In general, a First Pass checks a
Forum or Forums for new messages since your last access in that
forum.

Second ("Send") Pass A Pass used to send replies composed for messages from a First Pass,
retrieve messages selected from QuickScan headers, and in general
perform any outstanding work you have specified for the Forum(s)
such as downloading requested files.

Preferences Preferences are INI option settings that over-ride the default settings
maintained in various dialogs. Multiple Preferences can be saved to the
INI file. To load OzWin with a Preference insert "/u (preference
name)" in the command line for OzWin, without the quotations. The
Preferences are Power Services Feature.

Quoting The process of copying text from a message into a reply to that
message such that the text is marked with surrounding brackets to
indicate that it is copied from the parent message. Quoting is a
common practice on the Internet and BBS systems because it can help
the reader maintain continuity between messages when there may be
days between a message and its reply. However, quoting is discouraged
on CompuServe, especially quotes of more than one or two lines, or the
practice of quoting the entire contents of a message and then inserting
your reply comments in between paragraphs of the original text.
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Session Each time OzWin connects with CompuServe to perform automated
processing.

Shrunk State The Shrunk state refers to the display mode of the OzControl Window.
When OzControl is in the Shrunk state the Header, Menu Bar and Tool
Bar are all that gets displayed. When OzControl is not in the Shrunk
state the complete window is displayed.

Script A series of commands to the program that it can execute, stored in a
file. Scripts are used to manage the process of calling and connecting
to CompuServe, and to perform online operations that the program
does not internally provide. Also, you may see the term "Script" used
as another name for "AutoNavigator" (see above.)

Script Language A simple programming language the software can understand, to allow
you to create scripts. OzWin uses two script languages, one strictly for
processing the connection to and disconnection from CompuServe, and
the other for performing automated processes once online.

Signature The Signature is a user defined way of quickly entering specified text
into a message, usually for the purpose of signing the message. The
Signature can be any literal characters desired. Specific characters will
display different information or perform specific tasks. The ^M
performs a carriage return, ^J line feed, ^H backspace, ^I tab, %d
displays the date, %t time and %v version of OzWin. NOTE: use of
long or involved signatures is discouraged on CompuServe, especially
signatures of more than one line or that contain anything that can be
construed as advertising. Many forums forbid signatures that contain
anything other than name, date and time. Before using a signature in
messages posted in a forum, be sure to find out that forum's rules
concerning signatures.

Toolbit A Toolbit is an icon that performs a specific feature when clicked on
by the mouse. If you prefer the mouse over the keyboard, toolbits will
be provide easy access to commonly used features.

Tool Bar A Tool Bar is a group of toolbits aligned at the top of an OzWin
window. A tool bar is synonymous with Speedbar or Button Bar
referred by other applications.

Viewer A window used to view the contents of messages and perform
operations related to those messages, such as composing a reply.
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Flags

Message Browser / Message Viewer (Local Index)

Name Char Description
Tag ! This message is tagged.
Seen S This message has been viewed.
Hold H Do NOT auto. purge this message.
Purge P Mark message for purge.
Kill K Mark message for kill (Delete).
DeleteOnline D Delete this message online. (Forum)

CIS Mail Outbox Browser / Outbox Viewer (Local Index)

Name Char Description
Hold H Do NOT send online to CompuServe
Binary B Send attached file as binary
Receipt R Request receipt from CompuServe
Want Reply W Request that addressee reply

Forum Outbox Browser / Outbox Viewer (Local Index)

Name Char Description
Hold H Do NOT send online to CompuServe
Private P Only the recipient can read
Unformatted U CompuServe will not reformat message
Forward to Mail F CompuServe will forward the message

Quick Scans (CIS Mail)

Name Char Description
Bypass <Space>Skip this message.
Read R Retrieve this message.
Delete D Delete this message.

Quick Scans (Forum)

Name Char Description
Bypass <Space>Skip this Thread every session.
Read R Retrieve new messages in this Thread every

session.
Download D Retrieve new messages in this Thread next
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online session only.
Skip B Skip this Thread next online session only.
All A Retrieve all messages in this Thread in this

Section next online session.
All/Days (1)-(9) Retrieve all messages in this Thread in this

Section in last <n> days.
All/Every E Retrieve all messages in this Thread regardless

of Section.

Catalog Viewer

Name Char Description
Tag T This message is tagged.
Download D Download requested.

Listing Browser

Name Char Description
Tag T This message is tagged.
Retrieve R Abstract retrieval requested.
Download D Download requested.
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Hot Keys

Standard Windows
These hot keys are common to almost all Windows applications.

F1 Help
Enter Ok or Save
Esc Cancel or Exit
Alt-F4 Close Window

Common Editor
These hot keys are common to most all of the windows that allow editing. The hot
keys for Undo, Redo, Cut, Copy and Paste are Windows 3.0 standard. The 3.0 hot
keys were used because the 3.1 conflicts with Wordstar commands.

Alt+BkSp Undo
Shift+Alt+BkSp Redo
Shift+Del Cut
Ctrl+Ins Copy
Shift+Ins Paste
Del Delete
F3 Find Next in current message
F4 Go To Line...

Message Viewer
P Previous message
B Previous Message (Backward)
N Next message
F Next Message (Forward)
T Tag current message
R Reply
Shift + F3 Repeat last cross message search

Quick Scans (CIS Mail)
R Mark for Retrieve
D Mark for Delete
<Spacebar> Toggle mark
<Enter> Toggle mark

Quick Scans (Forum)
R Mark for Read always
D Mark for Download this once
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B Mark for Skip this once
A Mark for Retrieve All
E Mark for Retrieve All Every Section
1-9 Mark for Retrieve All (1-9) days in Age
<Spacebar> Toggle mark
<Enter> Toggle mark

Catalog Viewer
D Mark for Download
T Tag current entry
<Spacebar> Tag current entry

Listing Browser
D Mark for Download
R Mark for Retrieve Abstract
T Tag current entry
<Spacebar> Tag current entry
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Activity Indicators
Activity Indicators are small pictures that are displayed in the Defined Forums section
and the CIS Mail section of the OzControl Main Window. Activity Indicators are
designed to convey information to the user. Each Indicator has a specific meaning
pertaining to Inbox and/or OutBox events. The Inbox indicators are displayed on the
left and the OutBox indicators are displayed on the right.

Inbox Indicators
Thumbs Up Active
Happy face Waiting messages
Stack of Papers New messages not seen (Forum)
Glasses Quick Scan waiting
Closed Folder New Catalog/Listing (Forum)
Arrowhead down Download received from CIS Mail
Flag Received Bulletins (Forum)

OutBox Indicators
Open Book Member Directory Search pending
Mailbox with flag up Outbox Messages pending
Mailbox with letters Request for Quick Scans pending
Arrowhead down Download Request pending
Arrowhead up Uploads pending
Addessed Envelope Custom Message Search pending
Open Folder Custom Library Search pending
•
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